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1. What is Change Manager?
Change Manager helps you track changes to a product throughout its life cycle. You propose a change to
a product and then manage the entire cycle of review, approval, and implementation of the change.

It enables your organization to ensure the quality of every change made to a product by providing
mechanisms for problem identification, change authorization, coordination and planning, cost and
benefit analysis, and record keeping. You can articulate the work required to:

• Implement a change.

• Assess its impact on any managed business items, such as parts or documents.

• Notify lifecycle participants about proposed and authorized changes.

• Track progress and completion of work.

• Compare before and after product configurations.

Change Manager can be easily configured to use your change process.

• Use Change Manager with Workflow Designer to track the evolution of changes through your
organization according to a controlled, repeatable process. Workflow Viewer is accessible directly
from within Change Manager.

• Use Change Manager with Schedule Manager to create work breakdown structures that you can use
to plan and schedule the changes you are making to your product.

You also need the Workflow to Scheduling Integration option installed and configured.
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1. What is Change Manager?
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2. Before you begin
Prerequisites You need a license level that enables authoring for all Change Manager

functionality. If you do not have a higher level license, you are limited to
the following functionality:

• Creating a problem report (PR).

• Checking in a PR and submitting it to a workflow process.

• Adding business objects to the PR Problem Items and Reference Items
folders.

• Searching for and viewing change objects: PRs, engineering change
requests (ECRs), engineering change notices (ECNs) and deviation
requests (DRs).

• Receiving and acting on workflow assignments and tasks.

Schedule Manager must be available and licensed to use the work
breakdown structure functionality. You also need the Workflow to
Scheduling Integration option installed and configured to initiate
workflows from a schedule.

Workflow Designer must be available to process a change. You update
the status (such as moving the Disposition attribute from Investigate to
Approve) in a workflow process.

Note:

The Teamcenter change management process does not support
displaying substitutes on separate BOM lines in Structure Manager.
Turn off the substitutes display (set PSEShowSubstitutesPref to 0)
when working with change-management related features.

Enable Change
Manager

Before you can configure change management, you must add the
application to your existing Teamcenter environment.

1. Log on to Deployment Center and select the environment to which
you want to add Change Management.

2. Go to the Applications tab. Click Add or Remove Selected
Applications .
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3. In the Available Applications panel, use the web browser search to
find the Change Management application. Select the application, and
then click Update Selected Applications.

Deployment Center automatically selects any additional dependent
applications.

4. Go to the Deploy tab. Click Generate Install Scripts to generate
deployment scripts you will use to update affected machines.

When script generation is complete, note any special instructions in
the Deploy Instructions panel.

5. Locate deployment scripts, copy each script to its target machine, and
then run each script on its target machine.

For more information about running deployment scripts, see
Deployment Center ─ Usage.

Or, if you see Teamcenter Environment Manager (TEM), add the following
features in the Features panel:

• Change Management (server)

Installs the server-side definitions for changes.

Select Active Workspace→Server Extensions→Change Management

• Change Management (client)

Installs the user interface elements for viewing changes in Active
Workspace.

Select Active Workspace→Client→Change Management

If Change Manager does not appear in the rich client, edit the
HiddenPerspectives preference and remove the ChangeManager value.

If you have trouble accessing Change Manager, see your system
administrator; it may be a licensing issue.

Note:

You can log on to Teamcenter only once. If you try to log on to more
than one workstation at a time, you see an error message.

2. Before you begin
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Configure Change
Manager

The following basic configurations are required to use Change Manager:

• To customize Change Manager business rules and objects, install
the Change Management Business Modeler IDE templates (during
installation, select Change Management in the Business Modeler IDE
Templates panel in Teamcenter Environment Manager).

• Set Change Manager preferences.

• Define your users, including groups, roles, and access rules.

• Create your own workflow processes.

Start
Change Manager

In the navigation pane, click Change Manager .
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3. Change management in Teamcenter
Teamcenter provides functionality that enables you to initiate, administer, review, approve, and execute
product changes, using your company’s business process similar to the one shown here.

By automating your change process, you can minimize change-related rework and coordinate tasks to be
performed by individuals across your organization. Because Teamcenter change management leverages
product structure definitions, you can evaluate the impact of changes, track the status and completion
of tasks, and maintain a comprehensive history of product changes throughout the lifecycle. Change
management in Teamcenter is also tightly integrated with Schedule Manager and Workflow so you can
schedule implementation activities and guide a change through its phases.

In addition, if you have changes or issues that do not need to be addressed through an extensive,
standardized change management process, such as the one that Change Manager supports, or you have
highly visual information, you can use Issue Manager. Issue Manager automatically provides access to
Siemens Digital Industries Software design review and issue resolution tools, including NX, Lifecycle
Visualization, and the Lifecycle Viewer.
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3. Change management in Teamcenter

3-2  Change Management ─ Deployment and Rich Client Usage, Teamcenter 2412
© 2025 Siemens



4. What is a change?
Three main types of change objects shown in the figure implement the key elements of Change
Manager:

Each of these objects are Item types in the business model, and, therefore, are revisionable objects. Each
object type encapsulates the data for a phase of the change process. For example, a problem report (PR)
contains the data that defines the problem, the engineering change request (ECR) contains the analysis
of the impact of the problem, and the ECN contains the data for the implementation of the solution. 

Implemented By and Implements relationships associate the change objects with each other. Each
object type can be optionally associated with a workflow that defines the sequence of tasks and moves
each object through a set of states to bring the problem to a resolution.

Anyone who uses Teamcenter can create a PR to identify and formally track an issue with your product
information. Others who are involved in the change process can review and confirm the problem and
provide input into what business objects must be updated to resolve the issue. Members of a change
review or change implementation board can review and approve or disapprove the changes.

Types of changes

The change management solution is supported using the following change objects:

Change object Description

Problem report (PR) Initiates a change.

A PR captures information about a problem or an
enhancement. It includes the information necessary to
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Change object Description

confirm and reproduce any problems observed or to
document the specifics of a request for an enhancement.
Additional attributes document the perceived severity of the
problem and set the priority for addressing the issue relative
to other PRs. 

The processing of a PR sometimes leads to the creation of an
engineering change request (ECR).

Creating a PR is an optional step in the change process.
Depending on the conventions at your site, you may first
identify a problem or enhancement with an ECR, not a PR.

A PR may be addressed by one or more ECRs.

Engineering change request (ECR) Initiates a proposal that recommends a change and captures
business decisions associated with the change.

An ECR proposes a solution to the problem with cost
estimates and benefits of making the change. The actual
solution (for example, a new item revision) is implemented
in the change notice (ECN).

An ECR is typically a response to a PR unless the PR stage is
skipped.

A single ECR may logically group and address issues identified
in multiple PRs.

An ECR may be addressed by one or more ECNs.

Engineering change notice (ECN) Implements a change.

It provides a detailed work plan to resolve one or more ECRs
or a portion of one ECR.

An ECN identifies all items and documents affected by a
change and authorizes the actions that address a change.

Deviation request Seeks consent to deviate from a solution in production to
resolve a set of problems to initiate improvements. Typically,
there are two types of deviation requests:

• Request for deviation

Seeks consent to deviate from a part solution.

• Request for waiver

Seeks consent to accept a non-conforming part.

4. What is a change?
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Relationship between the change objects.

How one change relates to another

One change object in Teamcenter relates to other change object to manage the phases of the change
process. In the preconfigured Change Manager model, an engineering change notice (ECN) implements
an engineering change request, which implements the problem reports The following figure illustrates
the relationship between these objects.

Each change object shows these relationships in the Implements and Implemented By folders of the
change. You can also derive one change from another to create these relationships.

How one change relates to another
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A single ECR can implement problems identified in one or more PRs. Similarly, a single ECN can
implement issues identified in one or more ECRs. Likewise, two or more ECNs can implement a single
ECR, as shown. Using Change Manager, you can create very complex structures of changes to satisfy
specific change requirements, providing you with the flexibility you need.

4. What is a change?
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5. What can you do in Change Manager?
Identify a problem

If you are requesting a change or reviewing a recommended solution or plan as a member of change
review board:

• Create a change. For example, create a problem report to identify a problem or enhancement,
provide a preliminary assessment, and show the steps necessary to reproduce the problem or create
an engineering change request (ECR) to propose a solution to the problem.

• Create a change in the context of a reference object.

• Derive a change from another.

Review a solution

• Review ECRs and ECNs and make a business decision to approve or reject.

Manage the change process

If you are the change specialist managing the implementation of the change:

• Initiate a workflow to guide a change through the phases of a change process.

• Assign participants as the analyst and reviewers.

• Assign effectivity to specify when an ECN takes effect.

• Close ECRs and ECNs.

Develop or implement a solution

If you are the analyst determining how to implement a solution or if you are implementing the solution:

• Define change properties.

• Relate problem and reference items.

• Create a work breakdown using Schedule Manager.

• Implement the change by creating and revising affected items.
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Administer the change management process

If you are administering Change Manager, you can:

• Install and set up Change Manager.

• Set Change Manager options.

• Set up users and the organization and roles.

• Define custom change management objects.

• Control the actions of participants through conditions.

• Create workflows.

5. What can you do in Change Manager?
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6. Understanding the change management
process
You can manage your changes in the way that works best for your company’s processes. You should
define a change process that is flexible enough to impose the appropriate level of rigor and control
based on the level of risk, cost, and the business items impacted by the change. You can classify a
change as fast or standard track. In a fast track process, the change does not go through a formal
review process, while a standard track follows a more rigorous process, and may include a schedule to
manage the required tasks. The following example shows a typical standard track process. It is followed
by a graphic that shows the process by role.

See a more complete explanation of the change management business process using generic
terminology.

The process is shown below by task with the associated role.

The following shows the roles and their tasks.
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1. Author a problem report (PR).

A requestor creates a problem report to identify a problem or enhancement, provide a preliminary
assessment, and show the steps necessary to reproduce the problem.

2. Approve a problem report.

A change specialist assigns a priority to the problem report and assigns it to an analyst for technical
review. The specialist or analyst recommends a disposition, such as Approved.

3. Create an engineering change request (ECR).

A requestor (who may be the analyst associated with the problem report) creates an ECR to address
the problem report.

6. Understanding the change management process
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At this stage, the analyst develops a solution or several alternative solutions. The analyst does this
by creating markups on documents, Word documents, presentations, and so on. No decision has
been made at this stage about whether to proceed or what new items or item revisions may be
required.

Sometimes the PR may propose a solution if the problem is simple to fix. However, the solution
would still be formally documented in the ECR. Typically, though, the requestor is unlikely to be in a
position to know what the solution should be and may likely have no idea at all.

Note:

The change request can address more than one PR.

4. Evaluate the impacts.

The change specialist assigns the ECR to an analyst. The analyst identifies the items impacted by
the change, prepares supporting documentation, and prepares a high-level proposal for the actions
required to implement the change.

5. Make a business decision.

A change specialist submits the ECR to a change review board who decides if the change will be
made. The change review board can approve the change request, reject it, or require additional
investigation. If this is a fast track change, the review board is the owner of the change and the
process moves to the execute change step.

At this stage, a decision is made about whether to revise or create new items, according to the
form, fit and function and interoperability.

6. Derive an engineering change notice (ECN).

The requestor (who may be the analyst of the ECR) either derives a new change notice to address
the approved change request or associates the ECR with an existing ECN. The ECN addresses the
implementation details of the change. It may address multiple change requests. The requestor can
delegate responsibility for elaborating the details of the implementation plan.

Note:

An ECN is always derived to implement a solution, even for an ECN that went through a fast
track process. However, the workflow for the fast track ECN is very short, with a minimal
number of steps. It is necessary to create an ECN so the analyst can add solution items, which
is not possible in the ECR, whose purpose is only to define a proposed solution.

7. Prepare an implementation plan.

The analyst develops a detailed plan to address the set of approved ECRs addressed by the ECN.
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At this stage the agreed solution is implemented in the new/revised items.

8. Approve the ECN.

For a standard track process, the change implementation board reviews and approves the plan to
address the change. For a fast track process, the approval is informal and may just require the
change specialist managing the change.

9. Assign an effectivity.

A change specialist can assign effectivities to the ECN. The effectivities specify the timing of when
the change takes effect.

10. Execute the change.

The analyst implements and tracks the detailed plan for addressing the change. A change specialist
tracks the implementation progress at a high level.

11. Close the change.

The analyst closes the associated levels of the implementation plan. When all the actions
associated with each level of the implementation plan are complete, a change specialist closes
the change.

Problem report (PR) process example

The following example shows a simple process for managing a PR. Example of a Teamcenter workflow
that supports a PR process.

After you create a PR, assign a specialist, and submit it to a workflow, you:

• Validate the Problem Report

The assigned specialist reviews the PR properties.

• Assign Analyst

The assigned specialist assigns an analyst.

6. Understanding the change management process
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• Analyze PR / Approve/Reject

The assigned analyst reviews the PR and approves or rejects the problem.

Engineering change request (ECR) fast track process example

The following fast track example shows a process for managing an ECR through fast track.

Example of a Teamcenter workflow that supports an ECR process for both fast and standard tracks.

After you create an ECR, assign a specialist and submit it to a workflow, you:

• Classify/Assign Analyst

The assigned change specialist classifies the ECR as fast track, determines if more planning is required,
and assigns an analyst.

Note:

Change Manager conditions control who can assign the analyst. The default condition allows
the current change analyst to assign a new analyst or allows the change specialist to assign an
analyst.

• Complete Planning

At this stage, the analyst develops a solution or several alternative solutions. The analyst does this by
creating markups on documents, Word documents, presentations, and so on. No decision has been
made at this stage about whether to proceed or what new items or item revisions may be required.

If more planning is required, the assigned analyst completes it. The ECR returns to the specialist to
determine if planning is complete.

Engineering change request (ECR) fast track process example
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• Derive Change

The assigned change specialist derives an ECN to implement the solution.

• ECN Process

The assigned specialist begins a fast track ECN process so the change can be executed, and the
solution items added.

Engineering change request (ECR) standard track process example

The following standard track example shows a process for managing an ECR through standard track.

Example of a Teamcenter workflow that supports an ECR process for both fast and standard tracks.

After you create an ECR, assign a specialist, and submit it to a workflow, you:

• Classify/Assign Analyst

The assigned change specialist classifies the ECR as standard track, determines if more planning is
required, and assigns an analyst.

• Complete Planning

At this stage, the analyst develops a solution or several alternative solutions.

6. Understanding the change management process
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The analyst does this by creating markups on documents, Word documents, presentations, and so
on. No decision has been made at this stage about whether to proceed or what new Items or item
revisions are required.

If more planning is required, the assigned analyst completes it. The ECR returns to the specialist to
determine if planning is complete.

• CRB Review

If the planning is complete, the assigned change review board reviews the change and signs off as
approved or rejected with comments.

• Record Business Decision

The assigned specialist reviews CRB signoffs and comments and records the business decision.

• Disposition

If approval criteria are met, the ECR is approved. The ECN process is executed.

• If the ECR is deferred, it is placed on hold.

• If the ECR is rejected, it is closed.

• If the ECR is not ready, it is sent for rework and returns to the CRB review step.

Engineering change notice (ECN) process example

The following example shows a process for managing an ECN for implementing an ECR that goes
through the standard track process.

You can also develop an ECN process for an ECR that goes through a fast track process. That ECN would
not include a formal review by the change implementation board. It would also be implemented by the
same analyst assigned to the ECR.

Example of a Teamcenter workflow that supports an ECN process for a fast track ECR.

Engineering change notice (ECN) process example
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After you create an ECN, assign a specialist, and submit it to a workflow, you:

• Classify/Assign Analyst

The assigned change specialist determines if more planning is required and assigns an analyst.

The analyst develops a solution or several alternative solutions. The analyst does this by creating
markups on documents, Word documents, presentations, and so on.

No decision has been made at this stage about whether to proceed or what new items or item
revisions may be required.

• Complete Planning

If more planning is required, the assigned analyst completes the planning. The ECN returns to the
specialist to determine if planning is complete.

• Change Implementation Board Review

If the planning is complete, the assigned change implementation board reviews the change and signs
off as approved or rejected with comments.

• Record Implementation Decision

The assigned specialist reviews change implementation board signoffs and comments and records the
implementation decision.

• Disposition

6. Understanding the change management process
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• If approval criteria are met, the ECN is approved.

• If the ECN is deferred, it is placed on hold.

• If the ECN is rejected, it is closed.

• If the ECN is not ready, it is sent for rework and returns to the CIB review step.

Note:

The Disposition state applies to all change objects.

• Execute Change

If the ECN is approved, the assigned resources (for example, designers) implement the change
according to the plan. They edit the models according to the engineer’s directions as documented
in the ECR. The design changes are approved as part of the process.

• Close Change

The assigned specialist reviews the changes. If all tasks are complete, the ECN is closed.

Engineering change notice (ECN) process example
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7. What are change states?
Change states encapsulate the following:

• The degree of completion or its maturity (for example, Elaborating or Reviewing)

• The business decision during change processing or its disposition

Three change object properties define these states: Maturity, Disposition, and Closure.

Using the default Change Manager configuration and an appropriate set of workflows, the change state
model behaves according to the model shown in the following figure. In this model, any new change
object (PR, ECR, or ECN) is assigned the following:

• A Closure state of Open

• A Maturity state of Elaborating

• A Disposition state of None

Maturity is a substate of the Closure state Open, and Disposition is as a substate of the Maturity state
Reviewing.
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A change object with a Closure state of Open moves through various maturity and disposition states
during which decisions about the change are made. The Closure state remains Open until the change
object has progressed through all phases of the change process, at which point the closure state is set
to its final state of Closed. During this process, the change object can also be temporarily placed in one
of the intermediate closure states of Hold or Cancelled. Each object has its own change states, so each
change object associated with a change must be closed individually by the change process. 

At each stage of the change process, the workflow changes the values of these three properties
according to business rules to advance the change object to its next state.

Your administrator can configure Teamcenter using the Business Modeler IDE so your company has its
own set of states, additional ones, or different values for the states. For example, your company could
have 10 values for the Closure state and could change the name of the Disposition state to Decision.
Your company can choose to follow the initial Teamcenter model or design your own. If you choose to
follow the initial Teamcenter model, Change Manager provides the necessary elements for you to build
upon.

7. What are change states?
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Change states values

There are three key change states for change objects in the Change Manager initial configuration. Each
type of change object (PR, ECR, ECN) has its own change states and must be closed individually through
the process.

Note:

Although these states are defined on each object (PR, ECR, and ECN), the values apply to the
overall change process. Therefore, the Closure state would not be set to Closed until the change
has been completed, at which stage the closure and other states needs to be set on the PR and
ECR, as appropriate.

• Closure defines the status of the change object. Change objects start with an open state and remain
there until the change is complete unless a decision is made to defer or cancel the change. The
Closure change state can be one of the following:

• Open (default value on newly created change objects)

• Closed

• On hold

• Canceled

• Maturity defines the degree of completion of the overall change process.

The elaborating state is the investigation phase. The reviewing state can be informal where one user
approves the change or formal where a review board must approve. Reviewers can decide the change
is not ready and send it back to the planning phase or approve the change. Once approved, the
change moves to the executing state and the actual changes begin with the creation of new items
and item revisions. Finally, when all the necessary data has been created and approved, the change is
considered complete.

The Maturity change state can be one of the following:

• Elaborating (default value on newly created change objects)

• Reviewing

• Executing

• Complete

• Disposition represents a technical, business, or implementation decision by a person or review board
about a change object's approval.

Change states values
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When a change object is created, the Disposition value is set to None (no disposition), which is the
default. During review, the value should be set to Investigate and once a decision has been made,
the value set to Approved, Disapproved, or possibly Deferred.

The Disposition change state can be one of the following:

• None (default value on newly created change objects)

• Investigate

• Approved

• Disapproved

• Deferred

Note:

• You cannot directly change the state. The workflow changes the state property values.

• Change state settings affect your ability to add data or relate objects to change objects (for
example, to the Impacted and Solution Items folders).

• Additional control over the ability to edit a change object while the CMClosure state is Closed is
available by using the CM_Block_Edits_To_Closed_Change_Objects preference.

Example of the state changes of a problem report

The following example shows how the default state properties change as the problem report progresses
through the steps in the workflow. The change states in your organization may vary.

Step Closure Maturity Disposition

Start Open Elaborating None

Validate the Problem
Report

Open Elaborating None

Assign Analyst Open Elaborating None

7. What are change states?
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Step Closure Maturity Disposition

Analyze PR Open Elaborating None

Approve/Reject Open Reviewing None

End Open Reviewing One of these:

• Approved

• Disapproved

• Deferred

• Investigate

The state property settings restrict permissions to add items to the problem report's folders. For
example, the closure, maturity, and disposition property settings must be Open, Elaborating, and None
for a Requestor to add an item revision to the problem report's Problem Items folder.

Note:

You cannot directly change the state. The workflow changes the state property values.

Example of the state changes in a fast track engineering change
request (ECR)

The following example shows how the state properties change as the ECR progresses through the steps
in the workflow. The change states in your organization may vary.

Example of the state changes in a fast track engineering change request (ECR)
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Step Closure Maturity Disposition Release
state

Start Open Elaborating None Pending

Classify/Assign
Analyst

Open Elaborating None Pending

Complete Planning Open Elaborating None Pending

Execute Change Open Executing Approved Pending

Close Change Open Executing Approved Pending

End One of these:

• Closed

• Canceled

• On hold

One of these:

• Complete

• Elaborating

• Executing

One of these:

• Approved

• Disapproved

• Deferred

Released

7. What are change states?
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The state property settings restrict permissions to add items to the engineering change request's folders.
For example, the closure, maturity, and disposition property settings must be Open, Executing, and
Approved for an Analyst to add an item revision to the change request's Solution Items folder.

Note:

You cannot directly change the state. The workflow changes the state property values.

Example of the state changes in a standard track engineering
change request (ECR)

The following example shows how the state properties change as the ECR progresses through the
workflow steps. The change states in your organization may vary.

Step Closure Maturity Disposition Release
state

Start Open Elaborating None Pending

Classify/Assign
Analyst

Open Elaborating None Pending

Complete Planning Open Elaborating None Pending

CRB review Open Reviewing None Pending

Record Business
Decision

Open Reviewing One of these:

• Approved

Pending

Example of the state changes in a standard track engineering change request (ECR)
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Step Closure Maturity Disposition Release
state

• Disapproved

• Deferred

• Investigate

Rework Open Elaborating Investigate Pending

End One of these:

• Open

• Canceled

• On hold

One of these:

• Reviewing

• Elaborating

• Executing

One of these:

• Approved

• Disapproved

• Deferred

Pending

The state property settings restrict permissions to add items to the engineering change request's folders.
For example, the closure, maturity, and disposition property settings must be Open, Elaborating,
and None for a Requestor to add a problem report to a change request. The PR state settings have
restrictions as well (Open, Reviewing, Approved).

Note:

You cannot directly change the state. The workflow changes the state property values.

Example of the state changes in an engineering change notice

The following is an example of how state properties change as the engineering change notice
progresses through the steps in the workflow. The change states in your organization may vary.

7. What are change states?
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Step Closure Maturity Disposition Release
state

Start Open Elaborating None Pending

Classify/Assign
Analyst

Open Elaborating None Pending

Complete Planning Open Elaborating None Pending

CIB Review Open Reviewing None Pending

Record
Implementation
Decision

Open Reviewing One of these:

• Approved

• Disapproved

• Deferred

• Investigate

Pending

Set Effectivity Open Reviewing Approved Pending

Rework Open Elaborating Investigate Pending

Execute Change Open Executing Approved Pending

Close Change Open Executing Approved Pending

End One of these:

• Closed

• Canceled

• On hold

One of these:

• Complete

• Elaborating

• Reviewing

• Executing

One of these:

• Approved

• Disapproved

• Deferred

Released

The state property settings restrict permissions to add items to the engineering change notice's folders.

For example, the closure, maturity, and disposition property settings must be Open, Elaborating, and
None for a Requestor to add a change request (ECR) to a change notice (ECN). The ECR state settings
have restrictions as well (Open, Reviewing, Approved).

To relate a revision to an ECN, the closure, maturity, and disposition property settings must be Open,
Reviewing, and Approved as well as the release state must be something other than null or Released
(for example, Pending).

Example of the state changes in an engineering change notice
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Note:

You cannot directly change the state. The workflow changes the state property values.

7. What are change states?
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8. Change Manager interface

1 Open Change view Displays change folders and any attached forms or other
objects.

2 Open Task view Displays change folders associated with a Schedule
Manager task used for work breakdown planning.

3 Change Home view Contains saved searches for change objects defined by
system administrators and users. The default search is My
Open Changes.

4 Change Manager perspective Contains views to display change properties, related items,
BOM changes, change effectivity, and work breakdown
tasks.

Change Manager tabs

Tab Description

Summary Displays the property information of the selected object.
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Tab Description

It also lets you add or remove items belonging to a change
object and display workflow tasks associated with the
change object.

Details Displays the children of the selected component in the
Change tree.

Viewer Displays the registered viewer for the selected component
in the Change tree. When a change revision is selected, the
Viewer tab displays a user-defined list of change properties
and also displays change forms in a tabular format.

Impact Analysis Provides graphical where-used and where-referenced search
capabilities.

BOM Changes Displays changes to the structure of the selected object,
based on the displayed change.

Change Effectivity Displays the end item effectivity information for the
selected impacted/solution items in an engineering change
notice. End item effectivity information is created, modified,
and displayed in this view. Clicking the Create button opens
the Create Effectivity dialog box. Use this dialog box to
search for end items and to set unit and date effectivities.

Work Breakdown, Schedule
Manager

Displays the structure of the schedule and task breakdown
in Schedule Manager and allows you to modify it or create
a new one. Schedule Manager must be installed to see this
view.

Change Details Lets you add or remove items associated with a schedule
task and display workflow tasks and assignments
associated with the schedule.

Workflow Viewer Lets you view the tasks in a workflow associated with a
change object or schedule using the Workflow Viewer. It
provides a task view representation of the workflow to which
the selected change object or schedule task is submitted.

Change Manager menus

All Change Manager menus are standard Teamcenter rich client menus with the following additions.

8. Change Manager interface
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Menu command Description

File→New→Change Displays the New Change dialog box and allows the
creation of a change object.

Tools→Assign Participants Assigns users, group members, or role members called
participants to perform certain tasks during the change
process.

Change Manager buttons

Button Description

Manage saved searches Displays the Manage Saved Searches dialog box and allows
the creation, modification, or deletion of searches to find
change objects. This button is found in the Change Home
view.

Add Form Displays the BOM line item form dialog box and allows you
to associate a form with a structure change. You can use the
boxes in the form to document the purpose of the change
or other change information. This button is found in the
Change Manager BOM Change view.

Delete Form Removes the selected BOM change form for the solution
item. This button is found in the Change Manager BOM
Change view.

Rollup Displays the Roll Up view with a static display of all business
and change items contained in the change folders of the
selected change object and any of the associated tasks in the
work breakdowns. The set of relation folders displayed is the
same as in the Open Change view. This is a virtual rollup
of objects to provide consolidated visibility of the related
items anywhere in the work breakdown of the change. Once
the change is complete, you can make the rolled-up objects
permanent by sending them to the top-level change object.
This button is found in the Open Change view.

Open in Structure Manager with
Supersedure Window 

Displays the Supersedure view in Structure Manager with
the selected item revision from the Solution Items folder.
This button is found in the Open Change view.

Caution:

When you open a change object in the supersedure
window for the first time, click the split panels icon:

Change Manager buttons
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Button Description

You must select Yes from the confirmation dialog.
If you select No, clicking the split panels icon when
opening subsequent changes results in no action; the
confirmation window does not appear nor does the
supersedure window open. To reset this behavior after
clicking No, you must close all Structure Manager
windows.

To disable the confirmation dialog and open
supersedure windows automatically in the future, set
the CM_disp_bom_edits_dialog preference to Yes.

Open Schedule Displays the Schedule Manager view. This button is found in
the Open Change view.

View Task folders Displays the Open Task view. This button is found in the
Schedule Manager view.

8. Change Manager interface
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9. Change management business process
descriptions and roles
Overview of the change management business process

Teamcenter provides you with the ability to identify, approve, sequence, and validate product
enhancements throughout a product’s entire lifecycle. The following shows the basic business process
divided into four phases for managing changes. You can configure the business process for your
company’s needs. A more complete figure is shown after the table, which includes the many participants
involved in identifying, managing, and resolving a change incident, including requestors, analysts, and
the different review boards. The industry-independent best practices of CMII are the foundation of the
change management business process.

Click a phase in the table to learn more about it.

Note:

We use general terms and not Teamcenter terms to help you understand the process without first
having to understand Teamcenter.

Documented event or idea that can result in a product change or a new product.
It can be resolved with both short- and long-term solutions.

An incident report documents the change driver. It includes the information
necessary to confirm and reproduce any problems observed or to document the
specifics of a request for an enhancement. Additional attributes document the
perceived severity of the problem and set the priority for addressing the problem
relative to other incident reports.

You can use the Teamcenter products Corrective Action Preventive Action
(CAPA), Change Manager, or Issue Manager to initiate an incident report.

Note:

In Change Manager, an incident report is called a problem report.

Documented and authorized solution addressing the change driver.

A change solution collector stores the change solution, including the change
analyses and captures business decisions associated with the change solution.
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Note:

In Change Manager, a change solution collector is called an engineering
change request (ECR).

Documented and executed plan realizing the authorized change solution.

A change implementation collector stores the results of the change. It provides a
detailed work plan to resolve one or more change solutions.

Note:

In Change Manager, a change implementation collector is called an
engineering change notice (ECN).

Application of the updated product definition during product build,
manufacturing, and construction to produce the updated product.

9. Change management business process descriptions and roles
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Overview of the change management business process
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Change driver business phase

The change driver business process is a documented event or idea that can result in a product change or
a new product. It can be resolved with both short- and long-term solutions.

Role Process overview Teamcenter tasks

Document change driver

Requestor

Creates and updates the incident report (called a
problem report in Teamcenter) that collects all the
information about the incident, including root causes,
references, and verification records.

• Create a
problem report

• Update the
problem report

Investigate incident

Develops a short-term solution and reproduces the
incident.

• Determines the best way to resolve the incident as
quickly as possible until a long-term resolution can

• Update a
change

9. Change management business process descriptions and roles
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Role Process overview Teamcenter tasks

Analyst be applied. It is an optional step to quickly address
non-conformances.

• Reproduces the incident by recreating the conditions
when the incident occurred and by repeating the
steps leading up to the incident, including adding
the problem and impacted items to the change
object folders as helpful.

• Determines the specific root-causes of an incident to
be resolved with corrective actions.

• Managing items
related to a
change object

Investigate incident and approve

Incident review board

Evaluates the incident report and, if appropriate,
approves it. The incident moves to the Change solution
phase.

• Evaluates the incident description, including its root
causes, reproducibility, severity, ramifications, and
short-term resolution, if any.

• Decides if the incident requires a long-term
resolution.

• Returns the incident report for rework or to get
answers to questions to be sure of a good decision.

Review a change

Change solution business process

The change solution business process is the documented and authorized solution addressing the change
driver.

Change solution business process
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Role Process overview Teamcenter tasks

Initiate solution

Initiate solution

Creates and updates the change solution
collector (called an engineering change request

• Create an
engineering change
request

9. Change management business process descriptions and roles
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Role Process overview Teamcenter tasks

Requestor in Teamcenter) to collect all information about
the change solution.

• Relate change
objects to other
change objects

Define/analyze solution

Change specialist

• Determines if the change solution planning is
complete.

• Reviews the change solution, the root-cause
items, and the impacted items to be sure
the solution definition is complete for a
business decision to be made.

• If enough planning has been completed,
manages the cost estimation, and when
that is complete, sends the change to the
change review board.

• Determines the process flow for the change
solution (standard or informal).

• Manages the cost estimation.

• Assigns the cost estimators, ensures timely
completion of the estimates, and evaluates
the completeness of the estimate.

• Associates the cost estimates with the
change solution.

• About classifying a
change

• Update a change

• Initiate a workflow
process

• Managing the
participants of a
change

Analyst

Analyzes the change, and proposes and updates
one or more solutions that satisfy the change
drivers.

• Update the
engineering change
request

• Relate change
objects to other
change objects

• Managing items
related to a change
object

• Searching for change
objects

Change solution business process
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Role Process overview Teamcenter tasks

Technical review board

Reviews the solution from a technical viewpoint.

• Evaluates the technical merits of the proposed
change solutions, including rough estimate of
costs.

• Evaluates competing changes.

• Selects the recommended solution.

• Returns the change solution for rework or to
get answers to questions needed to ensure a
good decision.

Review a change

Cost estimator

Develops an estimate of all the recurring and
nonrecurring costs associated with the proposed
solution.

Update the engineering
change request

Change review board

Makes the business decision about the solution
by evaluating the cost benefits, the overall
budget, and the priority. May return the change
solution for rework or to get answers to
questions needed to ensure a good decision.

• Review a change

• Update the
engineering change
request

Change implementation business process

The change implementation business process is a documented and authorized solution addressing the
change driver.

9. Change management business process descriptions and roles
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Role Process overview Teamcenter tasks

Change implementation planning

Requestor

Creates change implementation collector
(called an engineering change notice in
Teamcenter) to collect all information
about the change implementation.

• Create an engineering
change notice

• Relate change objects to
other change objects

Change implementation business process
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Role Process overview Teamcenter tasks

Change implementation planning and execution

Change specialist

• Determines if the change
implementation planning is complete.

• Determines the process flow for the
change solution (standard or informal).

• Updates the change effectivity on the
change implementation collector.

• Reviews the change implementation,
the root-cause items, the impacted
items, and the implementation plan
to make sure the implementation
plan is complete enough for the
implementation decision.

• Records the change effectivity as
determined during the implementation
decision.

• About classifying a change

• Update a change

• Initiate a workflow process

Analyst

• Defines the tasks required to implement
the change solution.

• Confirms and addresses future-effective
competing changes.

• Includes the tasks to incorporate
cancelled future-effective competing
changes. Identifies any scope changes,
and stop the planning accordingly.

• Performs or manages the completion
tasks in the approved implementation
plan.

• Update a change

• Scheduling
implementation activities

• Managing items related to
a change

• Create a BOM change

• View the status of
a workflow in Change
Manager

• Display work assignments
and their status

• Managing the participants
of a change

• Replacing part instances
using Mass Update

9. Change management business process descriptions and roles
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Role Process overview Teamcenter tasks

• Managing unincorporated
changes

Change implementation planning

Change
implementation board

• Evaluates the proposed change
implementation plan.

• Determines the change effectivity.

• Decides if the plan is sufficient to
implement the solution to achieve the
effectivity.

• Returns the change Implementation for
rework or to get answers to questions
needed to be sure of a good decision.

• Review a change

• Update the engineering
change notice

Change implementation execution

Product development
organizations

The product development disciplines and
organizations make necessary changes,
including updating planning, design,
packaging and labels, and publications.

Managing the participants of
a change

Change incorporation phase

The change incorporation business process applies the updated product definition during product build,
manufacturing, and construction to produce the updated product.

Change incorporation phase
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Role Process overview Teamcenter tasks

Closed-loop execution

Change
specialist

Manages the results validation and release, such as
routing results to downstream processes, auditing
the change, and more. Also, closes the change.

• Assigns the change results reviewers, ensure
timely completion of the reviews, evaluate the
completeness of reviews, and release approved
change results.

• Collects change records and resulting items into
a package and send the package to recipients.

• Reviews every aspect of the change (all
change items), the root-cause items, the
impacted items, the resulting items, and the
implementation plan to ensure all tasks are
complete and all requirements have been met.

• Marks the change item as closed. Lock the
change item and relationships against updates.

• Managing the
participants of a change

• View the status of
a workflow in Change
Manager

• View workflow
assignments and their
status

• About setting change
states

9. Change management business process descriptions and roles
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Role Process overview Teamcenter tasks

Change implementation

Change results
reviewer

Reviews the resulting items for conformance
to the change as-planned. Documents all non-
conformances.

• View the status of
a workflow in Change
Manager

• View workflow
assignments and their
status

• Review a change

Change incorporation phase
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10. Identifying changes
Ways to identify changes

Any user can create a problem report (PR) identifying a problem. Your administrator can use groups and
roles along with conditions in the Business Modeler IDE to configure which change objects users can
create. Check with your administrator to see how your change management solution is configured.

You need a license level that enables authoring to create anything besides a PR. If you do not have a
higher level license, you are limited to creating PRs only.

You can create a change object three different ways:

• Independent of other existing objects

• In the context of any revisable object (impacted or problem item, 4GD design element, and so on)

• In the context of an impacted or problem item revision

• Derived from another change object; only ECRs, deviation requests, and ECNs can be created this way

If you derive a change object from another, you can copy the relations (such as reference items and
problem items) and the object’s synopsis (name) and description. You can change the synopsis and
description.

About deriving a change

You can derive a change object from another to manage the next phase of the change process.

To derive a change, you must have the correct permissions and the change must be in the change state
state.

• Derive an engineering change request (ECR) from a problem report (PR) to determine a solution for
the problem.

• Derive an engineering change notice (ECN) from an ECR to implement the solution to the problem.

• Derive a deviation request from a PR to allow a deviation.
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In addition, if your company has custom changes, you can derive one custom change from another. You
can also derive a single solution (engineering change request) that addresses multiple problem reports.

Note:

Depending on how Teamcenter is set up, the reference, problem, or impacted objects associated
with the source change (its relationships) may be automatically added to the derived change.
See your system administrator for more information.

In the Create Stylesheet for the given type being derived, the CREATERENDERING property for
the custom change notice must point to ChangeNoticeCreate and Propagate Relations must be
checked.

If you are using a custom create stylesheet for the custom Change Notice, which is already
configured as the CREATERENDERING for your type, add the following line:

<customPanel
java="com.teamcenter.rac.cm.wizards.ui.PropsPageRelationshipPanel"
js="displayCMCustomePanel"/>

Derive a change from another

1. Select one or more problem report or engineering change request revisions, right-click, and choose
Derive Change.

The revisions must have their properties set to:

10. Identifying changes
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Property Must be

Maturity Reviewing

Disposition Approved

Closure Open

2. In the create dialog box, select the type of change you want to create (engineering change request,
engineering change notice, or deviation request), and click Next.

The create dialog box appears with the information about the derived change already filled in. You
can edit these boxes.

3. (Optional) Type an ID and revision.

If you do not provide an ID and revision number, Teamcenter provides them automatically.

4. If you want to copy the relationships (such as reference items and problem items) from the source
change object to the derived change, select Propagate relations.

Your system administrator configures how reference, problem, or impacted objects associated with
the source change object (its relationships) may be automatically added to the derived change. See
your system administrator for more information.

5. (Optional) Click Open on Create to open the change in Change Manager after it is created.

6. Click Finish.

Derive a change from another
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Define deep copy rules for copying options from an ECR to an ECN

Use Teamcenter Business Modeler IDE deep copy rules to configure the copying options when a user
derives an ECN from an ECR. Deep copy rules define whether objects belonging to a business object
instance can be copied when a user performs a Derive operation on that instance. Deep copy rules
configure the copy option, providing the ability to select individual objects from the Affected Items and
Reference Items in an ECR.

Using deep copy rules, you can configure whether the following are copied into the ECN:

• Impacted Items

• Problem Items

• Reference Items

You can create rules for the default relation types CMHasImpactedItem, CMHasProblemItem,
CMReferences.

Refer to the BMIDE for Data Model Design in the Teamcenter collection for more information.

Note:

Validate that the setting copyFromOrignal is set to true on persistent properties to copy them
during the derive process. If copyFromOrignal is set to false on persistent properties, the
properties are not copied during derive.

Create Deep Copy Rules in BMIDE

1. Create a custom template based on the Change Manager template.

2. Open the Change Item Revision Business Object.

You can create a Derive deep copy rule for GnChangeRequestRevision and
GnProblemReportRevision.

• Select the Show Inherited Rules check box to display all rules inherited from parent business
objects.

• Select the Organize by Inheritance check box to sort the rules by parent business object names.

• Use the Add, Edit, or Remove buttons to work with the deep copy rules.

3. Select the Deep Copy Rules tab and click the Add button to add a row for each rule.

4. Choose the business object that the deep copy rule is applied to.

10. Identifying changes
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Specify the parameters for each rule.

Parameter Description

Target Primary? Mark or clear the check box as appropriate.

When the checkbox is marked, Target Business
Object is the primary object of the relationship
specified in the Relation Type box. When the
business object instance is revised or saved,
the secondary objects are carried forward and
related using the relation in the Relation Type
box.

When the checkbox is cleared, Target Business
Object is the secondary object of the
relationship specified in the Relation Type box.
When the business object instance is revised or
saved, the primary objects are carried forward
and related using the relation in the Relation
Type box.

Operation Type Select Derive.

Type Relation creates the deep copy relationship

Relation / Reference
Property

Select CMHasImpactedItem, CMHasProblemItem, or CMReferences.
You will supply a rule for each relation.

Attached Business
Object

For CMHasImpactedItem and CMHasProblemItem types select
ItemRevision.

For CMReferences select WorkspaceObject.

Condition Select the condition isTrue.

Action Choose the kind of copying to be allowed for the business object. The
available options differ depending on the type of target business object.

Select CopyAsReference. This creates a new relation between the new
revision and the related object. Therefore, modifications performed on
the copied object are propagated to the source object.

Note that if the deep copy rule NoCopy is set as isTrue and Required,
then this relation does not appear in any panel in Active Workspace.

Required Leave blank.

Define deep copy rules for copying options from an ECR to an ECN
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Parameter Description

Secured Select if you want to prevent the deep copy rule from being modified or
overridden by another template.

Copy Properties on
Relation

Select if you want persistent properties on relation objects carried
forward when the primary objects participating in relations are revised
or saved as new objects.

If not selected, only mandatory properties are carried forward.

5. Click Finish.

The rule is created and appears in the table in the Deep Copy Rules editor.

Defining deep copy rules for creating changes from another change

Use the Teamcenter Business Modeler IDE deep copy rules to set what objects and attributes are copied
when a user creates a copy of a change from another. Deep copy rules define whether objects belonging
to a business object instance can be copied when a user performs a save as or revise operation on
that instance. Deep copy rules can be applied to any business object type and are inherited by children
business object types.

Using deep copy rules, you can configure whether the following are copied for a change:

• Name, subject, description

• Problem and Impacted Items

• Referenced or related documents

The figure shows the deep copy rules defined by default for a ChangeItemRevision in the Deep Copy
Rules editor. The rules define that when copying a change, copy the problem, impacted, and reference
objects, but do not copy the incorporates and solution items.

10. Identifying changes
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Note:

Validate that the setting copyFromOrignal is set to true on persistent properties to copy them
during a save as or revise operation. If copyFromOrignal is set to false on persistent properties,
the properties are not copied during save as or revise.

About creating a change in the context of an object

You can create a change in the context of an impacted or problem item revision. The item revision is
automatically added to the Problem Items folder.

You can create a change in the context of any revisable object (impacted or problem item, 4GD design
element, and so on). The object is added to the appropriate folder depending on the type of object, the
type of change, and how your Teamcenter is set up. The following table shows the where the different
objects are placed by default.

About creating a change in the context of an object

Change Management ─ Deployment and Rich Client Usage, Teamcenter 2412  10-7
© 2025 Siemens



For the object Placed in the folder (its relation)

Item revision

Workset

10. Identifying changes
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For the object Placed in the folder (its relation)

Partition

Design element

Create a change

Learn about the permissions required to create a change and the different contexts in which to
create it.

1. Select the folder to contain the change, and choose File→New→Change.

2. In the New Change dialog box, select the type of change you want to create, and click Next.

Create a change
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3. Type a short description of the problem in the Synopsis box and a more complete description in
the Description box, as shown for a problem report.

Tip:

The synopsis is visible anywhere a list of change objects is found, while the description is
only visible when looking at more detailed information about the change, such as in the
Summary view. Therefore, use the synopsis to help organize your changes and use the
description to help others understand and execute the change.

10. Identifying changes
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4. (Optional) Type a change ID and revision.

If you do not provide an ID and revision number, Teamcenter provides them automatically.

5. (Optional) Click Open on Create to open the change in Change Manager after it is created.

6. Click Finish.

Create a change in the context of a reference object

Learn about the permissions required to create a change and the different contexts in which to
create it.

1. Right-click an item revision and choose New Change in context.

Right-click a revisable object, such as an item revision or 4GD design element, and choose New
Change in context.

2. In the New Change dialog box, select the type of change you want to create, and click Next.

3. Type a short description of the problem in the Synopsis box and a more complete description in
the Description box, as shown for a problem report.

Create a change in the context of a reference object
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Tip:

The synopsis is visible anywhere a list of change objects is found, while the description is
only visible when looking at more detailed information about the change, such as in the
Summary view. Therefore, use the synopsis to help you organize your changes and use the
description to help others understand and execute the change.

4. (Optional) Type a ID and revision.

If you do not provide an ID and revision number, Teamcenter provides them automatically.

5. (Optional) Click Open on Create to open the change in Change Manager after it is created.

6. Click Finish.

A thumbnail from the problem item is automatically attached to the change object, if it exists.

Note:

If you would prefer that the thumbnail be derived dynamically from the items related
to change, set the CM_derive_thumbnail_from_relations preference to true. False is the
default option.

The reference object is automatically copied to the appropriate folder.

The item revision is automatically copied to the Problem Items folder of the change object.

10. Identifying changes
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Create a new copy of an ECN using Save As

You can use an existing ECN as the basis for a new ECN by copying it. The new ECN does not carry over
solution items from the original revision and has a new, empty change space associated with it.

1. Select the ECN to copy, and select File→Save As.

2. In the Save Change Notice Revision As dialog box, select True or False to check out the new ECN.

3. Type a short description in the Description box.

4. Enter a revision letter, or click Assign to select one automatically.

5. (Optional) Click Open on Create to open the change in Change Manager.

6. Click Next.

7. Select Copy Reference, Copy Object, or No Copy.

• Copy Object creates a new copy of the attached object.

• Copy Reference points to the original attached object.

• No Copy indicate that neither a reference nor a copy of the attachment is used.

Select the item, and click Next.

Create a new copy of an ECN using Save As
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8. Type a description for the related objects in the Description box.

9. Enter an ECN number, or click Assign to generate a number automatically.

10. (Optional) Type a synopsis for the ECN.

10. Identifying changes
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11. Click Finish.

Create a new copy of an ECN using Save As
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11. Searching for change objects
Types of searches

There are two kinds of searches that you can use:

• System-defined searches

Searches created by a Teamcenter administrator shared by all users at a site. They are populated
by saved queries and do not require users to provide search criteria. They appear as folders in the
Change Home view. Teamcenter administrators can create, modify, or delete these searches.

The My Open Changes system-defined search is standard with Teamcenter and appears as a folder in
the Change Home view.

To execute the search, expand the folder.

• User-defined searches

Searches created by individual users for their personal use that are unique to them. They are
populated by the searches in the user's My Saved Searches list. They appear as folders in the Change
Home view.

Note:

A search name cannot contain a forward slash (/).

Create a search in Change Manager

1. In the Change Home view, click Manage saved searches .

2. In the Manage Saved Searches dialog box, click Add.

3. The default type is User-defined. If you are an administrator, you can select System-defined from
the list if you want the search available to all users.

4. Leave the Show check box selected.

5. Click the Assigned search list to select the search that is assigned to the folder.

The list contains your user-defined saved searches.

If you add a search that requires the user to provide additional information, an error is displayed
when that search folder is opened by a user.
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The system-defined searches displayed are searches that query change item revisions and require
no user interaction. You can use any of the system-defined searches.

6. The Search name defaults to the name of the search you selected in the Assigned search list.
Optionally, you can change it.

Note:

A search name cannot contain a forward slash (/).

7. Click OK.

Run a search

To run a search, do one of the following:

• If the search folder in the Change Home view is closed, open it.

• If the search folder in the Change Home view is already open, right-click the search folder and choose
Refresh.

Display searches in the Change Home view

1. In the Change Home view, click Manage saved searches .

2. To hide a search, clear the search's Show check box in the Manage Saved Searches dialog box.

3. To display a hidden search, select the search's Show check box.

4. Click OK.

Delete a search

1. Right-click the search folder in the Change Home view and choose Delete.

You can delete your user-defined searches. You can delete system-defined searches only if you are
an administrator.

2. In the Delete search folder dialog box, click OK.

11. Searching for change objects
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12. Reviewing changes
About reviewing a change

All the tasks to review and implement changes are typically controlled by workflows that flexibly guide
the change through the change process: authoring, review and approval, execution, and closure. When
you are requested to review a change, you receive a Perform Signoff task in your Tasks to Perform
folder.

Review a change

1. Select the perform-signoffs task in your Tasks to Perform folder.

2. Click the Viewer tab, and select the Task View option.

The system displays the Perform Signoff pane listing process information.

• Responsible Party

When the Responsible Party entry displays as an active link, you can reassign the parent task by
clicking the link and selecting a new group, role, and user.

Reassigning the task transfers ownership of the parent task to the selected user, making that
user the Responsible Party for the task. It does not, however, transfer your signoff responsibility.

• Instructions

When the Instructions link is displayed, there are instructions for the task. You can view the
instructions by clicking the link.

• Attachments

When there are attachments to the workflow process, you can view them by clicking the
Attachments link.

The system displays the Attachments dialog box. Target and reference attachments are listed
beneath the signoff task in the task tree.

• All Comments

If the All Comments entry is present and is as an active link, comments are written for the task.
You can view the comments by clicking the link.
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3. (Optional) If you are a privileged user because you are the process owner, the responsible party,
or a member of the administration group, you can delegate your signoff responsibility for the
perform-signoffs subtask to another user.

Note:

If you are selected to a signoff team based on your inclusion under a signoff profile, you
can only delegate the perform-signoffs subtask to another user who can match your signoff
profile group and role. Otherwise, you can delegate the perform-signoffs subtask to any
other user.

a. Click your linked name in the User-Group/Role column.

The system displays the Delegate Signoff dialog box.

b. Select a new user from the Group, Role, and User lists.

c. Click OK.

Teamcenter assigns the task to the specified user and the task is placed in their Tasks to
Perform folder.

4. Sign off the task:

a. Click the link in the Decision column to display the Signoff Decision dialog box.

b. Select an option.

• If perform-signoffs is a subtask of an Acknowledge task, select Acknowledged or Not
Acknowledged.

• If perform-signoffs task is a subtask of a Review task, select Approve, Reject, or No
Decision.

Note:

The Not Acknowledged and No Decision options do not apply to the quorum count. If
your decision is necessary to meet quorum requirements, this subtask cannot complete
until you select either Acknowledged or Approve.

c. (Optional) Type comments in the Comments box.

d. Click OK.

If user authentication is required to complete the task, type your password in the Password
box, and click OK.

12. Reviewing changes
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Note:

This authorization is determined by the creator of the process template. If your site
employs Security Services, you must use the Security Services password rather than
your Teamcenter password.

The task is complete and the Viewer tab now displays No View Data Available.

Review a change

Change Management ─ Deployment and Rich Client Usage, Teamcenter 2412  12-3
© 2025 Siemens



12. Reviewing changes

12-4  Change Management ─ Deployment and Rich Client Usage, Teamcenter 2412
© 2025 Siemens



13. Developing and implementing changes
Managing objects related to a change

About relating objects to a change

During the change process, you can relate other business objects (such as items, schedules, assemblies)
to change objects or relate the change objects to each other. The relationships are represented
graphically as folders, often referred to as pseudo-folders. The folders help you keep track of all business
objects related to the change.

For example, as shown in the figure, you could add reference documents to a problem report (PR)
to further clarify the problem or specify which item revisions are impacted by an engineering change
request (ECR). When you implement a change, the new item revisions created to solve the problem are
related as solution items.

You can manually add the objects to the change object to create the appropriate relations or the
relations can be automatically created when you create a change object.

• Manually add the objects to create the relationships

You create the appropriate relations by adding objects to the folders of the change object. You do this
as you would add objects to any folder in Teamcenter. For example, you add the part that is causing
the problem to the PR.
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You can also manage relationships using Teamcenter views.

• Automatically added when you create a change object from another

Some relations, such as problem item relations, can be automatically propagated from a change
object to another when you:

• Create the change object in the context of another

For example, if you create a change in the context of the problem part, the problem part is
automatically added to the Problem Items folder.

• Derive a change from another

For example, if you derive an ECR from a PR, the problem part associated with the PR is
automatically added to the Problems Items folder of the ECR. In addition, when you derive the
ECN to implement the solution, the problem item moves to the Problem Items folder of that ECN
as shown in the figure. This makes the object visible from each change object associated with the
change. 

In addition, the change object from which you derived the change is added to the Implements folder,
and the object that is implementing it is added to the Implemented by folder.

Your administrator can configure the types of relations to be propagated when change objects are
derived.

Contents of the change folders

The following table lists the change folders, the relationships they define, and the permissions and
change states required to add an object to it.

Change folder and its
contents How to add the objects

Problem Items

Contains item revisions
with the problems that
the change is to address.
This could be the parent
assembly.

To create a relationship between an item revision and a change object
(PR, ECR, or ECN), add the item revision to the change object's Problem
Items folder.

You must be an assigned participant and the change object property
settings must be as follows.

13. Developing and implementing changes
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Change folder and its
contents How to add the objects

Assigned
participant

Closure/Disposition/Maturity
property settings

Requestor Open/None/Elaborating

Analyst Open/None/Elaborating

or

Open/Investigate/Reviewing

Impacted Items

Contains item revisions
that are being changed
as a result of the change
process.

• To create a relationship between an item revision that an engineering
change request (ECR) or engineering change notice (ECN) affects and
the ECR or ECN.

• To add the item revision to the ECR or ECN's Impacted Items folder.

You must be an assigned participant and the ECR or ECN property
settings must be as follows.

Assigned
participant

Closure/Disposition/Maturity
property settings

Analyst Open/None/Elaborating

or

Open/Investigate/Reviewing

Solution Items

Contains item revisions
that are generated as a
result of the change (for
example, the new piece
parts and the new revision
of the parent assembly to
contain them).

To create a relationship between an item revision and the ECN that
implements the change, add the item revision to the ECN's Solution
Items folder.

You must be an assigned participant and the ECN property settings must
be as follows.

Assigned
participant

Closure/Disposition/Maturity
property settings

Analyst Open/Approved/Executing

Learn more about relating a solution item revision to an impacted
item revision.

Contents of the change folders
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Change folder and its
contents How to add the objects

Reference Items

Contains any Teamcenter
object, including datasets,
that reference related
information (such as
analysis documents and
system logs).

To associate related information (such as analysis documents and system
logs) with a PR, ECR, or ECN, add any Teamcenter object, including
datasets, to the Reference Items folder.

You must be an assigned participant and the property settings for the PR,
ECR, or ECN must be as follows.

Assigned
participant

Closure/Disposition/Maturity
property settings

Requestor Open/None/Elaborating

Analyst Open/None/Elaborating

or

Open/Investigate/Reviewing

Plan Items

Contains schedules that
define tasks in a work
breakdown structure.

To associate related work breakdowns (schedules) with an ECR or ECN,
add any schedules to the Plan Items folder.

You must be an assigned participant and the property settings for the
ECR or ECN must be as follows.

Assigned
participant

Closure/Disposition/
Maturity property settings

Analyst Open/None/Elaborating

or

Open/Investigate/
Reviewing

Implements

Contains change object
revisions that reference
this change object. An ECR
implements PRs. An ECN
implements ECRs.

Note:

A PR does not have a Implements folder because it does not
implement a problem, only identifies one.

Usually, the Implements folder is automatically populated as part of the
change process, but you can add to it if you are an assigned participant
and the property settings are set as follows:
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Change folder and its
contents How to add the objects

Assigned
participant

Closure/Disposition/Maturity
property settings

Analyst Open/Approved/Reviewing

Learn more about viewing the relationships between change
objects.

Implemented By

Contains change object
revisions that are
referenced by this
change object. A PR is
implemented by ECRs. An
ECR is implemented by
ECNs.

Usually, the Implemented By folder is automatically populated as part
of the change process, but you can add to it if you are an assigned
participant and the property settings are set as follows:

Assigned
participant

Closure/Disposition/Maturity
property settings

Analyst Open/Approved/Reviewing

Learn more about viewing the relationships between change
objects.

About viewing relationships using the Implements and Implemented by
folders

Two change object folders show the relationships between the change objects during the stages of
the change process:

• A change object’s Implements folder shows the change objects that are addressing the problem that
the change object identified.

• A change object’s Implemented By folder contains the change objects whose problems the change
object is addressing.

For example:

• The engineering change notices (ECN) Implements folder contains the engineering change request
(ECR) whose problem it is addressing, while that ECR’s Implemented By folder contains the ECN that
is correcting the problem it identified.

• The problem report (PR) Implemented By folder contains the ECRs that correct the problem that the
PR identified.

About viewing relationships using the Implements and Implemented by folders
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Note:

A PR does not have a Implements folder because it does not implement a problem, only identifies
one.

Usually, the Implements and Implemented By folders are automatically populated as part of the
change process but you can add to them if you are an assigned participant and the property settings are
set as follows:

Assigned
participant

Closure/Disposition/Maturity
property settings

Analyst Open/Approved/Reviewing

Because you derive a single change object from a change object, you must manually create any
relationships you want from other related change object. For example, if you use one ECR to implement
multiple PRs, only the PR from which you derive the ECR is added to the Implements folder of the ECR.
The following shows ECR-000489, which implements three PRs.

ECR-000489 was derived from PR-000955 so PR-000955 was automatically added to the Implements
folder of ECR-000489. The other two PRs were manually added to the Implements folder.
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You would also need to add related items to its other folders, such as adding problem items to its
Problem Items folder.

Relate change objects to other change objects

Usually, the Implements and Implemented By folders are automatically populated as part of the
change process but you can add to them if you are an assigned participant and the property settings are
set as follows:

• To associate a PR with an ECR, add the PR to the ECR’s Implements folder. You can add or delete PRs if
you are an assigned participant and the ECR and PR property settings are as follows.

Assigned
participant

Closure/Disposition/Maturity
property settings

Requestor ECR Open/None/Elaborating

PR Open/Approved/Reviewing

Change Specialist ECR Open/None/Elaborating

or

Open/Investigate/Reviewing

PR Open/Approved/Reviewing

• To associate an ECR with an ECN, add the ECR to the ECN’s Implements folder. You can add or delete
ECRs if you are an assigned participant and the ECN and ECR property settings are as follows.

Assigned
participant

Closure/Disposition/Maturity
property settings

Requestor ECN Open/None/Elaborating

ECR Open/Approved/Reviewing

Change Specialist ECN Open/None/Elaborating

or

Open/Investigate/Reviewing

ECR Open/Approved/Reviewing

Relate change objects to other change objects
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Note:

• You can associate more than one PR with an ECR and one PR with several ECRs.

• You can associate more than one ECR with an ECN and one ECR with several ECNs.

Create a new revision of impacted items

A change object can have multiple impacted and solution items. Processing these items one at a time
can be inefficient and prone to error. Therefore, you can revise one or more items in the Impacted Items
folder of an engineering change notice (ECN) and add them as new revisions in the Solutions Items
folder.

By default, to revise an item in the Impacted Items folder, the following properties must be met.

Assigned
participant

Closure/Disposition/Maturity
property settings

Analyst Open/Approved/Executing

You can also create a BOM change after revising an item.

To revise an impacted item:

1. Double-click the ECN revision to open it in the Open Change view as shown.
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2. Select the item or items in the Impacted Items folder you want to revise.

3. Choose File→Revise.

A new revision appears in the Solution Items folder.

The revision rule of the new revision items is determined by the supplemental revision type, if available.
There are two situations in which the revision type changes:

• A primary revision type with a primary supplemental set (no secondary set)

• A secondary revision type with a secondary supplemental set

Teamcenter assumes that the supplemental revision type is preferable. Typically, major revisions are
made using the standard Revise function.

Manage the change relations in the Summary view

In addition to using the standard views to add related items to the change folders associated with the
change object as you (the Change Home, Teamcenter Component, and Search Results views), you
can use the Summary view in Change Manager to display and manage the change item relations for
change objects.

You must be an assigned participant and the properties of the object must be set.

1. In a Change Manager view, select a change object, and click the Summary tab.

The Summary view displays the Affected Items and Reference tabs, which show the various
folders related to the change object as shown for an engineering change request (ECR). The folders
displayed depend on the type of change object or schedule task selected. You can add and remove
items as well as create new documents for the Reference and Solutions folder.

Manage the change relations in the Summary view
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2. Click the Affected Items or Reference tabs, depending on the type of items you want to manage.

3. Use the Cut, Copy, and Paste tools, as appropriate, to add or remove items from the folders. Use
the Add New tool to create a new document for the Reference and Solutions folder.

Relate a solution item to an impacted item

In Change Manager, a solution to an impacted item is not always a revision of the impacted item. It can
be a separate item (for example, a markup). In addition, there can be more than one revision of the
same item in either or both the Impacted Items and Solution Items folders.

To create BOM change and supersedure records for a change, there must be an exact correspondence
between the solution and impacted item revisions. If the change has a single impacted item revision and
a single solution item revision of the same item, the BOM change relationship is created automatically. If
not, you must use the Relate Solution Item to Impacted Item command to set up the relationship.
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If the solution item is not related to an impacted item and you send the solution item to Structure
Manager, the Relate Solution Item to Impacted Item dialog box appears. You must create the relation
before the solution item is sent to Structure Manager.

Note:

Supersedure relationships are always created manually. You must copy the old item revision to the
Impacted Items folder and the new item revision to the Solution Items folder.

1. Double-click the ECN revision to open it in the Open Change view as shown.

2. Right-click the item revision in the Solutions Items folder and choose Relate Solution Item to
Impacted Item.

BOM changes

Create a BOM change

1. Double-click the ECN revision to open it in the Open Change view, as shown.

Create a BOM change
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2. Right-click the item revision of the original assembly in the Impacted Items folder of the ECN and
choose Revise Impacted Item(s).

A new revision of the assembly appears in the Solution Items folder.

3. Right-click the item revision in the Solution Items folder and choose Send To→Structure
Manager.

4. Make your changes in Structure Manager and click Save.

You see the split window showing BOM changes; you have write access to the assembly.

5. In Structure Manager, you can create the supersedure and view the genealogy.

Note:

• Supersedure relationships are always created manually. You must copy the old item
revision to the Impacted Items folder and the new item revision to the Solution Items
folder.

• Be sure the TC_ValidApprovedStatus preference is set to a valid status (for example, TCM
Released). You can then see a visual indication of a potentially superseded component
using the Edit→Show/Hide Superseded command in Structure Manager when the top
line of the assembly is highlighted.

6. After the BOM change is created, you can see it in Change Manager by selecting the change object
revision and clicking the BOM Changes pane.
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7. (Optional) Create a BOM line item form by selecting the BOM line in the BOM Changes pane and
clicking Add Form .

You can use the boxes in the form to document the purpose of the change or other change
information.

Note:

To delete the form, you must click Delete Form . Other deletion methods do not work.

8. (Optional) Cut the schedules associated with the original revision and paste them into the new
revision.

Any schedules associated with the original change item revision are not automatically associated
with the new revision (a schedule cannot have two parents). Therefore, you need to cut the
schedules in the Plan Items folder of the original change item revision and paste them in the Plan
Items folder of the new revision.

Create a BOM change
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View BOM changes

Click BOM Changes to view changes made to a BOM when the following is true:

• A top line revision of a structure is part of an ECN solution.

• Older revisions of the same item are part of Impacted Items for the same ECN.

• There is a SolutionToImpacted relation between both revisions.

The BOM Changes view displays the changes in different colors:

These changes are displayed as follows:

• Adding a new line to the structure displays it in blue.

• Removing a line from the structure displays it in red.

• Changing a line displays it in orange.

View BOM changes tracked with an ECN

The change tracking process for new content and revisions is automated, providing a consistent method
across applications to indicate the active change.

Edits are recorded in the specified active change, set by selecting Active Change in the user profile.
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You can define which properties to track by modifying the preference
CM_bomline_tracked_properties.

• Create or Save As adds a revision to the solution item of the change notice

• Revise adds the new revision to the solution item for the change notice, and the prior revision is
added as an impacted item.

These changes are displayed as follows:

• Adding a new line to the structure displays it in blue.

• Removing a line from the structure displays it in red.

• Changing a line displays it in orange.

• Moving a line in the structure displays it as green.

This example shows two additions, two removals, and two changes:

Updating changes

Update a change

After a change object is created, you can update its properties depending on your ownership and
participant privileges. For example, you might want to enhance the problem report (PR) description to
elaborate on the conditions under which a problem occurred. 

Update a change
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1. Select the problem report, engineering change request, deviation request, or engineering change
notice that you want to update.

You can update these objects only if you are the owner or have checkout and checkin privileges
granted by an access control list, access rules, or another method.

2. Click either the Summary or Viewer pane.

3. Click the Check out and edit button.

4. Edit the properties you want to update.

Note:

• You cannot edit the ID property.

• You cannot change the participants from the Summary or Viewer pane. Choose
Tools→Assign Participants instead.

• You cannot change the Maturity, Disposition, or Closure properties from the Summary
or Viewer pane.

To change these properties, see About setting change states.

• You cannot edit properties on change objects, or their relations, after they are closed.

5. To save your changes in the Summary pane, click either the Save properties and check in button
or the Save and keep checked out button.

To save your changes in the Viewer pane, click the Save button.

6. To discard your changes in the Summary pane, click the Cancel checkout and revert back to
original button.

To discard your changes in the Viewer pane, click the Clear button.

7. If you saved your changes, check them in if they are not already checked in.

To check in your changes in the Summary pane, click the Save properties and check in button.

To check in your changes in the Viewer pane, click the Check-In button.

Note:

You cannot use the Save As command for a change. Creating a change based on another change
violates change management business logic. Therefore, the Save As command is not available
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for a change object (it is disabled) to prevent you from breaking business rules or creating poor
change management data. Instead, create a new object and relate the change items to the
appropriate folders in the new object.

Change object properties

Change objects capture the necessary change information either as part of their properties or through
establishing relations with other objects as shown.

Participants

Participants are the users involved with identifying, managing, and resolving the change. Participants
can be assigned at the start of the change or they can be assigned throughout the change process,
depending on the requirements of your company. The participants can also be automatically assigned
to workflow tasks. Participants are modeled as separate objects and are not properties of the change
object. Participants can be a single user or a group, such as a board.

Here is an example of participants who are assigned.

Change object properties
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Change states

Change states define the degree of completion and the latest business decision regarding a specific
change. They are set during workflow, and used to control the change. The states, while set on an
individual change object, apply to the overall change process. For example, the Executing change state
references the change notice (ECN) when changes are being made using the solution items.

Here is an example of the change states. The bold text shows the defaults.

Related items, changes, and schedules

During the change process, you elaborate a change object by relating other objects to it. For example,
you may need to add reference documents to a PR or specify which item revisions are impacted by the
change. When you implement a change, new item revisions must be related as solution items. You can
also relate schedules to change requests (ECRs) for planning the solution or to change notices (ECNs) for
implementing the solution.

Change Manager shows these related items in change folders that it automatically creates for you. The
change folders, for example, Impacted Items, Solutions Items, and Plan Items, define the type of
relation the item has to the change object. Business rules (modeled as Business Modeler IDE conditions)
control the data that can be related under the different folders, by participant type, and what change
state.

Here is an example of the folders of the change objects and the types of change objects they are related
to:
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Note:

You cannot edit properties on change objects, or their relations, after they are closed.

Listing of change properties

Change object properties store change data during the change process. A user either enters the
data or Change Manager automatically creates it during the change process.  The values of some of
these properties are used to drive workflow decisions, while others are provided for user reference or
instruction.  Here, we see a subset of the change properties available on different types of change
objects. Some properties, such as the State, are common to all change objects.

The following lists the default properties for a change object. To view properties, use the Viewer tab.

Properties common to all change objects

The property Does the following

ID Provides the change object identification number.

Name Provides a name for the change object.

Synopsis Provides a name for the change.

Description Provides a description of the problem.

State The state of the change. Can only be changed through a workflow process.

• Closure

• Maturity

• Disposition

Participants Lists those involved in the change management process.

Note:

These are not properties, but relations to participant objects.

• Requestor

• Analyst

• Change Specialist 1

• Change Review Board (ECR only)

Listing of change properties
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The property Does the following

• Change Implementation Board (ECN only)

Properties of problem reports

The property Does the following Property name LOV name
and values

Environment
Description

Describes the environment as it was when the
problem occurred. For example, if the car door
was open and the car was moving in reverse.

CMEnvironment
Description

None

Sequence of
events

Describes what happened before the problem
occurred. Provides a guide for reproducing the
problem.

CMSequence
OfEvents

None

Technical
review priority

Guides the analyst to the problems to address
first. The values, based on CMII, are 1 to 4, with
1 being the highest priority.

Your administrator may have replaced this list of
values (LOV) with your company’s own.

CMTech
ReviewPriority

CM Tech Rev
Priority

• 1

• 2

• 3

• 4

Verification Describes how the problem was verified. For
example, it was reproduced.

CMVerification None

Ramification Describes what will or might happen if the
problem is not resolved. For example, increased
incidence of customer injury.

CMRamification None

Severity rating Indicates the severity of the problem. For
example, customer injury rates a 1 (high) while
a user manual typographical error rates a 4
(low).

The values, based on CMII, are 1 through 4,
with 1 being highest severity.

Your administrator can replace this list of values
(LOV) with your company’s own.

CMSeverity
Rating

CM Priority

• 1

• 2

• 3

• 4
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Properties of engineering change requests

The property Does the following Property name LOV name and
values

Reason Provides a short description of the
reason for the change. The values
are based on CMII.

Your administrator can replace
them with different types of
changes (for example, safety or
performance) that your company
processes on a regular basis.

CMReason CM CR Reason

• To Fix

• To Prevent

• To Improve

Proposed solution Describes the recommended
technical solution in enough
detail to enable a cost-benefit
decision. The analyst enters this
information.

For standard track changes, a
simple description in this text box
is not enough, so the analyst
may attach other documents
(for example, BOM markups, a
preliminary implementation plan
(schedule), or any other item
needed to describe the proposed
solution). In this case, those items
should be briefly described here.

This property is part of the
technical recommendation.

CMProposed
Solution

None

Is fast track? Indicates if the ECR should be
processed as a fast track change.

CMIsFastTrack CMII CR Fast Track

• Yes

• No

Technical review
priority

Guides the change review board
and the technical review board
(if involved) to the problems to
be addressed first. The priorities
can be copied from the PR, or
the change specialist can set the
value.

The LOV values are based on CMII.

CMTech
ReviewPriority

CM Priority

• 1

• 2

• 3

Listing of change properties

Change Management ─ Deployment and Rich Client Usage, Teamcenter 2412  13-21
© 2025 Siemens



The property Does the following Property name LOV name and
values

• 4

Recurring cost Provides an estimate of the
incremental costs of the changed
product.

CMRecurringCost None

Nonrecurring cost Provides an estimate of the total
costs to implement the change.

CMNonrecurring
Cost

None

Technical
recommendation

Forms part of the technical
recommendation, along with the
CMTestResults
Attached, CMTechnical
Review, and CMProposed
Solution properties.

The values are based on CMII.

CMTechnical
Recommendation

CM Tech
Recommendation

• Problem
Confirmed

• Problem Not
Confirmed

• Another Problem

Test results
attached?

Answers the question of whether
the analyst has attached
documentation of the test results.
This property is part of the
technical recommendation.

CMTest
ResultsAttached

CM YesNo

• Yes

• No

Technical
recommen-
dation date

Specifies the date of the
recommendation.

CMTech
RecommDate

None

Timing factors Provides an opinion or guidance
from the change review board
or analyst to the change
implementation board about
setting the effectivity and the
implementation timing.

CMTimingFactors None

Properties of engineering change notices

The property Does the following Property name LOV name and values

Implemen-
tation priority

Guides the analyst about the relative
priority of implementing the change.

CMImplPriority CM Priority

• 1
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The property Does the following Property name LOV name and values

• 2

• 3

• 4

Special
instruction

Captures any special instructions the
change Implementation board has
for the analyst and the change
implementation team itself.

CMSpecial
Instruction

None

Is customer
approval
required?

Indicates if one or more customers
must approve the change.

CMSpecial
Instruction

None

Status of
customer
approval

Indicates whether or not the
customers approved or disapproved
the change.

CMStatusOf
CustApproval

CM CN Approval

• Approved

• Disapproved

Date of customer
approval

Indicates the date of the customers’
approval or disapproval.

CMDateOf
CustApproval

None

Managing unincorporated changes

About incorporating changes

An unincorporated change is a change that is approved but not yet incorporated in the design of a
product. Usually, changes are not incorporated fully because there is not enough time, importance, or
budget to incorporate the changes completely through the development process.

The unincorporated change functionality is intended to track unincorporated changes to existing
designs. It does not support tracking unfinished work of new, unreleased designs.

Unincorporated changes can only be applied to ECNs.

Example:

A designer releases Revision A of Item1 for production, and begins working on a new revision
(Revision B). On the shop floor, a minor modification is performed over Revision A and production
starts. This changed version needs to be recorded in Teamcenter. Therefore, a new supplemental
revision (A01) is created and released. Because the change still needs to be incorporated into the
main release, (revision B, in this case), the change is considered partially incorporated.

About incorporating changes
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An ECN can also either partially or fully incorporate markups. However, a markup is considered fully
incorporated into all the solution items of the incorporating ECN, which has the change partially
incorporated into the same item.

Example:

A designer creates a ECN (CN1), with a markup (MU1) as a solution item. The designer sets the
Incorporation status of several of the impacted items to Partially Incorporated.

The designer then creates a second ECN (CN2) to incorporate markup MUI. The designer creates
an incorporates relation between CN2 and MU1.

CN1/MU1 are now considered fully incorporated into the solution items of CN2 that belong to the
impacted items of CN1 and have an Incorporation status of Partially Incorporated.

For a full example of incorporating changes, see Example of incorporating changes.

Example of incorporating changes

The following is an example showing the steps to incorporate changes partially and then fully when an
engineering change notice (ECN) impacts multiple change items.

Step 1 – Create engineering change notice implementing changes

Company ABC creates an ECN (Change Notice Main) to implement a change needed on two items
(Item 1 and Item 2). The item revision of the items in the Solutions folder is Revision b.

The ECN change state is Open, Executing, and Approved.

The following shows the status for the items as it would appear in the Change History dashboard.
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Note:

ECN CN0 in the Change History dashboard is not shown in the figures to avoid complexity. CN0 is
the ECN that initially created Item 1, Revision a, and Item 2, Revision a as solution items.

Step 2 – Make the partially incorporated changes

On the shop floor, a minor modification is done over Revision a of the two items (Item 1 and Item 2) and
production is started. Company ABC needs to immediately incorporate the change into Teamcenter. The
items have work-in-process revisions so the change cannot be incorporated into these.

Therefore, a designer creates new revisions to incorporate the shop-floor changes and starts a
new change notice (Change Notice Partial) to manage the implementation. The designer sets the
incorporation status on the items in the Impacted Items folder of Change Notice Partial to Partially
Incorporated.

The designer closes Change Notice Partial after creating Revision a01 of Item 1 and Item 2.

Work still continues on Revision b in Change Notice Main, and it remains open.

Example of incorporating changes
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The change states of the ECNs are:

• Change Notice Main – Open, Executing, and Approved

• Change Notice Partial – Closed, Complete, and Approved

Step 3 – Incorporate changes from Item 1, Revision a01, into Revision b in Change Notice
Main

The designer finishes the work in Change Notice Main on Revision b of the items. The designer wants
to incorporate the change to Item 1 in Change Notice Partial into Revision b of Change Notice Main,
but not the change that was done to Item2. To indicate this, the designer creates an Incorporates this
relation between Change Notice Main and Revision a01.
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The change states of the ECNs are both Closed, Complete, and Approved.

Step 4 – Incorporate changes from Item 2, Revision a01, into Revision b in Change Notice
Additional

Much later, more changes are recommended for Item 1 and Item 2. Therefore, Company ABC creates
a third change notice (Change Notice Additional). During that change, the designer implements the
changes that were in Change Notice Partial for Item 2 into Revision c.

At this point, all change notices are closed.

Example of incorporating changes
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The change states of the ECNs are all Closed, Complete, and Approved.

Conditions that must be met to set Incorporation status

The following conditions must be met before you can set the Incorporation status of an item revision.
By default, all impacted items in the Impacted Items folder of an ECN are set to Unincorporated.
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In addition, when an ECN is closed through a workflow, all impacted items with a status of
Unincorporated are automatically set to Incorporated.

Conditions required for a change to be partially incorporated

A change authorized by an ECN revision is considered partially incorporated in an item revision if the
following are met:

• The item revision is a solution item of the ECN (in its Solution Items folder). If it is, then it meets the
Business Modeler IDE condition CMHasSolutionItem.

Note:

The CMHasSolutionItem condition is not supported by change revisions (ECR).

• The ECN has an impacted item in its Impacted Items folder and its Incorporation status is set to
Partially Incorporated.

The CMHasImpactedItem relation object has the ECN revision as its primary object and
an item revision of the same item as its secondary object In addition, the value of the
property Cm0IncorporationStatus on the CMHasImpactedItem relation object is set to Partially
Incorporated.

Conditions required for fully incorporating a change

A change previously partially incorporated into an item revision, (for example, Revision a01) is
considered fully incorporated into another item revision (for example, Revision b) of the same item
if all the following are met:

• The ECN authorizing the item revision (in this example, Revision b) is a primary object of a
Cm0Incorporates relation object and the previous revision (for example, Revision a01) is the
secondary object.

• The ECN has an impacted item in its Impacted Items folder and its incorporation status is set to
Incorporated.

The CMHasImpactedItem relation object has the ECN as the primary object and an item revision of
the same item as its secondary object. In addition, the value of the property Cm0IncorporationStatus
on the CMHasImpactedItem relation object is set to Incorporated.

• The ECN revision authorizing the item revision (in this case, Revision b) is closed.

Conditions that must be met to set Incorporation status
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Conditions required for incorporating markups

An ECN incorporates a markup partially or fully in the same way it does item revisions, as explained in
the two earlier sections. However, a markup is considered fully incorporated into all the solution items of
the incorporating ECN that has the change partially incorporated into the same item.

Example:

A markup (MU1) is a solution item of an ECN (CN1) and the incorporation status of a few of the
impacted items of CN1 is set to Partially Incorporated.

A designer later creates an Incorporates relation between a new ECN (CN2) and the markup MU1.

Now CN1 and MU1 are considered fully incorporated into the solution items of CN2, which belong
to the impacted items of CN1 with the Incorporation status set to Partially Incorporated.

Set the Incorporation status of an object

Before you can set the Incorporation status of an item revision:

• The item revision must be related to an engineering change notice (ECN) as an item that it impacts.

• Conditions must be met to set the Incorporation status of item revision.

Note:

By default, the Incorporates relation is not displayed as a folder under the ECN revision.

For information about displaying a folder with this relation under the ECN, see Configure a folder
to display Incorporation status.

1. In My Teamcenter or Change Manager, right-click the item revision and choose Properties on
Relation.

2. In the Properties dialog box, scroll to Incorporation Status and set it to one of the following:
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• Unincorporated

The change has not been incorporated.

• Partially Incorporated

The change as defined has been partially incorporated. It may or may not already be fully
incorporated by a subsequent change.

• Incorporated

The change as defined has been fully incorporated. No subsequent changes are required to fully
incorporate the defined change.

• Cancelled

The change as defined is not incorporated in any way. This value indicates that an item has been
identified as an impacted item, but the change as defined is not applied to that item. This status
can be applied before a change solution definition or change execution has begun, or it can be
updated after the change execution has begun.

3. Click OK.

General process for incorporating change items in an ECN

The following shows the general process for incorporating change items in an engineering change
notice (ECN). It is followed by a summary of the steps.

General process for incorporating change items in an ECN
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Note:

The examples use primary revisions. We recommend that you use secondary revisions when
partially incorporating change items. For example, use A01 or A02 and not A, B, and C.

1. Create the ECN to completely incorporate the item revision.

a. Create the ECN.

b. Add the item revision to be incorporated to its Impacted Items folder.
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c. Assign participants and start a workflow.

2. Create the new item revision.

a. Use the Revise Impacted Items(s) command to create a new revision of the item revision and
add it to the Solutions Items folder.

The following properties must be met:

Assigned
participant

Closure/Disposition/Maturity
property settings

Analyst Open/Approved/Executing

3. Create the second ECN that is to incorporate the item revision partially (the partially incorporated
ECN).

a. Create the partially incorporated ECN.

General process for incorporating change items in an ECN

Change Management ─ Deployment and Rich Client Usage, Teamcenter 2412  13-33
© 2025 Siemens



b. Assign participants and start a workflow.

4. Set the Incorporation status and make the change.

a. Use the Properties on Relation command to set the Incorporation status of the item revision
to Partially incorporated

b. Use the Revise Impacted Items(s) command to create a new revision of the item revision and
add it to the Solutions Items folder.

The following properties must be met:

Assigned
participant

Closure/Disposition/Maturity
property settings

Analyst Open/Approved/Executing
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c. Make the change.

5. Add solution item to incorporation ECN.

a. Add the item revision from the Solutions Items folder of the second ECN to the Incorporates
folder of the first ECN that will incorporate all changes.

The following properties must be set to add the item revision to the Incorporates folder:

Assigned
participant

Closure/Disposition/Maturity
property settings

Analyst Open/Approved/Elaborating

6. Close the incorporation ECN.

a. Close the first ECN that incorporates the solution item. Closing the ECN automatically sets the
Incorporated status of the solution item to Incorporated as shown in the Change History
dashboard.

General process for incorporating change items in an ECN
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The following preferences control defaults in change item revisions:

ChangeItemRevision_Cpd0SubsetDefaults_default_relation
Description When creating a change object in the context of a subset, specifies the

relation the subset has to the created change item revision. The default is
that the subset is a reference item.

Default CMReferences
Default Protection
Scope

User

ChangeItemRevision_Cpd0DesignElement_default_relation
Description When creating a change object in the context of a design element, specifies

the relation the design element has to the created change item revision. The
default is that the design element is an impacted item.

Default CMHasImpactedItem
Default Protection
Scope

User

ChangeItemRevision_Cpd0WorksetRevision_default_relation
Description When creating a change object in the context of a workset, specifies the

relation the workset has to the created change item revision. The default is
that the workset is a reference item.

Default CMReferences
Default Protection
Scope

User

ChangeItemRevision_DefaultChildProperties
Description Specifies the list of properties that can be displayed as children of

a ChangeItemRevision node.
Default IMAN_master_form_rev

IMAN_specification

IMAN_requirement

IMAN_manifestation

IMAN_reference

release_status_list

TC_Attaches
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CMImplements

CMImplementedBy

CMHasImpactedItem

CMHasProblemItem

CMReferences

CMHasSolutionItem

CMHasWorkBreakdown
Default Protection
Scope

Site

ChangeItemRevision_ItemRevision_default_relation
Description When creating a change object in the context of an item revision, specifies

the relation the item revision has to the created change item revision. The
default is that the item revision is a problem item, as shown in the figure for a
change request.

Default CMHasProblemItem
Default Protection
Scope

User

ChangeItemRevision_Ptn0Partition_default_relatio
Description When creating a change object in the context of a partition, specifies the

relation the partition has to the created change item revision. The default is
that the partition is an impacted item, as shown in the figure for a change
request.

Default CMHasImpactedItem
Default Protection
Scope

User

General process for incorporating markups in an ECN

The following provides the general process for incorporating change items in an engineering change
notice (ECN) when the solution item is a markup of the impacted item (they are different items; not
revisions of each other).

Note:

The examples use primary revisions. We recommend that you use secondary revisions when
partially incorporating change items. For example, use A01 or A02 and not A, B, and C.

1. Create the ECN to completely incorporate the change.

General process for incorporating markups in an ECN
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a. Create the ECN.

b. Add the item revision to be incorporated to its Impacted Items folder.

c. Assign participants and start a workflow.

d. Use the Revise Impacted Items(s) command to create a new revision of the item revision and
add it to the Solutions Items folder.

The following properties must be met:

Assigned
participant

Closure/Disposition/Maturity
property settings

Analyst Open/Approved/Executing
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2. Create a second ECN that is to incorporate the item revision partially and make the partial change.
The following shows the completed ECN with different impacted and solution items.

a. Create the second ECN.

b. Add the item revision to be partially incorporated to its Impacted Items and Solutions Items
folders. In this case, they are different items that are unrelated.

General process for incorporating markups in an ECN
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c. Assign participants and start a workflow.

d. Use the Properties on Relation command to set the Incorporation status of the item revision
in the Impacted Items folder to Partially incorporated

For more information about setting the Incorporation status of a change item, see Set the
Incorporation status of an object.

e. Use the Relate Solution Item to Impacted Item command to relate the solution item to
the impacted item, which creates a link between them, as shown in the Change History
dashboard.

For more information about the Change History dashboard, see View Incorporation status
and history.

f. Make the change and close the ECN.

3. Add the item revision from the Solutions Items folder of the second ECN to the Incorporates
folder of the first ECN that will incorporate all changes.

The following properties must be set to add the item revision to the Incorporates folder:

Assigned
participant

Closure/Disposition/Maturity
property settings

Analyst Open/Approved/Elaborating
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4. Close the first ECN that incorporates the solution item. Closing the ECN automatically sets the
Incorporated status of the solution item to Incorporated as shown in the Change History
dashboard.

For more information about the Change History dashboard, see View Incorporation status and
history.

Configure a folder to display Incorporation status

By default, the Incorporation status Incorporates is not displayed as a folder under an engineering
change notice (ECN) revision.

Configure a folder to display Incorporation status
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Use the Options dialog box to specify that the Incorporates property should be displayed for an ECN.

1. Choose Edit→Options.

2. In the list on the left, select General and then select Item Revision.

3. Click the Related Object tab.

4. Set Select Item revision type to Change Notice Revision.

5. In the Available Relations list, double-click Incorporates.

Incorporates moves to the Shown Relations list.

6. Now click the General tab, and set up that the same relations be shown following Steps 4 and 5.

7. Click OK.

Viewing Incorporation status and history

View Incorporation status and history

You can view the incorporation status of an engineering change notice (ECN) or an item revision using
the Change History dashboard of the Summary tab.
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Note:

The Change History dashboard must be configured.

1. In My Teamcenter or Change Manager, select an item or ECN.

2. Click the Summary tab.

3. Click the Change History tab.

The following shows the Change History dashboard when an item revision is selected.

Each row in the dashboard represents one revision of the item or the ECN authorizing the revision
(no two rows represent the same revision). The columns in the dashboard change depending on
whether you selected to view the incorporation history of an item revision or ECN:

• Columns in the Change History dashboard for an item

• Columns in the Change History dashboard for an ECN

Understanding the columns in the Change History dashboard for an ECN

When you select to view the Incorporation status of an engineering change notice (ECN) in the Change
History tab of the Summary tab, the Change History dashboard appears with the following columns.

Understanding the columns in the Change History dashboard for an ECN
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The column Displays

Solution Item The name of the solution item of the ECN.

Impacted Item The name of the Impacted Item in the ECN.

Incorporates Changes
of

The names of the item revisions or markups that the ECN is incorporating.

Incorporated by The name of the ECN revision that is incorporating the object listed in
Solution Item column.

Incorporated into The Incorporation property of the ECN revision.

Incorporation Status The Incorporation status of the impacted item, except if the Incorporation
status is set to Partially Incorporated. Then, this indicates that another
ECN has incorporated the change fully.

Understanding the columns in the Change History dashboard for an item

When you select to view the Incorporation status of an item in the Change History tab of the Summary
tab, the Change History dashboard appears with the following columns.

The column Displays

Revision/Solution Item The ID and name of the solution item.

Impacted Item The ID and name of the impacted item.

Markup The name and ID of any markup.

Authorizing Change
Notice

The name of the ECN revision.

Closure The Closure of the ECN.

Maturity The Maturity of the ECN revision.

Disposition The Disposition of the ECN revision.
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The column Displays

Incorporates Changes of IDs of the item revision or the name of the markup being incorporated
by the ECN revision.

Incorporated by The name of the incorporating ECN revision.

Incorporated into The ID of the revision the change was incorporated into.

Incorporation Status of
Change

Shows the Incorporation status set on the impacted item, except if the
Incorporation status is set to Partially Incorporated. Then, this indicates
that another ECN has incorporated the change fully.

Configure the Change History dashboard

1. Associate the Change History tab with more workspace objects.

Change Manager associates the Change History tab with all standard workspace objects involved
in a change management process, such as item revisions and change objects. If you want to display
the Change History dashboard for other workspace objects, such as document revisions, you can
modify the style sheet for the Summary view of the object by adding the following code.

    <page titleKey="tc_xrt_ChangeHistory" title="Change

History" visibleWhen="{pref:CM_Change_History_Enable}==true">

        <section titleKey="tc_xrt_ChangeHistory"

title="Change History" initialstate="expanded">

            <customPanel

java="com.teamcenter.rac.cm.views.ItemChangeHistoryPanel"

js="displayItemCustomPanel"  />

        </section>

    </page>

If you have modified the style sheet of a subtype of Item/ItemRevision, the Change History would
not appear in its Summary view, and you need to add the code shown.

2. Turn on and off the display of Change History dashboard.

Use the CM_Change_History_Enable preference to turn on or off the display of the Change
History dashboard.

Configure the Change History dashboard
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3. Change the columns in the dashboard and their order.

• CM_Item_ChangeHistory_Columns

Changes the columns displayed for an item revision.

• CM_CNR_ChangeHistory_Columns

Changes the columns displayed for an engineering change notice.

Performing mass-updates of objects

About the mass-updating of objects

Using Change Manager or My Teamcenter, you can make updates, in bulk, to part instances or to
the source objects of realized design elements in 4th Generation Design (4GD). For example, you can
identify and automatically replace every occurrence of an impacted part with its solution item. Using
Change Manager allows you to control the process through change management in two phases. Both
methods provide you with a wizard to step you through the process.

Configuring the mass-updating of parts and realizations

(Recommended) Suppressing the mass update commands

By default, the Mass Update and the Mass Update Realization commands are available to all users.
Siemens Digital Industries Software highly recommends that you suppress access to these commands
using the Command Suppression application. It controls the suppression of menu options based on a
user’s group or role.

Setting up where-used search for the mass-updating of parts

For users to be able to see the assemblies that are impacted by the mass-updating of parts using
the Mass Update command, you must set the MassUpdateDefaultRevRule preference to define the
revision rule that is used to perform a where-used search on the target part of a mass update. By default,
the rule is Latest Working.

Configuring the mass-updating of objects using change management

An administrator must configure the following for users to be able to perform mass updates during a
change management process using Change Manager:

• Install Change Manager
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Mass updates use the CM_Massupdate_Support_Change preference to activate change object
support. The preference is automatically installed when Change Manager is installed. By default, it
is set to true, indicating that Change Manager is installed. 

If the preference does not exist (that is, Change Manager is not installed) or it is set to false, mass
updates do not work with a change object, but they do work outside of Change Manager using the
single-phase process in My Teamcenter.

• Install 4GD template to perform mass updating of realizations

To use a change object to manage the mass-updating of the source objects of design elements
(realizations), install the 4th Generation Design Integration for Change management template.

• Configure Change Manager to allow access to change objects and their folders

Mass-updating relies on the Business Modeler IDE conditions and rules being used in Change Manager
to determine what change objects and folders it can access. Therefore, the change states of the
change object (Closure, Maturity, and Disposition) must be set so mass update can access the
folders associated with the object and change the item revisions.

Mass update evaluates the following Change Manager conditions:

• Cm0isCMHasImpactedItemCreatableForPrimary

• Cm0isCMHasSolutionItemCreatable

• Cm0isCMHasProblemItemCreatable

• Cm0isCMHasImpactedItemCreatable

• isChangeExecutionAllowed

In addition, users performing a mass update must be in the correct group and be participants of the
change management process. Otherwise, the conditions prevent the users from adding objects to
the Problem, Impacted Items, and Solution folders.

When mass-updating parts, you could easily collect so many assemblies that no single user in your
organization has permission to update them all. To resolve such issues, the Mass Update wizard allows
you to rerun updates and attempt any updates that failed the first time. You could also use workflow
access controls to grant permission to the user at the appropriate step.

The following shows the default conditions set for all change objects: problem report (PR),
engineering change request (ECR), engineering change notice (ECN).

• To add item revisions to the Problem Items or Referenced Items folders:

■ Must be Analyst or Requestor

Configuring the mass-updating of objects using change management
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■ AND

Disposition: None Maturity: Elaborating (Default) (until the Reviewing stage)

■ OR

Analyst

■ AND

Disposition: Investigate Maturity: Reviewing (once in Review, but only if Investigate (that is,
rework)

• To add item revisions to the Impacted Items folder:

■ Must be Analyst

■ AND

Disposition: None Maturity: Elaborating (Default) (Before Review, first time round)

■ OR

Disposition: Investigate Maturity: Reviewing (Default) (after review rework required – second
time round)

• To add item revisions to the Solution Items folder:

■ Must be Analyst

■ AND

Disposition: Approved Maturity: Executing (Only when running an approved change)

■ OR

Disposition: Investigate Maturity: Reviewing (Default) (after review rework required – second
time round)

• Specify objects that can be added to folders

Use the following preferences to define the Generic Relationship Management (GRM) rules to use
when adding item revisions to the Problem, Impacted Item, and Solution folders. GRM rules limit
what objects can be pasted to other objects.

• CM_Massupdate_Problem_PseudoFolder
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Specifies the GRM rule to use when adding problem parts to a change object.

• CM_Massupdate_Impacted_PseudoFolder

Specifies the GRM rule to use when adding impacted parts to a change object.

• CM_Massupdate_Solution_PseudoFolder

Specifies the GRM rule to use when adding solution parts to a change object.

• Set the types of change objects

Use the following preferences to specify the types of change objects with which the mass updates can
be performed:

• CM_massupdate_allowed_ECN_types

Change Manager change object revision types that are used for ECN operations. By default, it is set
to ChangeNoticeRevision.

• CM_massupdate_allowed_ECR_types

Change Manager change object revision types that are used for ECR operations. By default, it is set
to ChangeRequestRevision.

Performing mass-updates of part instances

About the mass-updating of part instances

You can make bulk updates to multiple assemblies as part of a change management process or in a
single phase using the Mass Update wizard. For example, you can identify and automatically replace
every occurrence of an impacted part with its solution item.

The Mass Update wizard automates the check-out/check-in process and the creation of the necessary
revisions of assemblies. It also tracks the assemblies that you cannot edit (for example, because they
belong to another group). You view the results of the mass update as a report.

About the mass-updating of part instances
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You can replace parts in nine different ways, including replacing, removing, adding, and manually
updating (revising parts that are released). You can also add, modify, and remove updates associated
with the change object during the ECR and ECN processes before they are executed.

The updates are stored in the folders of the associated change object or in the Newstuff folder if you
perform the update without a change object. For example, new assembly revisions are automatically
added to the Solution Items folder.

Note:

• By default, the Mass Update command is available to all users. Siemens PLM highly
recommends that you suppress access to this command using the Command Suppression
application. It controls the suppression of the Mass Update menu option based on a user’s
group or role.

• Mass updates are only performed on data in a local database. The updates do not span globally
to other site databases.

• Mass updates are only structural replacements. If you have additional data, such as torque
information, you need to update it manually.

• You must have the necessary permissions to perform a mass update and Change Manager
must be configured for mass updates.

Note:

The Teamcenter change management process does not support displaying substitutes on separate
BOM lines in Structure Manager. Turn off the substitutes display (set PSEShowSubstitutesPref to
0) when working with change-management related features.

Types of mass updates you can perform for parts

Nine operations are available from the Mass Update wizard for replacing part instances as listed in
the examples. The operations allow you to replace parts, make substitutes, or manually update the
assembly.

Note:

The examples show the assemblies released in the end state. However, the state of the assemblies
depends on the workflows of the engineering change notice (ECN) at the time the replacement
occurs.

• Replace Part

Replaces the target part in a structure if the target part has no substitutes or if it is the preferred
substitute.
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• If the target part is an alternate substitute, it is not replaced.

• If the target part is a preferred substitute, all the alternate substitutes are retained with the
replacement part.

Example:

If the assembly is And the
target is

And the
replacement is

Then the result of the
replacement is

• Replace Part and Keep as Substitute

Replaces the target part in a structure if the target part has no substitutes or it is a preferred
substitute. If the target part is an alternate substitute, it is not replaced. The target part is added as an
alternate substitute after the target part has been replaced.

Example:

If the assembly is And the
target is

And the
replacement is

Then the result of the
replacement of the part as
a substitute is

• Replace Substitute

Replaces the target part in a structure if the target part is an alternate substitute. If the target part has
no substitutes or the target part is a preferred substitute, it is not replaced.

Types of mass updates you can perform for parts
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Example:

If the assembly is And the
target is

And the
replacement is

Then the result of
the replacement of the
substitute is

• Add Part

Adds a part to a structure that contains the target part, regardless of whether or not the target part
has substitutes or whether the target part is the preferred or alternate substitute. The part is added to
the structure and you must reposition the component within the structure.

Example:

If the assembly is And the
target is

And the
replacement is

Then the result of the
addition is

• Add Part as Substitute

Adds a part to a structure as an alternate substitute to the target part, regardless of whether or not
the target part has substitutes or if the target part is the preferred or alternate substitute. The part is
added as an alternate substitute to the target part and you must reposition the component within the
structure.
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Example:

If the assembly is And the
target is

And the
replacement is

Then the result of the
addition is

• Remove Part and Substitute

Removes the target part in a structure if the target part has no substitutes or it is a preferred
substitute.

• If the target part is an alternate substitute, it is not removed.

• If the target part is a preferred substitute, all the alternate substitutes are removed with the target
part.

Example:

If the assembly is And the
target is

And the
replacement is

Then the result of the
removal is

None

• Remove Part and Keep Substitute

Removes the target part in a structure if the target part has no substitutes or it is a preferred
substitute.

• If the target part is an alternate substitute, it is not removed.

• If the target part is a preferred substitute, the first alternate substitute becomes the preferred
substitute.

Types of mass updates you can perform for parts
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Example:

If the assembly is And the
target is

And the
replacement is

Then the result of the
removal is

None

• Remove Substitute

Removes the target part in a structure if the target part is an alternate substitute. If the target part is
not a substitute or is the preferred substitute, it is not removed.

Example:

If the assembly is And the
target is

And the
replacement is

Then the result of the
removal is

None

• Manual Update

Revises structures that contain the target part and does not make any structural changes. It does this
regardless of whether or not the target part has substitutes or whether the target part is a preferred or
alternate substitute. You must manually make the changes to the revised structures.
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Example:

If the assembly is And the
target is

And the
replacement is

Then the result of the
removal is

None

Good part update practices

• By default, the Mass Update command is available to all users. It is highly recommended that
you suppress access to this command using the Command Suppression application. It controls the
suppression of the Mass Update menu option based on a user’s group or role.

• Be sure to select Propagate relations when deriving the engineering change notice (ECN) from the
engineering change request (ECR) to include the mass updates in the Problem Items and Impacted
Items folders of the ECR.

• If you want to make a series of updates within the same change management process, select
Manage Update to display the Manage Updates dialog box and add or remove updates.

• If no single user in your organization has permission to update all the assemblies in one mass update,
rerun the mass update and attempt any updates that failed the first time. You could also use workflow
access controls to grant permission to the user at the appropriate step in the mass update.

• When performing updates under a change management process, you can automatically submit all the
updates to workflow as a single package.

Performing mass-updates of part instances under change management

About the mass-updating of parts using change management

Updating parts using change management are performed in two phases:

Good part update practices
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Note:

You can perform mass-updates on parts using either an ECR or an ECN. Mass-updates using an
ECN are not dependent on creating an ECR first.

• Authorization of the mass update during an engineering change request (ECR).

• Running the updates during an engineering change notice (ECN).

Authorize part updates during an ECR

During an engineering change request (ECR) change process, you can authorize the updates to be
made to an assembly. Authorizing the updates is the first phase in the two-phase change management
process. The second phase is running the updates, which can be done in the engineering change notice
(ECN) that is derived from the ECR.

After the authorization of the update in the ECR, an authorization report appears. The authorization
report is attached to the change object, along with all the operational data that tells what mass update
changes are to be performed during the ECN.

Before the update is run, you can validate and fix any synchronization issues with the update. You
can also add or remove updates.

Note:

You must have write access to add items to the Problem Items and Impacted Items folders of
the change object.

1. If necessary, create an ECR to track the updates and submit it to workflow.

2. In My Teamcenter or Change Manager, select the part on which to base the change (an item
revision) or the ECR.

3. Choose Edit→Mass Update .

The Mass Update wizard appears.
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4. From the Operation list, select the type of operation you want performed during the mass
update.

5. In the appropriate boxes of the Mass Update wizard, search for the parts and change objects to
be included in the authorization. If you selected a change object or a target part when you started
the mass update, the object or part is already entered. If you selected to remove a part or perform a
manual update, you do not select a replacement or additional part.

• Target

The part on which to base the change. The target part is used to identify the assemblies that are
impacted by the mass update.

• Change object

The change object in which to store the parts, the requested updates, and the results of the mass
updates.

Authorize part updates during an ECR
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Note:

The change object that you select must be in an ECR workflow and have no updates
associated with it. If the change object you select contains an update, select a different
change object or select Manage Update to manage the updates associated with the
change object.

• Replacement/Add

The part to be replaced or added to the target part, depending on the operation selected for
the mass update. Defining a replacement part is not required if you are removing a part or
performing a manual update.

Note:

The boxes that appear depend on the operation selected.

A thumbnail of the parts appear in the Mass Update wizard.

6. Choose the following options beneath the parts:

• Click Add to Problem folder to store the target part in the change object’s Problem folder.

• Click Add to Solution folder to store the replacement part in the change object’s Solution
folder.

Note:

The labels of these options is Add to Newstuff folder until you select a change object.

7. Click Next.

8. On the Select the impacted Parts to update page, in the Select column, select the impacted
assemblies you want to update. You can only select assemblies to which you have write permission.
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Tip:

• If you cannot edit an assembly, an X appears in the Updatable column.

There are many reasons why you cannot edit an assembly, including not having write
access to it, the assembly does not belong to you, or the mass update operation does
not perform that type of replacement or substitution (for example, the part already has
an alternate substitute or it is the preferred substitute). Review the operations for any
limitations on substitutes.

• To help make the selection process easier, enter a keyword in the Where Target is used
box to filter the table and reduce the amount of information being displayed.

• To remove all table keyword filters in the Where Target is used box, click Erase.

• To select all assemblies, click Select All and to clear the selection, click Deselect All.

9. Click Next.

The Review the Mass Update and Execute, Save or Cancel page appears.

Authorize part updates during an ECR
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10. Confirm the selection and select Save As Update.

The results of the update appears.

11. Review the results of the mass update, and select Close.

Note:

You can also select Manage Update to display the Manage Updates dialog box and add or
remove updates. This is particularly helpful if you want to make a series of updates within
the same change management process.
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The Mass Update wizard updates the Problem and Impacted folders of the change object. It also adds
the results of the update to the ECR.

Search for parts or change objects while updating parts

1. In the Mass Update wizard, in the Target, Add/Replacement or Change object box, enter the
search criteria for the part or change object and click the Search tool , as shown in the figure.
The figure shows the Mass Update wizard when adding a part.

Note:

Entering a change object is optional when performing a mass update in a single step using
My Teamcenter.

Search for parts or change objects while updating parts
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2. In the Search dialog box that appears, enter additional search criteria and click Search.

Tip:

To clear the search criteria, click Clear.

3. From the table, select the part or change object.

Tip:

The table displays a maximum of 10 items. Use the buttons along the bottom to navigate
through the table. You can also click a number to go to that page.

4. Click OK.

Manage part updates during an ECR

You can manage the updates to an engineering change request (ECR) while they are still under the
control of the ECR process (they have been authorized but not run). For example, you can add additional
updates or remove an update.
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1. In My Teamcenter or Change Manager, select either a part or the ECR with the authorized update.

2. Choose Edit→Mass Update .

The updates that have already been added appear.

3. Do one of the following:

• To remove an update, select the update and to the right of the table, click X.

• To add updates, click Add As Update to display the Mass Update wizard. You can also authorize
another update.

Note:

You cannot change the change object selection. The change object is locked because the
update is associated with that change object.

Run part updates during an ECN

After the engineering change request (ECR) authorizing a mass update is approved, start an engineering
change notice (ECN) to run the mass update.

The process updates the Solution Items folder of the ECN.

Note:

You must have write access to add items to the Solution Items folder of the ECN.

Run part updates during an ECN
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1. Derive an ECN from an ECR that contains an authorized mass update and submit it workflow.

Note:

Be sure to select Propagate relations when deriving the ECN from the ECR to include the
mass updates in the Problem Items and Impacted Items folders of the ECR.

2. In My Teamcenter or Change Manager, select either a part (item revision) or the ECN with the
authorized update.

3. Choose Edit→Mass Update .

The Manage Update dialog box appears showing the updates to be run.

4. Click Execute.

A Mass Update Execution report appears with the results of the mass update.

5. Review the report, and if necessary, fix any problems and run the parts replacement again.

The mass update creates a new revision for all the released assemblies, checks out all the assemblies to
which you have write access, and adds the results in the Mass Update Execution report to the ECN.
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Rerun part updates during an ECN

During an open engineering change notice (ECN), you can run a mass update again to replace parts if
there were failures during the original run that you have corrected.

Note:

Rerunning a mass update only performs updates on changes that did not run or failed. Successful
updates are not run again.

1. In My Teamcenter or Change Manager, select an ECN with an authorized update.

2. Choose Edit→Mass Update .

The remaining updates to run appear.

3. Click Execute.

A Mass Update Execution report appears with the results of the mass update.

Rerun part updates during an ECN
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4. Review the report.

The mass update creates a new revision for all the released assemblies, checks out all the assemblies to
which you have write access, and adds the results in the Mass Update Execution report to the ECN.

Performing mass-update of part instances in a single phase

Mass-update part instances in a single phase

Using My Teamcenter, you can replace parts in an assembly in one phase. After the update, an
authorization report appears, explaining the results of the update. You can optionally select a change
object in which to store the updates. If you do not select a change object, the updates are stored in your
Newstuff folder.

Note:

You must have write access to the assemblies to be updated.

1. In My Teamcenter, select the part on which to base the update.

2. Choose Edit→Mass Update .

The Mass Update wizard appears.
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3. From the Operation Type list, select the type of operation you want performed during the mass
update.

4. In the appropriate boxes of the Mass Update wizard, search for the parts to be included in the
mass update.

• Target

The part on which to base the change. The target part is used to identify the assemblies that are
impacted by the mass update.

• Replacement/Add

The part to be replaced or added to the target part, depending on the operation selected for
the mass update. Defining a replacement part is not required if you are removing a part or
performing a manual update.

• Change object

The change object in which to store the parts, the requested updates, and the results of the mass
updates.

Mass-update part instances in a single phase
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Note:

• The boxes that appear depend on the operation you selected.

• Selecting a change object is optional when performing a single-step process. If you do
not select a change object, the updates are stored in your Newstuff folder.

Thumbnails of the parts appear in the Mass Update wizard.

5. Beneath each part, click Add to Newstuff folder to store the results of the update in the Newstuff
folder.

Note:

Select the Add to Newstuff folder to ensure you have an update history. You can use Audit
Manager to view who performed the operation.

6. Click Next.

7. In the Select column of the Select the impacted Parts to update dialog box, select the impacted
assemblies you want to update. You can only select assemblies to which you have write permission.

Tip:

• If you cannot edit an assembly, an X appears in the Updatable column.
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There are many reasons why you cannot edit an assembly, including not having write
access to it, the assembly does not belong to you, or the mass update operation does not
perform that type of replacement or substitution (for example, the part already has an
alternate substitute or it is the preferred substitute).

Review the operations for any limitations on substitutes.

• To help make the selection process easier, type a keyword in the Where Target is used text
box to filter the table and reduce the amount of information being displayed.

• To remove all table keyword filters in the Where Target is used text box, click Erase.

• To select all assemblies, click Select All and, to clear the selection of all assemblies, click
Deselect All.

8. Click Next.

The Review the Mass Update and Execute, Save or Cancel page appears.

9. Confirm the selection and select Execute.

The results of the update appears.

Mass-update part instances in a single phase
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10. Review the results of mass update, and select Close.

Folders that store the part mass updates

You can optionally store the results of a mass update that you perform in a single phase in the Newstuff
folder, as shown in the figure. The results appear under the subfolder Mass Update Results with the
actual update stored under a folder with the date of the update. Under the date folder are folders
containing the results, which are the same types of folders used to manage a change. A report of the
results is also stored in the folder.

• Problem Item

The target item (the item revision that was added or replaced).

• Impacted Items

The assemblies that were impacted by the update.
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• Solution Items

The additional or replacement part (the item revision that was added or that replaced the target).

Performing mass-updates of source objects in 4GD design elements

About mass-updating source objects in 4GD design components

You can update, in bulk, the source objects of multiple reuse design components using the Mass
Update Realization wizard. For example, you can identify and automatically replace the source object
of every realization of an impacted part with its solution item everywhere it occurs. You can refine the
update to include only specific product designs or partitions. For example, you could update, in bulk, all
the realizations of a piston in two of the functional partitions of the product design CD000001.

You can make the change in two ways:

• In Change Manager, using change objects to track and manage the updates in a two-phase process.

About mass-updating source objects in 4GD design components
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• In My Teamcenter, using a single-phase update process without a change object.

The mass update realization process automates the creation of the necessary revisions. It also tracks the
item revisions that you cannot edit (for example, because they belong to another group). You view the
results of the mass update on the screen as well as in a realization update report.

Additionally, the updates are stored in the folders of the associated change object or in the Newstuff
folder if you perform the update without a change object. For example, new replacement item revisions
and updated impacted object revisions are automatically added to the Solution Items folder.

Note:

• Only reuse design components with a source object of an item revision can be updated.

• Subordinate design components cannot be updated.

• By default, the Mass Update Realization command is available to all users. Siemens Digital
Industries Software highly recommends that you limit access to this command using the
Command Suppression application. It controls the suppression of the Mass Update Realization
menu option based on a user’s group or role.

To learn how to suppress the Mass Update Realization menu option, see the Teamcenter
Administration.

• Mass update realization is available in the rich client only.

• You must have the necessary permissions to perform a mass update realization and if you want
to use a change object for the process, the 4th Generation Design Integration for Change
Management template must be installed.

Good practices for performing mass-updates of source objects

• By default, the Mass Update Realization command is available to all users. Siemens PLM highly
recommends that you suppress access to this command using the Command Suppression application.
It controls the suppression of the Mass Update Realization menu option based on a user’s group or
role.
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To learn how to suppress the Mass Update Realization menu option, see the Rich Client
Customization.

Performing mass-updates of source objects using change management

About the mass-updating of source objects using change management

During an engineering change request (ECR) change process, you can authorize the updates to be made
to design elements. Authorizing the updates is the first phase in the two-phase change management
process. The second phase is running the updates, which can be done in the engineering change notice
(ECN) that is derived from the ECR.

After authoring the updates in the ECR, a mass update realization update report is generated. This report
is attached to the change object.

Note:

• You must have write access to add items to the Problem Items and Impacted Items folders of
the change object.

• You can add/remove updates only when the ECR has the change states for creating an impacted
item.

Learn more about configuring the mass-updating of objects.

Phase 1 - Authorize mass updates using an ECR

Select the target, replacement, and change objects

1. If necessary, create an ECR to track the updates.

2. In My Teamcenter or Change Manager, select the item revision on which to base the change or the
ECR.

About the mass-updating of source objects using change management
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3. Choose Edit→Mass Update Realization .

The Mass Update Realization wizard appears.

It displays three areas for specifying the objects to be replaced and the change object to manage
them.

• Target Object

The item revision on which to base the change. The Mass Update Realization wizard searches for
realizations of this object within the specified collaborative designs and/or partitions.

• Replacement Object

The part to be replaced for the target object. It can be a revision of a different item than the
target object. All realizations of the target object are updated to use this object as their source
object.

• Change object

The change object in which to store the parts, the requested updates, and the results of the mass
updates.

Note:

If the change object you select contains an update, the Manage Update button appears
on the first page of the wizard for you to manage the updates associated with the
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change object. The Manage Update button only appears if the change object contains
existing markups.

4. In the Target Object, Replacement Object, and Change Object boxes, enter the objects to be
included in the update. You can also search for the objects.

5. Choose the following options beneath the parts:

• Click Add to Problem folder to store the target part in the change object’s Problem folder.

• Click Add to Solution folder to store the replacement part in the change object’s Solution
folder.

Note:

The labels of these options is Add to Newstuff folder until you select a change object.

6. Click Next and set the scope of the replacement.

Set the scope of the mass updates

Realizations are only searched for in the selected collaborative designs and/or partitions.

1. In the corresponding section of the Define scope of search of realizations page, set how you
want to limit the replacement of realizations.

Set the scope of the mass updates
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• Default Revision Rule

Select the revision rule to be applied when finding partitions and design elements.

• Collaborative Designs

a. Click the plus (+) next to the Collaborative Design table.

b. In the Search for Collaborative Designs dialog box, set the ID, name, modification dates,
and owning user attributes for the collaborative designs to be included in the updates.

c. Click Apply.

The results of the search appear.

d. (Optional) Set the values again to search for a different collaborative design.

e. Click Apply or when finished, click OK.

Selected collaborative designs appear in the Collaborative Design table of the Define scope of
search of realizations page.

• Partitions
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Realizations are only searched for in the selected partitions for the corresponding collaborative
designs.

a. Click the plus (+) next to the Partitions table.

b. In the Search for partition dialog box, set CD to a previously found collaborative design.

c. Set Scheme to a partition scheme type from the list of types available for the selected
collaborative design.

The top-level partitions of that scheme type in the given mode appear.

d. Expand any of the listed partition and select the partitions to include in the search.

e. Select Include Child Partitions to include the child partitions of the selected partitions in
the search scope.

f. Click Apply.

The selected partitions from the results of the search will appear in the partition table of
Define scope of search of realizations page.

g. (Optional) Set the values again to search for different partitions.

Set the scope of the mass updates
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h. Click Apply or when finished, click OK.

• Design Elements Attributes

Define criterion for including design elements in the search results. The criteria is applied when
searching for design elements. User can define criteria based on the name, ID, logical designator,
owner, and owning group.

Tip:

To remove a collaborative design or partition, select the collaborative design or partition you
want to remove, and click X next to the table.

2. Click Next.

The Mass Update Realization wizard displays all the realizations (reuse and subordinate design
elements) of the target object. Subordinate design elements are hidden by default. Display the
subordinate design elements by clicking Show subordinate DEs.

3. (Optional) Filter the design elements further by entering text in the box that appears below Where
Target is realized. You can clear the filter text by removing the text or clicking the Clear button

.

4. In the Select column (the column with check boxes and highlighted in red in the earlier figure),
select the impacted realizations you want to update. You can only select realizations to which you
have write permission.
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If a realization cannot be updated, an X appears in the Updatable column. The Comment columns
state the reason for you not being able to update it. In addition, the check box in the Select column
cannot be selected (it is displayed in gray).

5. Do one of the following depending on the type of process:

• If you are updating realizations using the two-phase change management process, click Next
and continue to the next step to save the update for execution later.

• If you are using the single-phase process in My Teamcenter:

a. Click Execute.

b. Review the results of mass update, and select Close.

The mass updates appear in the Newstuff folder as shown in the figure.

Save the update for execution later

After clicking Next in the previous step, the Review the Mass Update Realization and Execute, Save
or Cancel page appears.

Save the update for execution later
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1. (Optional) Click Back to make changes to the inputs.

2. Confirm the selection and select Save As Update.

A dialog box appears that informs you of which of the updates were successfully saved for later
execution and which were not.
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3. Review the results of the save-as update, and optionally add or remove updates.

Note:

When you select Add As Update, a page appears to let you select the target and replacement
objects (but not the change object). This is particularly helpful if you want to make a series of
updates within the same change management process.

The Mass Update Realization wizard updates the Problem and Impacted folders of the change object. It
also adds the results of the update to the ECR.

Save the update for execution later
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Edit the authorized update before running

You can manage the updates to an engineering change request (ECR) while they are still under the
control of the ECR process (they have been authorized but not run). For example, you can add additional
updates or remove an update.

1. In My Teamcenter or Change Manager, select either a part or the ECR with the authorized update.

2. Choose Edit→Mass Update Realization .

The updates that have already been added appear.

3. Do one of the following:

• To remove an update, select the update and to the right of the table, click the X.

• To add updates, click Add As Update to display the Mass Update Realization wizard and
authorize another update.

Note:

You cannot change the change object selection. The change object is locked because the
update is associated with that change object.
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Phase 2 - Run the authorized update using an ECN

Run the authorized updates using an ECN

After the engineering change request (ECR) authorizing a mass update is approved, start an engineering
change notice (ECN) to run the mass update.

The process updates the Solution Items folder of the ECN.

Note:

You must have write access to add items to the Solution Items folder of the ECN.

1. Derive an ECN from an ECR that contains an authorized mass update.

Note:

Be sure to select Propagate relations when deriving the ECN from the ECR to include the
mass updates in the Problem Items and Impacted Items folders of the ECR.

2. In My Teamcenter or Change Manager, select either a part (item revision) or the ECN with the
authorized update.

3. Choose Edit→Mass Update Realization .

The Manage Update dialog box appears showing the updates to be run.

Run the authorized updates using an ECN
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4. Click Execute.

The Update Results dialog box appears with the results of the mass update.

5. Review the results, and if necessary, fix any problems and rerun the ECN. You can also click
Submit to Workflow to open a workflow dialog box and submit the impacted objects selectively
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to workflow. For example, once update realization is completed, you many want to notify
stakeholders.

The Mass Update Realization wizard creates a new revision for all the released design elements, updates
all the design elements to which you have write access, and adds the results to the Update Results
report to the ECN.

Rerun the authorized updates using an ECN

During an open engineering change notice (ECN), you can run a mass update again to replace
realizations if there were failures during the original run that you have corrected.

Note:

Rerunning a mass update only performs updates on changes that did not run or failed. Successful
updates are not run again.

1. In My Teamcenter or Change Manager, select an ECN with an authorized update.

2. Choose Edit→Mass Update Realization .

The Manage Update dialog box appears.

Rerun the authorized updates using an ECN

Change Management ─ Deployment and Rich Client Usage, Teamcenter 2412  13-85
© 2025 Siemens



3. Click Execute.

A dialog box appears with the results of the mass update realization.

4. Review the results.

The Mass Update realization creates a new revision for all the released design elements, checks out all
the design elements to which you have write access, and adds the results in the Update Results report
to the ECN.
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Performing mass-updates of source objects in a single phase using My Teamcenter

Mass-update source objects in a single phase using My Teamcenter

Using My Teamcenter, you can update the source objects of design elements a single phase from
selection to execution. The updates are stored in your Newstuff folder.

1. In My Teamcenter, select the item revision on which to base the update.

2. Choose Edit→Mass Update Realization.

The Mass Update Realization wizard appears.

It displays three areas for specifying the objects to be replaced and the change object (optional) to
manage them.

• Target Object

The item revision on which to base the change. The Mass Update Realization wizard searches
for realizations of this object in design elements within the specified collaborative designs or
partitions.

• Replacement Object

Mass-update source objects in a single phase using My Teamcenter
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The part to be replaced for the target object. It can be a revision of a different item than the
target object. All realizations of the target object will be updated to use this object as their
source object.

• Change object

Do not select a change object in a single-phase process. If you select a change object, the mass
update becomes a two-phase process under change management.

3. In the Target Object and Replacement Object boxes, enter the objects to be included in the
update or search for the objects.

4. Select Add to Newstuff folder to store the target and replacement parts in the Newstuff folder.

5. Click Next and set the scope of the replacement.

Set the scope of the mass updates

Realizations are only searched for in the selected collaborative designs and/or partitions.

1. In the corresponding section of the Define scope of search of realizations page, set how you
want to limit the replacement of realizations.

• Default Revision Rule

Select the revision rule to be applied when finding partitions and design elements.
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• Collaborative Designs

a. Click the plus (+) next to the Collaborative Design table.

b. In the Search for Collaborative Designs dialog box, set the ID, name, modification dates,
and owning user attributes for the collaborative designs to be included in the updates.

c. Click Apply.

The results of the search appear.

d. (Optional) Set the values again to search for a different collaborative design.

e. Click Apply or when finished, click OK.

Selected collaborative designs appear in the Collaborative Design table of the Define scope of
search of realizations page.

• Partitions

Realizations are only searched for in the selected partitions for the corresponding collaborative
designs.

a. Click the plus (+) next to the Partitions table.

Set the scope of the mass updates
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b. In the Search for partition dialog box, set CD to a previously found collaborative design.

c. Set Scheme to a partition scheme type from the list of types available for the selected
collaborative design.

The top-level partitions of that scheme type in the given mode appear.

d. Expand any of the listed partition and select the partitions to include in the search.

e. Select Include Child Partitions to include the child partitions of the selected partitions in
the search scope.

f. Click Apply.

The selected partitions from the results of the search will appear in the partition table of
Define scope of search of realizations page.

g. (Optional) Set the values again to search for different partitions.

h. Click Apply or when finished, click OK.

• Design Elements Attributes
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Define criterion for including design elements in the search results. The criteria is applied when
searching for design elements. User can define criteria based on the name, ID, logical designator,
owner, and owning group.

Tip:

To remove a collaborative design or partition, select the collaborative design or partition you
want to remove, and click X next to the table.

2. Click Next.

The Mass Update Realization wizard displays all the realizations (reuse and subordinate design
elements) of the target object. Subordinate design elements are hidden by default. Display the
subordinate design elements by clicking Show subordinate DEs.

3. (Optional) Filter the design elements further by entering text in the box that appears below Where
Target is realized. You can clear the filter text by removing the text or clicking the Clear button

.

4. In the Select column (the column with check boxes and highlighted in red in the earlier figure),
select the impacted realizations you want to update. You can only select realizations to which you
have write permission.

If a realization cannot be updated, an X appears in the Updatable column. The Comment columns
state the reason for you not being able to update it. In addition, the check box in the Select column
cannot be selected (it is displayed in gray).

5. Do one of the following depending on the type of process:

Set the scope of the mass updates
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• If you are updating realizations using the two-phase change management process, click Next
and continue to the next step to save the update for execution later.

• If you are using the single-phase process in My Teamcenter:

a. Click Execute.

b. Review the results of mass update, and select Close.

The mass updates appear in the Newstuff folder as shown in the figure.

Folders that store the updates

You can optionally store the results of a mass update that you perform in a single step in the Newstuff
folder, as shown in the figure. The results appear under the subfolder Mass Update Results with the
actual update stored under a folder with the date of the update. Under the date folder are folders
containing the results, which are the same types of folders used to manage a change. A report of the
results is also stored in the folder.

• Problem Item

The target item (the item revision that was added or replaced).

• Impacted Items

The assemblies that were impacted by the update.

• Solution Items

The additional or replacement part (the item revision that was added or that replaced the target).
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Search for target, replacement, and change objects

In the Mass Update Realization wizard, you can search for the objects to be included in the update.

1. In the Target Object, Replacement Object, and Change Object boxes, enter any search criteria for
objects to be included in the update, and click the Search tool , as shown in the figure.

A Search dialog box appears, depending on the type of object. The following shows the search
dialog box for the target object. The options are the same for a replacement object. You can search
based on ID, name, and revision.

Search for target, replacement, and change objects
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The following shows the search dialog box for a change. You can search based on ID, synopsis, and
revision.
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2. From the table, select the part or change object.

3. Click OK to return to the Mass Update Realization wizard.

A thumbnail of the selected objects appear in the Mass Update Realization wizard.

Search for target, replacement, and change objects
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14. Managing a change
About change dependencies

Change dependency

ECNs can be ordered and sequenced with respect to each other by designating an ECN as before, after,
or concurrent. This is done by creating a relationship between the dependent ECNs.

• Before Dependency - one ECN needs to be addressed before the other

• After Dependency - one ECN needs to be addressed after another

• Concurrent Dependency - the ECNs should be addressed simultaneously

These relationships lay out a sequence for moving the ECNs forward in the change process.

Change dependencies can be used to detect references across changes and report them to users. The
system then allows or prevents certain actions based on the dependencies. For example:

• When sharing for collaboration, all concurrent ECNs must be shared together. If a user attempts to
submit a single ECN with concurrent dependencies to the ChangeNoticeRevision Share workflow,
the system will display an error.

• When closing an ECN by releasing it, all concurrent ECNs must be released together. They must be
targets of the same workflow process such as the ChangeNoticeRevisionDefaultWorkflow.

• You cannot reference an item that is in context of another ECN unless either the changes are
concurrent or the ECN whose content is being referred to is ahead of the referring ECN in the
sequence.

Create a change dependency

1. Right-click the dependent ECN and choose Copy .

2. Select the other ECN and choose Edit→Paste Special.
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3. In the Paste Special dialog box, select Concurrent Dependency and click OK.

A change dependency has been created between the two ECNs.

About Active Change

When you set the Active Change in your user profile, you see a list of ECNs returned via the saved
query My Change Notices. By default, all ECNs are listed where you are a change analyst, or a change
contributor. You can designate the ECN to receive all of your new and modified content to be tracked by
default. This feature means that you never have to navigate away from the structure you are modifying,
once the Active Change is set.

Note:

If you have created a custom participant or custom user profile, you must add the new attribute to
the Search Criteria section for the My Change Notices query.

A business object constant is added to facilitate this function, Cm0ChangeManaged, and its default
setting is true for ItemRevision and Configurator objects. If this constant is set to true, the new object
is tracked against the global change context (set in the User profile).

About managing a change

Using Change Manager, you can propose a change to a product, and then manage the entire cycle of
investigation, elaboration, review, approval, and implementation of the change. These tasks are typically
controlled by workflows that flexibly guide the change through the four phases of the change process.
Once selected and configured, the workflow guides each participant through the steps of the process by
adding tasks to the My Worklist folder of each participant directing them to perform necessary actions,
such as assigning reviewers, reviewing document changes, or entering data.

The work required to manage the change process is:

• Begin the change process.

• Assess the change’s impact on any managed business items, such as parts or documents.

• Assign and modify participants.

• Initiate any workflows and monitor the progress and completion.

Initiate a workflow process

1. Select the change object, and do one of the following:

• Choose File→New→Workflow Process.
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• Click the Summary view and select New workflow process,

The New Process Dialog dialog box appears.

2. Type a name for the process in the Process Name box.

3. Type a description to identify the process in the Description box.

4. Click the Process Template list to view process templates and make a selection.

5. (Optional) Select the Show Under Construction Templates check box.

6. Select a Process Template Filter option, if available.

Caution:

Legacy Process Template Filter functionality has been deprecated as of Teamcenter 11.2,
and is turned off by default. This functionality is replaced by Business Modeler IDE conditions
used to associate templates.

• To view all available process templates, select the All option.

• To view only those process templates assigned to your group, select the Assigned option.

7. Click the Attachments tab to view or assign target and reference attachments.

It is not necessary to assign target data at the initiation of a process.

• If necessary, generate a list of objects from several sources, including search results, Structure
Manager, and other active Teamcenter applications, that can be pasted as references or
attachments.

8. Click the Process Template tab to view the process template selected as the basis of the new
process.

9. (Optional) Assign all tasks in the process.

a. Click the Assign All Tasks tab.

The system displays the assignment list information.

b. Select a list from the Assignment Lists list.

Teamcenter applies the assignment list to the tasks in the process. Users are displayed as
nodes in the process tree and the action assigned to the user is displayed to the right of the
tree under the Actions heading.

Initiate a workflow process
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Note:

The select-signoff-team and perform-signoffs subtasks associated with Route,
Review, and Acknowledge tasks are not displayed in the tree.

c. (Optional) Assign responsible parties:

A. Select the task node in the tree.

B. Click Add (+).

The system displays the user information and action assigned to that user beneath the
task node in the process tree.

C. Repeat the previous steps to assign a responsible party for other tasks in the process.

d. (Optional) Assign users:

A. Expand the task node in the tree to begin to assign users to review, acknowledge, or
receive notification of a task.

The system displays either the Users node or Profiles node.

• The Users node allows you to assign resources using an ad hoc selection process.

• Profiles limit the pool of users that can be assigned to the task.

The system displays the Profiles node when user profiles were defined as part of the
process template.

B. Select the Users or Profiles node.

C. Use the Group, Role, and User lists to select a user.

D. Select an action from the list.

The system displays the actions in this list based on the task template type. For example,
if a Route task is selected, the Review, Acknowledge, and Notify actions are displayed.
If a Review task is selected, only the Review action is available; if an Acknowledge task
is selected, only the Acknowledge action is available.

E. Click Add (+).

The system displays the user information and action assigned to that user beneath the
task node in the process tree.

14. Managing a change
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F. Repeat the previous steps to assign users to review, acknowledge, or receive notification
of other tasks in the tree.

Tip:

You can copy user nodes and paste them in to another task using the Copy and
Paste buttons located beneath the tree.

e. (Optional) Modify or set the quorum value for Review and Acknowledge tasks in the Rev
Quorum and Acknow Quorum boxes.

f. (Optional) To save modifications to the process assignment list, select the Save Modifications
Back to List check box.

Note:

You can only save modifications to personal process assignment lists. Shared lists can be
modified, but the changes cannot be saved.

10. Click OK to initiate the process.

Note:

Click Cancel at any time to cancel the operation without initiating a process.

View the status of a workflow in Change Manager

Within Change Manager, you can view the tasks in a workflow associated with a change object or
schedule using the Workflow Viewer as shown. It provides a task view representation of the workflow to
which the selected change object or schedule task is submitted.

• In a Change Manager view, such as Change Home, right–click a change object or schedule with a
workflow submitted, and choose Workflow Viewer.

The workflow tasks appear in the Workflow Viewer tab.

View workflow assignments and their status

Using the Summary view in Change Manager, you can view the tasks in a workflow associated with
a change object or schedule, their status, and the assigned participants, as shown for an engineering
change request (ECR). You can also start a new workflow process.

View the status of a workflow in Change Manager
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1. In a Change Manager view, such as Change Home, select a change object or schedule with a
workflow submitted.

2. Click the Summary tab.

View the workflow status and assignments.

About classifying changes

Changes are classified to determine the level of approval required.

• Fast track

In a fast track classification, an engineer uses an engineering change request (ECR) followed by an
engineering change notice (ECN) to develop a solution for a change and implements the change
without going through a formal review process. Fast track changes meet prescribed criteria, such as
low risk or low cost. Typically, the majority of changes are processed through fast track.

• Standard track

14. Managing a change
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A standard track classification follows a formal change process including change and implementation
review boards. They are for changes that do not meet the fast track criteria (for example, for high-
risk, high-cost, complex changes). It requires an ECR, separate ECNs, and an approval process to
manage the change implementation and approval. Because of the cost and length of time to make
such a change, schedules are typically used to plan and manage the solution development and
implementation.

Teamcenter provides an Is Fast Track? property on the ECR that directs changes down one of these two
tracks during workflow.

Edit the properties of a change object.

The following are organization and product considerations that are often used to determine whether a
change goes through a fast or standard track for.

About classifying changes

Change Management ─ Deployment and Rich Client Usage, Teamcenter 2412  14-7
© 2025 Siemens



Replicating change objects on remote sites

Using Schedule Management ─ Deployment and Rich Client Usage, you can replicate change objects
on remote sites by creating workflows on remote sites. Teamcenter creates a workflow as a remote
workflow whenever the privileged user is a remote user (or, in absence of a privileged user, the
workflow owner is a remote user).

When the system creates the remote workflow, it completes the following:

• Links the schedule task to that workflow.

• Attaches all task attachments including Solution Items, Problem Items, and Impacted items using
GRM relations.

• Checks attachments out remotely or transfers ownership to the remote site.

The change object is replicated along with its Reference Items.

14. Managing a change
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Managing the participants of a change

About the participants in the change process

Different types of users are involved in various phases of the change process.

For example, at the start of the change process, a requestor creates a change object. During the life of
the change object, analysts review it, provide input, and implement the change; and change specialists
(change administrators) facilitate its movement through the change process. Members of a change
review or change implementation board may review and approve or disapprove the change.

The terms requestor, analyst, specialist (administrator), implementation board, and review board refer
to roles that participants perform at different steps of the change process. Depending on the complexity
of a change, the same person may perform many roles, or many people may perform the same role.

A change specialist assigns users for each participant type used in the change object. A change
management workflow can then be configured to automatically assign workflow tasks to the
appropriate users based on their participant type on the change object.

For example, the workflow can automatically assign the analyst to perform the Implement Change
workflow task. These users are referred to as dynamic participants.

Note:

• See your workflow administrator for information about how your company’s change
management workflows are configured or learn more about extending the dynamic
participants.

• Rules that control who can perform what and at what stage of the change process are defined
as Change Manager conditions.

• You can also set participants programmatically using the Integration Toolkit (ITK).

• Change contributors can also be added. Change contributors can create solutions for the
change notice just like an analyst. They act as a secondary analyst.

Types of participants

Participants Description

Requestor

Creates a change object or is delegated a change object
by another requestor. The requestor is responsible for
elaborating the definition of a change and for providing as
much detail as possible to define the problem or request
at hand. A requestor may perform the elaboration, or a

About the participants in the change process
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Participants Description

change specialist may delegate responsibility for elaborating
a change to another user (an analyst or requestor).

When you create a change object, you are its requestor. If
responsibility is delegated to another user, that user becomes
the current requestor and you are no longer the requestor.

Analyst

Assesses the technical feasibility of a change or the technical
feasibility of implementing the low-level details of a change.
An analyst elaborates the details of a change by providing
a technical recommendation, performing an impact analysis,
and planning the implementation. The analyst may perform
the implementation or delegate the work to others. During
the implementation phase, the analyst monitors the change
execution and is ultimately responsible for ensuring the
implementation is performed correctly and according to the
plan.

This person is generally a senior technical person with
knowledge of technical issues and a site’s products and
business goals.

Change specialist
(change administrators)

Facilitates and manages movement of a change or deviation
through the appropriate processes at a site. Change
specialists also work to continuously improve the change
process itself. They have an understanding of product
definitions and a site’s change process. There can be three
levels of change specialists:

• Change specialist I is responsible for coordinating the flow
of problem reports, deviation requests, and ECRs through
the analysis phase, preparing cost estimates for complex
ECRs, and creating the agenda for change review board
meetings. Change specialist I also chairs those meetings.

• Change specialist II prepares ECNs for implementing
approved ECRs by identifying those that can be grouped
and implemented with one ECN. The item and document
impact matrix within the ECN form provides an ideal road
map for the change implementation board to develop
a detailed implementation plan. Change specialist II
strives to minimize the cost of implementing approved
ECRs while also achieving end-item traceability. ECNs are
released to the change implementation board on the basis
of the ECR priorities and available capacity.

Change specialist II does not initially appear
in Change Manager by default. Modify the
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Participants Description

isChangeSpecialist2Assignable condition so a user can
be assigned as change specialist II.

• Change specialist III audits ECN packages to assure
continuity between superseded and superseding
documentation, records, and data. ECNs and detailed
implementation plans are used as checklists of audit
requirements. Change specialist III releases documents,
records, and data that conform to these requirements.
Change specialist III is essentially an inspection function,
and the objective is to streamline the process and
eliminate the need for inspection.

Change specialist III does not initially appear
in Change Manager by default. Modify the
isChangeSpecialist3Assignable condition so a user can
be assigned as change specialist III.

Change review board

Reviews, approves, and authorizes engineering change
requests and deviation requests. The review board makes
a business decision about whether a change or deviation
request should proceed. Review board members are
generally senior individuals from various functional areas
within a site or individuals who have expertise in some
aspect of a change or deviation.

Change implementation board

Reviews, approves, and authorizes change notices. This
group reviews the detailed implementation plan for an
engineering change notice and makes a technical decision
about whether to implement the planned change. The group
also makes an implementation plan.

The membership of the implementation board generally
includes both people with technical knowledge and
managers with control of resources and schedules.
Membership may vary depending on the complexity, cost,
and other characteristics of a change.

About dynamic participants

Dynamic participants are workflow handlers that automatically assign users to perform different
workflow tasks based on the participant types assigned to a change object that has been submitted to
workflow. The default participant types include Analyst, ChangeSpecialist1, Requestor, and Change
Contributor, as well as others.

A change specialist uses the Assign Participants command to assign participants for a change object.
Then, when the workflow that is configured for dynamic participants reaches a task and needs to

About dynamic participants

Change Management ─ Deployment and Rich Client Usage, Teamcenter 2412  14-11
© 2025 Siemens



determine who the participants are, the workflow looks at the current assignee for the participant type
(for example, Reviewer for a Review task) and sends it to that user’s inbox. If the user assigned to a
participant type changes after the workflow starts, the workflow automatically recognizes the new user
for any tasks that have not started.

If a workflow is not set up to have dynamic participants, the participants are determined explicitly by
selecting users. Those participants are fixed and cannot change.

Caution:

A user is assigned as a participant with a specific group and role. The user’s session context must
be set to the same group and role they are assigned as to satisfy any Change Manager conditions
that are applied.
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Note:

You can set the participants using the Integration Toolkit (ITK).

Assign participants

Note:

• To use the Assign Participants command to assign review members based on their roles, a
workflow must be configured to use dynamic participants.

See your workflow administrator for information about how your company’s change
management workflows are configured or learn about designing a workflow with dynamic
participants.

• You must have permission to assign participants.

1. Select the change object that you want to assign participants to.

2. Choose Tools→Assign Participants.

3. In the Assign Participants dialog box, select the participant type (for example, Change Specialist
I).

4. Click either the Organization or Project Teams tab and select a user to assign to the participant
type.

You can search for a group, role, or user in the box below the tabs.

Use Resource Pool Options to assign a set of group or role members as participants instead of
individual users. When a group or role is selected, additional options become available.

• If you select a group, you can click Any Member so any member of the group can be the
participant for that type.

• If you select Proposed Reviewers, Change Review Board, or Change Implementation Board,
and then select a group, you can click All Members to assign all members of the group.

• If you select a role under a group, you can click Any Member and choose Specific Group to
assign any member of the combined group and role as the participant type or choose Any Group
to assign any member of any group and the selected role as the participant type.

5. To remove a user as a participant, select the user under the participant type and click Remove.

6. To change a participant, select the user under the participant type, select the new user in the
Organization or Project Teams tab, and click Modify.

Assign participants
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7. Click Add.

8. When you are finished assigning participants, click OK.

Note:

If the change object does not automatically display the assigned participants in the Summary, it
may be necessary to manually refresh the window.

About setting change states

To set the change states of a change, use the EPM-set-property workflow handler on your workflow
process.

For example, if you want to change the value of the Disposition property to Approved, set the handler
to the following on the appropriate task in your workflow process:

EPM-set-property –props=CMDisposition –values=Approved 
–to_att_type=TARGET –bypass

Note:

You must use the –bypass argument to change the property value.

The EPM-set-property handler requires a list of explicit classes as explained below for each of the
change objects.

For the change object The class is

Problem reports -include_types=ProblemReportRevision

Change requests -include_types=ChangeRequestRevision

Change notices -include_types=ChangeNoticeRevision

Setting change effectivities

About setting change effectivities

Revision effectivities specify the actual timing of when an engineering change notice (ECN) takes effect.
Effectivities state the implementation point for the change in the product structure, and they can be
stated in a variety of ways. The product structure can be configured for a particular date or unit (serial)
number by applying a revision rule.

14. Managing a change
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Effectivity type Description

Date Specifies the range of dates for which the results of a change
take effect. You can assign a date effectivity to an ECN.

Unit Specifies the range of item units or serial numbers for which
the results of a change take effect. You can assign a unit
effectivity to an ECN.

Note:

Effectivities can only be applied to an ECN after it is reviewed and approved, but before it has been
implemented. The ECN revision must have a release status added to it.

• The change notice must have a release status.

• The change notice Disposition state must be set to Approved.

• The change notice Maturity state must be set to Reviewing.

The effectivity must be applied manually to the Solution Items assemblies so the product
structure can be configured using effectivity. The effectivity is not automatically propagated from
the ECN.

Assign effectivity

1. Select the change notice revision that you want to assign an effectivity to. To set an effectivity, the
change notice must have the following:

• You must be assigned as a change specialist for the change notice.

• The change notice revision must have a release status.

• The change notice Disposition state must be set to Approved.

• The change notice Maturity state must be set to Reviewing.

2. Click the Change Effectivity pane.

3. Click Create.

4. Click Units or Dates effectivity, as appropriate, and define the range.

If defining a unit effectivity range, type the desired effectivity range in the Units box. Use the
- character within a continuous range and the , character to separate discontinuous ranges. For

Assign effectivity
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example, the unit range 1-5,7-9 defines effectivity for units 1 through 5 and 7 through 9 (but not
effective for unit 6).

If defining a date effectivity range, select a date from the calendar (and optionally enter a time),
and click Set Date to place that date in the From Date cell. Select another date (and optionally
enter a time), and click Set Date to place that date in the To Date cell. Repeat these steps for
additional date ranges until you enter all the desired date ranges. Click the Clear Date button to
remove a date from the currently selected cell.

• Click the UP button to add the and up (open-ended effectivity) condition to the end of the unit
or date effectivity range.

• Click the SO button to add the stock out condition to the end of the unit or date effectivity
range.

• If you use effectivity mapping, select the Shared Effectivity check box.

• Select the Apply Access Manager effectivity protection check box to apply the predefined
access rules to this effectivity.

Note:

Teamcenter interprets UP and SO conditions as open-ended for revision configuration
purposes. The revision is considered effective for any value greater than or equal to the unit
or date value immediately preceding the UP or SO. Stock out indicates that existing stocks of
a component revision should be used up before the next revision.

5. For unit effectivity, define an end item to qualify the effectivity range. You must use this with the
unit effectivity range to specify a product, module, or subsystem that carries the unit number to
which this effectivity refers. You can select an end item in one of the following ways:

• Click Open by Name  adjacent to the End Item box and search for an item by identifier and/or
name.

• Copy an item to the clipboard and click Paste  adjacent to the End Item box.

• Click MRU  adjacent to the End Item box.

Note:

If you want to remove the entered end item, click Clear  adjacent to the End Item box.

Once you select the end item, select the revision from the list to the right of the Clear  button.

6. For Intent, select the intent for each line in the ECN.
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Note:

One of the effectivity properties must be specified, either Date or Unit. To choose multiple
intents, your site must be configured to do so.

7. When you are finished, click OK.

About proposed effectivity

Proposed effectivity is set on a change notice before a release status is added. This effectivity is planned
prior to the completion of a change and the release of its solution items.

Note:

Proposed effectivity is assigned and edited in Active Workspace.

1. Select the change notice that you want to view a proposed effectivity.

2. Click More Properties in the Summary pane.

3. Select the All tab and scroll to Proposed Effectivity.

4. If Proposed Effectivity is not in the list, and to verify it is not set, select Show Empty Properties at
the end of the Edit Properties window.

Generate the As Planned/As Released baseline report

The As Planned/As Released baseline report displays the structural hierarchy of an object and provides
details about attached documents, the authorizing change notice, effectivity, and release date. It also
displays the planned change notice for in-process documents as well as change effectivity.

Example:

Run the report on an assembly with multiple levels, attachments, and revisions. The report
identifies affected items with document attachments and their respective change notices.

To see the structure of an ECN, generate the Change Item Report.

1. Select a change object.

2. Right-click the change object and click Generate Report.

3. Select As Planned As Released Baseline Report and click Next.

4. Click Finish to run the report.

About proposed effectivity
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The report opens in a browser window.

5. (Optional) Generating the report could take several minutes. You can click Run in Background to
continue working while the report is generated.

The report provides the following information in a table format:

The table is broken down into three main sections. The contents of the columns are dependent on the
structure configuration, whether or not an attachment is revised or released, and if it is part of a change
notice.

Note:

Revisions to document attachments are not automatically updated in the Attachments tab. When
a document attachment is revised, manually add it to the Attachments in order to accurately
display the revision history in the As Planned As Released report

Items

Contains all of the items in an assembly.

Documents As Planned/As Released

Contains documents and other attachments. If an attachment is released as part of a change with
a Proposed Effectivity this is listed in the Effectivity Date column with the related change notice
number in the Change Notice column. If the attachment was not released as part of a change, those
columns are empty.

Planned Changes
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Contains only items that currently part of an unreleased change. Solution items that are revisions of
an impacted item are added and include the ECN. The related impacted items shows that it will be
deleted.

The CM_PRIMARY_DOCUMENT_RELS preference must be configured in order for the baseline report to
run. It defines the relations through which a document is attached to an Item Revision. If a document is
primary and the Item Revision is secondary in the relationship, the prefix S2P: must be provided.

The default settings are as follows:

IMAN_specification

Fnd01isDescribedByDrawing

FND_TraceLink

FND0DesignToBomRelation

IMAN_METarget

Allowable values are any relation that can be associated with an ItemRevision.

Generate the As Planned/As Released baseline report
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15. Administering the change management
process
About administering the change management process

Because change management processes differ from company to company, you can configure and
customize Change Manager to meet your business needs and help you follow your documented process.

• Set Change Manager options.

• Set up groups and roles for users to be involved in the change process.

• Set up how changes are derived.

• (Optional) Define custom change management objects.

• Configure conditions to control the actions of participants.

• Create workflows for the change process.

Migrating to Change Manager

If you used Change Viewer in the past, when you upgrade to the latest version of Teamcenter, existing
Change Viewer classic change objects are not upgraded; in other words, their database storage is not
changed. You will need to create a Change Manager object and link the Change Viewer classic object to
it.

Existing Change Viewer classic objects are likely moving through an active workflow. You cannot migrate
these objects without disrupting the workflow. You must determine which milestones are important to
check and accommodate in the workflow if you want to start a Change Manager object at the point
in the workflow where the corresponding Change Viewer classic object stopped. If you have Change
Viewer classic objects, you must develop a process and ensure workflow contributors are aware of the
migration to Change Manager.

Therefore, we recommend that you:

1. At a given milestone, create a Change Manager object and link the Change Viewer classic object
using the Reference Items folder.

2. Either allow the Change Viewer classic object to continue through its workflow or terminate
the current workflow and start a new workflow for the Change Manager object. You can add
conditional evaluations in the workflow to forward the new change object to the correct step in the
workflow process.
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3. Create all new change objects using Change Manager.

Setting Change Manager preferences

You can set the following Change Manager preferences:

• To view Change Manager, set HiddenPerspectives (make sure Change Manager is removed from the
list of hidden perspectives and CMViewerClassic is in the list (hidden).

• The Teamcenter change management process does not support displaying substitutes on separate
BOM lines in Structure Manager. Turn off the substitutes display (set PSEShowSubstitutesPref to 0)
when working with change-management related features.

Setting up users

About setting up users

You will want to set up rules to restrict change management actions to authorized users. For example,
you may want to define rules to limit the creation of engineering change requests (ECR) and engineering
change notices (ECN) to change specialists who are members of the Change Management group. 

• Use the Organization application to define groups and roles and associate the roles with the
participant types. A typical approach is to create a change management group to contain the change
specialists.

• Use the Business Modeler IDE to define the conditions that drive access rules used to manage object
permissions. In the example shown here, the business rule for creating ECRs is limited to those who
are members of the Change Management group:

isChangeRequestCreatable
OR u.group_name = "Change Management"

It is recommended that you create the roles with a similar name to the participant types to avoid
confusion. For example, create the Change Specialist role to match the ChangeSpecialist1 participant
type. If you want to use different change specialists, create roles, such as Change Specialist 1, Change
Specialist 2, and so on.

Change analysts can be selected from anywhere in the organization, but it might be useful to identify
those users who can perform the technical input for changes in an Analyst role. A sample of a typical
organization tree is shown in the figure.
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Example of configuring groups to create change requests and change notices.

Note:

Users need a Teamcenter Change Management license level that enables authoring to use all
Change Manager functionality. If they do not have a higher level license, they are about creating
issues and penetration requests limited to the following functionality:

• Creating a problem report (PR).

• Checking in a PR and submitting it to a workflow process.

• Adding business items to the PR Problem Items and Reference Items folders.

• Searching for and viewing change objects: PRs, engineering change requests (ECRs),
engineering change notices (ECNs), and deviation requests (DRs).

About setting up users
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• Receiving and acting on workflow assignments and tasks.

Set Active Change in user profile

You can edit the Active Change in the User Settings dialog box. The Change Context shows a list of
available change notices when you are either the change analyst or a change contributor. Once selected,
the change notice revision also displays in subsequent sessions as the Active Change.

For example, when a new item is created and ECN-888803 is selected as the change context, its first
Item Revision appears in the solution items of ECN-888803.  Likewise, if a revise operation is performed
on an existing Item Revision, the newly-created item revision is also attached to ECN-8888803 as a
solution item. 

15. Administering the change management process
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If the original item revision was already attached to ECN-888803 as an impacted item, then in addition
to adding the new item revision as a solution item, the original revision and the new revision are also
automatically associated to each other with a change lineage.

Set Active Change in user profile
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Setting participants programmatically using ITK

You can set the participants of a workflow using the Integration Toolkit (ITK). The following example
shows how you can set participants using the ITK.

TCTYPE_find_type("ChangeSpecialist1", "ChangeSpecialist1", 
&participant_type);

EPM_create_participant(group_member, participant_type, participant_tag);

GRM_find_relation_type("HasParticipant", &relation_type));

GRM_create_relation(cn_rev_tag, participant_tag, relation_type, 

 NULLTAG, &relation));

GRM_save_relation(relation));

Note:

For more information about using the ITK, see the Integration Toolkit Function Reference on
Support Center.

Configure a group to create change requests and change notices

1. In Organization, create a group that contains users who work with change objects and add those
users to the group. For example, create the Change Management group.

2. Open the Business Modeler IDE.

3. Access the Advanced perspective by choosing Window→Open Perspective→Other→Advanced.

4. In the Extensions view, select the project in which you want to create the condition. Right-click the
project and choose Organize→Set active extension file. Select the file where you want to save the
data model changes.

5. Expand the project and the Rules→Conditions folders.

6. Double-click the isChangeRequestCreatable condition.

7. In the Expression box, type the following after the existing text:

OR u.group_name = "new-group"

15. Administering the change management process
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If you use the example group from step 1, type the following:

OR u.group_name = "Change Management"

8. Double-click the isChangeNoticeCreatable condition.

9. In the Expression box, type the following after the existing text:

OR u.group_name = "new-group"

If you use the example group from step 1, type the following:

OR u.group_name = "Change Management"

10. To save the changes to the data model, choose File→Save Data Model, or click the Save Data
Model button on the main toolbar.

11. Deploy the data model to the database.

Users in the Change Management group can create change requests and change notices.

Configuring how changes are derived

As system administrator, use the CM_change_derivations preference to configure which change object
can be derived from another.

• Derive an engineering change request (ECR) from a problem report (PR) to determine a solution for
the problem.

• Derive an engineering change notice (ECN) from an ECR to implement the solution to the problem.

• Derive a deviation request from a PR to allow a deviation.

Configuring how changes are derived
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Note:

Refer to Define deep copy rules for creating changes from another change for more information on
configuring Copy Options.

Defining custom change management objects

Use the BMIDE for Data Model Design to create custom change management objects representing the
change objects for your change process. The custom objects you create are templates of the different
change processes to be used at your site. End users create instances of these change objects, such as
change requests, and use them in their workflow processes. Also, to enable users in the change process
to create the custom business objects, make new conditions allowing the creation.

List of standard change management business objects.

In addition to creating the custom change management objects, you can also:

• Configure Change Manager pseudofolders in which to store objects related to the created objects and
which automatically appear when a user creates an object of that type.

• Create new forms as needed in which to hold custom information about the change management
object.

• Add properties, such as change type, to existing change management objects.

If you want to add persistent properties to change objects, you can extend business classes directly
using the Business Modeler IDE. You can also create a dialog box definition by specifying the required
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and optional properties for an instance creation. Subclasses that do not have their own dialog box
definition inherit the dialog box definition of their parent class. To display new properties, you must
add them to the style sheets defined for the change object.

Note:

Before working with Change Manager objects, you must install the Change Management template
(cm_template.xml file) to your project. During installation, select Change Management in the
Business Modeler IDE Templates panel in Teamcenter Environment Manager.

Configuring conditions to control the actions of participants

About configuring conditions to control the actions of participants

Use the BMIDE for Data Model Design to configure Change Manager to fit your business process by
setting specific conditions or rules. They control which participants can perform specified actions under
certain Maturity, Disposition, and Closure change states.

Conditions generally apply to all types of change objects (PRs, ECRs, and ECNs).

• Summary of default Change Manager conditions

• Examples of Change Manager conditions.

• Working with conditions when adding a custom naming rule to standard Change Manager objects.

To see a listing of all the Change Management on Active Workspace ─ Usage conditions, see the
Teamcenter Data Model Report in the Teamcenter documentation on Support Center.

Examples of Change Manager conditions

• Restrict who can add item revisions to the Solution Items folder and when

• Restrict who can add item revisions to the Problem Items folder and when

• Restrict who can assign the analyst and when

Restrict who can add item revisions to the Solution Items folder and when

Use the following condition to allow only an analyst to add item revisions to the Solutions Items folder
when the following states are met:

• Closure is Open

• Disposition is Approved

About configuring conditions to control the actions of participants
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• Maturity is Executing

Cm0isCMHasSolutionItemCreatableForPrimary ( ChangeItemRevision o , 
UserSession u)

Then, define the following expression:

(Condition::isAnalyst (o, u) AND o.CMClosure = "Open" 
AND o.CMDisposition = "Approved" AND o.CMMaturity = " Executing“ ) 

If this condition is not met, the analyst cannot add the solution item and an error message appears. 

Restrict who can add item revisions to the Problem Items folder and when

Use the following condition to restrict when a requestor or analyst can add item revisions to the
Problem Items folder. It sets one combination of required states for the requestor and a different
combination for the analyst. Such restrictions ensure that the requestor can no longer add problem
items after completing the elaboration phase and the analyst can no longer add problem items after
completing the review phase.

Cm0isCMHasProblemItemCreatableForPrimary ( ChangeItemRevision o , 
UserSession u)

Then, define the following expression:

(Condition::isRequestor(o,u) AND o.CMClosure = "Open" AND o.CMDisposition =
"None"
AND o.CMMaturity = "Elaborating") OR (Condition::isAnalyst(o, u) AND
((o.CMClosure = "Open" AND o.CMDisposition = "None" AND o.CMMaturity =
"Elaborating") OR (o.CMClosure = "Open" AND o.CMDisposition = "Investigate"
AND o.CMMaturity = "Reviewing") OR (Condition::isChangeExecutionAllowed(o,
u)))))

The expression does the following:

• First, it sets the restrictions for when the requestor (isRequestor) can add item revisions:

(Condition::isRequestor(o, u)  AND o.CMClosure = "Open" AND
o.CMDisposition = "None" AND o.CMMaturity = "Elaborating“

It only allows the requestor to add items revisions to the Problem Items when:

• Closure is Open (o.CMClosure = ”Open”)

• Disposition is None (o.CMDiposition = ”None”)

15. Administering the change management process
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• Maturity is Elaborating ((o.CMMaturity = " Elaborating“)

• Next, it sets the same restrictions for the analyst (isAnalyst):

Condition::isAnalyst(o, u) AND ((o.CMClosure = "Open" AND o.CMDisposition
= "None" AND o.CMMaturity = "Elaborating“ ) 

• Closure is Open (o.CMClosure = ”Open”)

• Disposition is None (o.CMDiposition = ”None”)

• Maturity is Elaborating ((o.CMMaturity = " Elaborating“)

• Then, it sets a second case for when the analyst can add item revisions:

OR ( o.CMClosure = "Open" AND o.CMDisposition = "Investigate" AND
o.CMMaturity = "Reviewing")))

The second case allows the analyst to add item revisions to the Problem Items folder when:

• Closure is Open (o.CMClosure = ”Open”)

• Disposition is Investigate (o.CMDiposition = ”Investigate”

• Maturity is Reviewing (o.CMMaturity = "Reviewing“)

Restrict who can assign the analyst and when

Use the following condition to set that either the analyst or the change specialist can assign or reassign
the analyst and when.

isAnalystAssignable ( ChangeItemRevision o , UserSession u)

Then, define the following expression, so both the analyst and change specialist can assign the analyst
during the elaboration phase, but only the analyst can assign (that is, reassign) the analyst during the
review phase:

((u.user_id = o.change_analyst_user_id) 
AND 
((o.CMClosure = "Open“ AND o.CMDisposition = "None" 
     AND o.CMMaturity = " Elaborating“) 
OR 
(o.CMClosure = "Open" AND o.CMDisposition = "Investigate“ 
     AND o.CMMaturity = "Reviewing"))) 
OR 
((u.user_id = o.change_specialist1_user_id) 

Examples of Change Manager conditions
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AND 
(o.CMClosure = "Open" AND o.CMDisposition = "None" AND 
o.CMMaturity = " Elaborating"))

The expression does the following:

• First, it checks if the user logged into the session is the analyst assigned to the change object:

(u.user_id = o.change_analyst_user_id)

If the user is the analyst, it sets when that user can reassign the change object:

(o.CMClosure = "Open“ AND o.CMDisposition = "None" 
     AND o.CMMaturity = " Elaborating“)
OR 

(o.CMClosure = "Open" AND o.CMDisposition = "Investigate“ 
     AND o.CMMaturity = "Reviewing")

The change states for when the analyst can reassign the change object are:

• Closure is Open (o.CMClosure = ”Open”)

• Disposition is None (o.CMDiposition = ”None”)

• Maturity is Elaborating ((o.CMMaturity = " Elaborating“)

And:

• Closure is Open (o.CMClosure = ”Open”)

• Disposition is Investigate (o.CMDiposition = ”Investigate”

• Maturity is Reviewing (o.CMMaturity = "Reviewing“)

• If the user is not the analyst but the change specialist:

(u.user_id = o.change_specialist1_user_id)  

If the user is the change specialist, it sets when that user can assign or reassign the change object:

AND (o.CMClosure = "Open"  
     AND o.CMDisposition = "None" AND o.CMMaturity = " Elaborating"))

• Closure is Open (o.CMClosure = ”Open”)
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• Disposition is None (o.CMDiposition = ”None”)

• Maturity is Elaborating ((o.CMMaturity = " Elaborating“)

Note:

Change object modification is permitted only when CMClosure is set to Open.

Summary of default Change Manager conditions

The default rules generally apply to all types of change objects: problem report, engineering change
request (ECR), and engineering change notice (ECN):

• To add item revisions to the Problem Items folder:

Assigned participant Closure/Disposition/Maturity property settings

Requestor Open/None/Elaborating

Analyst Open/None/Elaborating

or

Open/Investigate/Reviewing

• To add any object to the Referenced Items folder:

Assigned participant Closure/Disposition/Maturity property settings

Requestor Open/None/Elaborating

Analyst Open/None/Elaborating

or

Open/Investigate/Reviewing

• To add item revisions to the Impacted Items folder:

Assigned participant Closure/Disposition/Maturity property settings

Analyst Open/None/Elaborating

or

Open/Investigate/Reviewing

• To add item revisions to the Solution Items folder (applies to ECN only):

Summary of default Change Manager conditions
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Assigned participant Closure/Disposition/Maturity property settings

Analyst Open/Approved/Executing

• To add a schedule to the Plan Items folder (applies to ECR or ECN only):

Assigned participant Closure/Disposition/Maturity property settings

Analyst None/Elaborating (default)/Reviewing

or

None/Investigate/Reviewing

• To propagate a change item to a schedule task folder:

Assigned participant Closure/Disposition/Maturity property settings

Analyst or Task owner None/Elaborating (default)/Reviewing

or

None/Investigate/Reviewing
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16. Managing the change process through
a workflow
About managing the change process through a workflow

Workflows guide a change through the different phases of a change process: authoring, review and
approval, execution, and closure. These phases are modeled as states of the change.

For example, a workflow process moves the Disposition attribute of a change from Investigate
to Approve. (Change states cannot be manually updated.) Using Change Manager with Workflow
Designer, therefore, tracks the evolution of changes through your organization according to a controlled,
repeatable process. In addition, you can:

• Tie a workflow to a scheduled task so as tasks are worked on and updated in Teamcenter workflow,
the information is sent to Schedule Manager where the corresponding information is updated. You
can also configure a Teamcenter scheduled task so the associated workflow can be initiated when
certain conditions are met.

• Set up a workflow to automatically assign review members from assigned participants by configuring
the workflow for dynamic participants.

To do this, you need to use the following workflow action handlers:

• The EPM-set-property handler to set the change state properties when they change during the
workflow.

• The EPM-auto-assign handler to assign the appropriate participant on the change object as the
responsible party for the current task.

These Change Manager preferences determine which workflows start when a change revision is
submitted:

Preference Change Object

ChangeNoticeRevision_default_workflow_template Change Notice Revision

ChangeRequestRevision_default_workflow_template Change Request Revision

ProblemReportRevision_default_workflow_template Problem Report Revision
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Note:

A default workflow process template is used when Submit is selected on the Create panel. For
a change revision submitted after creation, the default template is pre-selected for the matching
change type, making it easier to submit to the default workflow on pre-existing change revisions.

The following are three examples of workflows for a problem report, engineering change request, and
engineering change notice:

• Problem report (PR) process

• Engineering change request workflow

• Engineering change notice workflow

Tip:

Learn more:

• Work through a tutorial of creating an ECR workflow

• Create your own workflows using the Workflow Designer

• Set change states

• Initiate a workflow from a schedule task.

• Set dynamic participants.

Problem report workflow example

A typical process flow for managing problem report (PR) is shown in the figure. It includes the change
states at each stage and the participants assigned.

16. Managing the change process through a workflow
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Any user (whether internal or external) can raise a PR. The process steps through assigning participants,
identifying the root cause, and determining if a change is required. If a change is required, an
engineering change request (ECR) is derived from the PR to define the solution.

Note:

The PR process does not define the solution. Non-product solutions, such as resolving a user
error, may be resolved as part of the PR process. Expand the signoff outcomes of the Determine
Resolution condition task to accommodate these.

The PR workflow is shown next:

Problem report workflow example
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PR Properties

Properties exist on the PR to record the pertinent details. Automated branching based on the Priority or
Severity values can be added through a condition task, if required.

Problem report properties are:

Property Description LOV

CMEnvironmentDescription Describes the environment as it was
when the problem occurred. For
example, if the car door was open
and the car was moving in reverse.

None

CMSequenceOfEvents Describes what happened prior to the
problem occurring. Provides a guide
for reproducing the problem.

None

CMTechReviewPriority Provides guidance to the analyst
regarding which issues should be
addressed first. Values 1-4 are from
CMII, with 1 being the highest
priority. You may want to replace this
list of values with your own.

CM Tech Review
Priority (1,2,3,4)

CMVerification Describes how the problem was
verified

None

CMRamification Describes what may happen if the
problem is not resolved. For example,
increased incidence of customer
injury.

None

CMSeverityRating Indicates the severity of the problem.
For example, customer injury rates
a 1 (high) while a user manual
error rates a 4 (low). Values 1-4 are
from CMII, with 1 being the highest
severity. You may want to replace this
LOV with your own values.

CM Priority (1,2,3,4)

Process Participants

• Requestor

Initiates the PR.

• Change Specialist

16. Managing the change process through a workflow
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Administers/coordinates the PR. Assigns the Analyst.

• Analyst

The technical expert/lead. Evaluates and reproduces the problem. Identifies the root cause(s).

Process Template Detailed Notes

Ensure participants are assigned- Validate task

The EPM-check-object-properties rule handler is used with the arguments shown. If the attribute
ChangeSpecialist1 (on the PR, single target of the workflow) has a NULL value, the process exits along
the failure path to the Do task to assign the participant.

Note:

Choose the exit path [Set to Error Path] from the Validate task. Do not select [Set Error Code] as
this is not applicable in this case.

• The first Or branch sends the workflow to the Is Specialist Assigned? verification task, determining
whether a change specialist has been assigned.

• If the change specialist has not been assigned, the workflow sends the Assign Specialist do task to
the requestor to assign the change specialist.

• The workflow then branches back to the first Or task, which again sends the workflow to the Is
Specialist Assigned? verification task to verify that the specialist has been assigned.

• When the specialist is assigned, the workflow moves to the second Or task, which begins the same
process but this time to verify that the analyst is assigned and, if necessary, assigns the analyst.

• Workflow handlers

Problem report workflow example
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• The EPM-check-object-properties action handler checks that the value for ChangeSpecialist1 or
Analyst is not null.

Note:

As a best practice, the Assign Analyst task should be a separate task from the Assign
Specialist task. This task is auto-assigned to the Change Specialist participant type (now
populated).

• The EPM-auto-assign handler assigns the participants. The default value is REQUESTOR. Your
organization can change this to a dedicated group or role. For example, if a change management
group is CMII compliant and independent from the engineering department, process integrity is
ensured.

In this example, the participant type ChangeSpecialist1 is used. If you desire CMII compliance,
ChangeSpecialist2 and ChangeSpecialist3 are also provided. Contact your administrator.

In the Do task Assign Change Specialist, the assignee for the auto-assign handler is set to the
REQUESTOR

The EPM-auto-assign handler should be included in the Do task for all workflow templates
(Problem Report, Change Request, and Change Notice).

Note:

The check-condition handler is created automatically by the system. The argument on the
check-condition rule handler on the Assign Specialist Do task is set to any because the [Set
to Error Path] was used.

Table 16-1. Workflow Handlers for check and assign tasks

Task Handler Argument Value

Check whether the
change specialist is
assigned.

EPM-check-object
-properties

-type

-props

ProblemReportRevision

ChangeSpecialist1

Check for the analyst EPM-check-object-
properties

-type

-props

ProblemReportRevision

Analyst

Assign the specialist EPM-auto-assign -assignee $REQUESTOR

Assign the analyst EPM-auto-assign -assignee $CHANGE_SPECIALIST1

16. Managing the change process through a workflow
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Task Handler Argument Value

Note:

The handler produces an error if the
property is null.

Assign Analyst

The Change Specialist assigns the Analyst. This is controlled by BMIDE conditions.

Assign participants prior to starting the workflow process

If either (or both) the Change Specialist and Analyst are assigned to the PR prior to the workflow process
starting, the Validate task checks result in true (non-error) results and the PR progresses forward to the
reproduce problem step.

To assign participants prior to the workflow:

1. Select the PR revision.

2. Select Tools, Assign Participants, and Change Specialist.

3. If you assigned yourself as the Change Specialist, click Apply, assign the Analyst, and click OK.
The BMIDE condition specifies that only the Change Specialist can assign the Analyst, so that
assignment must be completed first. In a production setting, you would most likely edit the
condition to enable other users to assign the Analyst, as appropriate for your organization's
business rules.

If you did not assign yourself as the Change Specialist, click OK to exit the assignment, log in as the
assigned Change Specialist user, and assign the Analyst.

Reproduce the problem

The assigned analyst determines whether the problem can be reproduced (Reproduce the Problem
condition task) to validate it.

The analyst can choose the following paths:

• Need More Info branch - More Info do task

If the analyst needs more information from the requestor, this branch is selected.

Problem report workflow example
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Handler Set to

EPM-auto-assign $REQUESTOR

• Requestor cancels PR

The requestor may decide there is not a problem after all, or cannot provide the required information,
in which the [Unable to Complete] path goes to the Requestor cancels PR task, allowing the PR to
be terminated.

This is a Do task with a notify handler to inform the analyst, with no need for acknowledgment.

Property Set to

Closure Canceled

Disposition Disapproved

Maturity Complete

• Cannot reproduce the problem

If the analyst cannot reproduce the problem, the workflow sends the Inform Requestor acknowledge
task to the requestor. This task records the requestor’s acknowledgment.

Property Set to

Closure Canceled

Disposition Disapproved

Maturity Complete

• Analyze root cause, determine severity

The analyst performs this task, which is defined separately from the Reproduce problems task. In
a production setting, there may be different users producing the problem and identifying the root
cause. In some cases, the same user (the analyst) may perform both steps, in which case you can
combine them.

The analyst determines which business objects must be replaced or fixed. These objects must be
related to the PR as problem items. If any items are already related as such, the relationships can be
retained if the items truly need to be replaced, but should be removed if they do not.

Impacted items, items requiring revising to enable the replacement of problem items, are identified
during the CR process during the where used search of the impact analysis, and should not be
identified here.

16. Managing the change process through a workflow
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Note:

Manual condition tasks only differ from a Do task by allowing multiple exit paths to be defined.
Those exit paths can be given custom names, which appear as the signoff options.

Analyze the root cause and determine severity

The Analyst performs this task, defined as a separate task from the Reproduce Problem task. In a
production setting, different users may be reproducing the problem and identifying the root cause. The
analyst may perform both steps, in which case they can be combined.

The Analyst must determine which product business objects need to be replaced or fixed. These
business objects must be related to the PR as Problem Items. If any items are already related as such,
the relationships can be retained if the items must be replaced, but should be removed if they do not.

Impacted items (items that must be revised to enable the replacement of the problem items) are
identified during the CR process during the where-used search of the impact analysis and are not
typically identified here.

Determine the resolution

The change specialist performs the Determine Resolution condition task. The change specialist can
decide the following based on the analysis. There are 4 possible outcomes or exit paths:

Problem report workflow example
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Resolution Description

Resolve Continues to Notify Approved task.

Deferred Goes to the PR Deferred task, which sets the Disposition
property to deferred. Then it branches back to the
Determine Resolution task, where it remains in the Change
Specialist's inbox as a reminder.

Investigate Goes to the Investigate PR task for more research.

The task sets the Disposition property to investigate,
allowing the analyst to add items to the change folders
(Problem Items and Reference Items), or update the PR
properties.

Reject Goes to the Notify PR Rejected task. The requestor and
analyst are notified that the PR has been rejected. They do
not acknowledge the notification. The Disposition property
is set to disapproved on the following Or task.

• Approve the problem

The change specialist can approve the problem resolution (Resolve). The Resolve task sets the
Disposition property to Approved and notifies the requestor and analyst.

• Send it back for rework

If the change specialist determines more work is required (Investigate), the workflow returns to the
Investigate PR task for more research.

The task sets the Disposition property to Investigate, allowing the analyst to add items to the change
folders (Problem Items and Reference Items) or update the PR properties.

• Reject it

If the change specialist rejects the PR (Reject), the workflow moves to the Notify PR Rejected task.
The requestor and analyst are notified that the PR has been rejected. They do not acknowledge the
notification.

The Disposition property is set to Disapproved.

• Defer it

If the change specialist is undecided and wants to leave the decision for later (Deferred), the
workflow moves to the PR Deferred task, which sets the Disposition property to Deferred. Then
it branches back to the Determine Resolution task so it remains in the change specialist’s inbox as a
reminder.

16. Managing the change process through a workflow
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It also notifies the requestor and analyst that the PR is deferred.

Derive ECR and complete

If the change specialist resolves the problem report, a change request is derived from the PR (DeriveCR).

At the beginning of this task, the Maturity property is set to Reviewing, which is required for the ECR to
be derived. The following Business Modeler IDE rule controls this:

isCMImplementsCreatableForSecondary ( ChangeItemRevision o , UserSession 
u)

o.CMClosure = "Open" AND o.CMDisposition = "Approved" AND o.CMMaturity = 
"Reviewing"

After the ECR has been derived and starts its processing, the Maturity property is set to Executing to
indicate to observers that the PR is being resolved.

• Workflow handlers

The EPM-auto-assign handler automatically assigns the task to the change specialist.

• EPM-set-property sets the states noted in the task descriptions.

Engineering change request workflow example

A typical ECR process is shown in the figure. It includes the change states and the participants assigned
at each stage.

The following ECR workflow steps through the process of verifying that participants are assigned to
the workflow, identifying the impacted items, and generating and recommending a solution. The ECR

Engineering change request workflow example
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can follow either a fast or standard track. You can set a cost or other criteria threshold separately to
determine which track the ECR follows.

• If the change falls below the set threshold, the change follows a fast track.

Changes that follow a fast track are those with:

• Limited cost, typically requiring only revision changes.

• No interchangeability issues.

• Require little review.

The abbreviated ECR process is followed by an abbreviated ECN process to implement the change,
which no change implementation board review. The abbreviated ECR process is followed by an
abbreviated ECN process to implement the change with no change implementation board review.

• If the change exceeds the set threshold, the change follows a standard track and is reviewed by the
change review board.

Changes that follow a standard track use both a full ECR process with a review by the change review
board and a full ECN process with review by the change implementation board. The change also
requires an implementation plan.

An ECN is always derived to implement a solution, even for an ECR that went through a fast track
process. However, the workflow for the fast track ECN is very short, with a minimal number of steps, as
shown in this example. It is necessary to create an ECN so the analyst can add solution items, which is
not possible in the ECR, whose purpose is only to define a proposed solution. For example, a Solution
Items folder is not even associated with an ECR.

16. Managing the change process through a workflow
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Note:

It is technically feasible to configure an ECR to display the Solution Items folder and, therefore,
use it to implement a solution. However, this exposes the Solution Items folder for all ECRs, which
would not be applicable to standard track changes and would confuse users.

If after the workflow ends, an ECR is approved, a new or existing change notice (ECN) is derived.

The process flow of the Change Manager example workflow process for an ECR is:

• Perform impact analysis: how many and which parts are affected? This provides an early idea of cost.

• Propose one or more technical solutions so that the most cost-effective solution can be selected.

• Estimate the costs (initial and recurring), to assist the Change Review Board in making a decision.

• Progress to solve or reject.

Tip:

See a complete explanation of the change states an ECR goes through.

Change Request Properties

These CR-specific properties are available:

Property Description LOV

CMReason Provides a short name describing the
change reason. The LOV values come from
CMII. Organizations can usually identify
different types of changes (for instance,
safety or performance) processed on a
regular basis.

CM CR Reason

To fix, to prevent, to
improve.

CMProposedSolution The Analyst describes the recommended
technical solution in enough detail
to enable a cost-benefit decision. For
Standard Track changes, the Analyst may
attach other documents, BOM markups,
preliminary schedule, or any other item
necessary to describe the proposed
solution. Those items should be briefly
described here. This property is part of the
technical recommendation.

None

Engineering change request workflow example

Change Management ─ Deployment and Rich Client Usage, Teamcenter 2412  16-13
© 2025 Siemens



Property Description LOV

CMIsFastTrack Indicates whether the CR should be
processed as a Fast Track change.

CMII CR Fast Track

Yes, No

CMTechReviewPriority Provides guidance to the Change Review
Board and/or Technical Review Board (TRB).
Can be copied from the PR, or the Change
Specialist can set the value for the CRB or
TRB.

CM Priority

1,2,3,4

CMRecurringCost The estimate of the incremental costs of
the changed product.

None

CMNonrecurringCost The estimate of the total costs to
implement the change.

None

CMTechnicalRecommendation This property forms part of
the technical recommendation, in
addition to CMTestResultsAttached,
CMTechnicalReview, and
CMProposedSolution

CM Tech
Recommendation

Problem Confirmed,
Problem Not
Confirmed, Another
Problem

CMTestResultsAttached This property is part of the technical
recommendation, indicating whether
the Analyst has attached test results
documentation.

CM YesNo

Yes, No

CMTechnicalReview This property is not displayed by
default. Values 1-2 come from CMII. This
property should be part of the technical
recommendation

CM Tech Review

1 = Requestion
Solution is Acceptable;
2 = Another Solution is
Proposed

CMTechRecommDate Specifies the date of the recommendation. None

CMTimingFactors The CRB or Analyst may provide
requirements, opinions, or guidance to the
CIB regarding the setting of effectivity, and
therefor implementation timing, for the
change

None

Process Participants

• Requestor

Initiates the change.
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• Change Specialist

Administers/coordinates the change. Assigns the Analyst.

• Analyst

The technical expert or lead. Performs impact analysis and proposes the solution.

• Change Review Board (CRB)

Business managers to make the cost-benefit analysis and provide financial approval.

Workflow process template notes

Ensure participants are assigned - Validate task

The EPM-check-object-properties rule handle, with the arguments shown below, is used to validate
whether participants are assigned. If the attribute ChangeSpecialist1 (on the CR, the single target of
the workflow) has a null value, the process exists along the failure path to the Do task to assign the
participant.

The workflow starts by verifying whether this assignment has been completed using two Or branches as
was done for the PR. In this case, the branches verify and assign the change specialist, and the second
branch verifies and assigns the change analyst/change review board (CRB).
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Workflow Handlers for check and assign tasks

Task Handler Argument Value Notes

Check
whether
the
change
specialist
is
assigned.

EPM-check- object-
properties

-include_type

-property

ChangeNoticeRevision

Analyst

None

Check for
the
change
analyst
and
change
review
board
(CRB)

EPM-check- object-
properties

-include_type

-property

ChangeRequestRevision

ChangeReviewBoard

The handler produces an
error if either the analyst
or CRB properties have null
values.

The argument is
ChangeReviewBoard (not
$CHANGE_REVIEW_BOARD
as used in the auto-assign
handler.
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Task Handler Argument Value Notes

Assign
the
specialist

EPM-auto-assign -assignee

-source_task

$REQUESTOR

Is Specialist Assigned?

The auto-assign handler
should be included in the
Do task for all workflow
templates (PR, ECR, ECN).

Participant assignments are
not carried over from
the change object to the
derived change. The change
specialist must be assigned
for each new change object
(ECR, ECN). Typically, the
change specialist derives/
creates the ECR/ECN, and
assigns herself.

The EPM-check-condition
is created automatically by
the system.

Assign
the
analyst
and CRB

EPM-auto-assign -assignee $CHANGE_SPECIALIST1 The change specialist
assigns the analyst and
the CRB. The ability to
make these assignments
is controlled by BMIDE
conditions.

Assign participants prior to starting workflow process

If the Change Specialist, or the Analyst and CRB are assigned to the CR prior to starting the workflow
process, the validate task checks result in true (non-error) outcomes, and the CR automatically
progresses forward to the Identify Impacted Items, Propose Solution, Estimate Cost step.

To assign the participants prior to the workflow:

1. Select the CR revision.

2. Select Tools, and then Assign Participants, and assign the Change Specialist.

3. If you did not assign yourself as the Change Specialist, click OK to exist the assignment. Log in as
the assigned Change Specialist user and assign the Analyst and CRB.

4. If you did assign yourself as the Change Specialist, click Apply.

5. Assign the Analyst and CRB, and click OK.
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The BMIDE condition specifies that only the Change Specialist can assign the Analyst, so that
assignment must be completed first. In your organization, you would most likely edit the condition
to enable other users to assign the Analyst, as appropriate for your organization's business rules.

Identify impacted items, propose a solution, and estimate costs

The analyst assigned to the next task (Identify Impacted Items, Propose Solution, Estimate Cost do
task) identifies the impacted items and generates and determines a solution. The analyst elaborates
the change object by adding related objects to it, including creating markups on documents, Word
documents, presentations, and so on.

The analyst determines whether new objects (items) or simply new revisions are required with cost and
interchangeability implications. This must be clear to the engineer who later makes the changes. The
change review board can amend the solution.

Determine if the planning is complete and which track to follow

Once the analyst determines a solution, the workflow moves to the Planning Complete? condition task,
which is assigned to the change specialist who evaluates if the ECR is ready to move forward and on
which track (fast or standard).

The task has these possible outcomes or exit path:

• The plan is not complete – rework

The change specialist chooses this branch (Plan Not OK - Rework) if the analyst needs to add more
definition to the solution. The workflow returns to Identify Impacted Items, Propose Solution,
Estimate Cost task through the Or task. The analyst performs additional impact or other analyses as
required to fully define the proposed solution. The process returns the ECR to the change specialist at
the Planning Complete? task for another verification.

• The plan is not complete – reject

The change specialist closes PRs. Selecting this branch cancels the CR.

• The plan is complete and does not need review

The change specialist chooses the Plan OK – Fast Track branch if the change meets the fast track
criteria and is ready for implementation.

The workflow moves to the Derive CN task, where the change specialist derives an ECN from the ECR
and initiates the ECN fast track workflow process.

While an ECR may fit the fast track criteria, it is considered a best practice to follow it with an ECN,
especially for new or updated product data. In addition, at the ECN stage, it may be combined with
other changes for implementation. The result may or may not be a fast track ECN.
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• The plan is complete but needs review

(Plan OK – Standard Track)

The change specialist chooses this branch if the planning is complete and now can be reviewed by the
change review board. It moves to the CRB Review proposed solution task.

The ECR’s change states are updated to lock the ECR and its folders against change while it is being
reviewed:

• Disposition of  None

• Maturity of Reviewing

• The Reject path is followed if it is not approved. The workflow moves to the condition task Set
Change Review Board Decision. The change specialist records the CRB's desired outcome and sets
the path accordingly. This can be done by reviewing the signoff comments, phone or email survey,
or a meeting with the CRB to review the desired outcome.

You can have an approval from the condition task after a reject from the review. The reject may
not be a complete rejection – it could be an approval with comments. It also provides a second
opportunity for reviewers to change their minds, after discussion with the CRB.

There are several ways to model this:

1. The CRB meets offline, and the change specialist enters the decision - use only the condition
task with multiple outcomes.

2. The CRB meets online, and the change specialist only observes - use only the review task with
approve/reject outcomes. This can interpret 100% approval as approve, and 100% rejection as
reject, and any mix of those as requiring rework.

3. The CRB meets online, the change specialist reviews comments and enters the decision - using
both the review task and condition task. 100% approval from the CRB review is automatically
interpreted as approve.

At completion, the CR is updated to indicate to observers that the CR is being implemented (Maturity
of Executing. )

If all members of the change review board do not approve, the workflow moves to the Set Change
Review Board Result condition task.

• The start action of the Review tasks sets the Maturity to Reviewing. The CR is locked to prevent any
changes while it is in review.
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Handler Argument Value

EPM-set-property -property

-value

-to_attach

-include_type

-bypass

CMMaturity

Reviewing

target

ChangeRequestRevision

EPM-set-rule- based-protection -acl Vault

EPM-adhoc-signoffs -assignee

-auto_complete

-ce

$CHANGE_REVIEW_BOARD

You must specify a Workflow ACL to enable correct access to the attached items.

Use the adhoc-signoffs handler with the assignee $CHANGE_REVIEW_BOARD to assign the members
of the CRB automatically.

Assign the CRB to perform the signoffs. In the following example, the participant type Change Review
Board is used.

• Who should be assigned to the CRB?

A number of groups can be created in the organization to contain the members of the CRB for
different types of review; for instance standard, safety impact, and so forth. One of these groups is
assigned as the CRB participant type.

Another approach is to assign a number of users to the Change Management group, with role CRB,
and then assign those members as appropriate to the Change Review Board participant.

Note:

The CRB participant can have multiple users (indicated by the double head icon).

Set Change Review Board Result

This is automatically assigned to the change specialist. The condition task has three possible outcomes
or exit paths:

1. Approve

Continues to the Notify CR Approvedtask.
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2. Rework

Rework path goes to a task that sets the Disposition to Investigate, and then back to the Identify
Impacted Items, Propose Solution, Estimate Cost task. This allows the analyst to add items to the
change folders Problem Items, Reference Items, and Impacted Items.

3. Reject

Continues to the Identify Impacted Items, Propose Solution, Estimate Cost task.

Notify CR approved

Notify and set the Disposition state to Approved and Maturity to Reviewing. BMIDE rules will not allow
objects to be added to the change.

Handler Argument Value

EPM-notify -recipient

-subject

-attachment

$REQUESTOR, $ANALYST

CR Approved

target

EPM-set-property -property

-value

-to_attach

-include_type

-bypass

CMMaturity, CMDisposition

Reviewing, Approved

target

ChangeRequestRevision

Notify CR Rejected

Notify requestor and analyst; set CMClosure = Canceled , CMDisposition = Disapproved and
CMMaturity = Completeusing the EPM-set-property handler.

Handler Argument Value

EPM-notify -recipient

-subject

-attachment

$REQUESTOR, $ANALYST

CR Rejected

target

EPM-set-property -property

-value

-to_attach

-include_type

CMClosure, CMDisposition, CMMaturity

Canceled, Disapproved, Complete

target

ChangeRequestRevision
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Handler Argument Value

-bypass

Derive the change notice

The Change Specialist chooses this branch if the change meets fast track criteria and is ready for
implementation.

For a fast track, the change specialist derives an ECN from the ECR and initiates the ECN workflow
process. For a standard track, the creation occurs after the Change Review board has approved the ECR
(Derive CN). For a fast track, the creation occurs after the change specialist has approved that the ECR
follow a fast track (Derive CN, Start CN, Fast Track).

At the beginning of either task, the ECR state is updated so the ECN can be derived controlled by BMIDE:

isCMImplementsCreatableForSecondary ( ChangeItemRevision o , UserSession u)
o.CMClosure = "Open" AND o.CMDisposition = "Approved" AND o.CMMaturity =
"Reviewing"

• In the start section

Handler Argument Value

EPM-auto-assign -value $CHANGE_SPECIALIST

EPM-set-property -property

-value

-to_attach

-include_type

-bypass

CMDisposition, CMMaturity

Reviewing, Approved

target

ChangeRequestRevision

EPM-adhoc-signoffs -assignee

-auto_complete

-ce

$CHANGE_REVIEW_BOARD

At the end of the process, after the change notice has been derived and started its processing, the ECR
state is updated to indicate to others that the ECR is being implemented: Maturity of Executing.

Handler Argument Value

EPM-set-property -property

-value

CMMaturity
Executing
target
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Handler Argument Value

-to_attach

-include_type

-bypass

ChangeRequestRevision

Close PRs

The change specialist performs this task manually. EPM-set-property can be automated to close
implemented PRs if your organization has implemented this feature.

In the instance where the CR is to be canceled: Any PRs that are in the implements list of other open CRs
should be removed from the implements list of this CR. Any remaining PRs in this CR’s implements list,
that need closing, should be submitted to a PR workflow that will close them.

Handler Argument Value

EPM-auto-assign -value $CHANGE_SPECIALIST1

EPM-set-property -property

-value

-to_attach

-include_type

-bypass

CMClosure, CMDisposition, CMMaturity

Canceled, Disapproved, Complete

target

ChangeRequestRevision

EPM-adhoc-signoffs -assignee

-auto_complete

-ce

$CHANGE_REVIEW_BOARD

This task sets the following CR states: Closure = Canceled, Maturity = Complete, Disposition =
Disapproved

Engineering change notice fast track workflow example

A typical fast track engineering change notice (ECN) process is shown in the figure. It includes the
change states and the participants assigned at each stage.
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The workflow to implement this process is shown in the next figure.

The workflow steps through the process of verifying that participants are assigned to the workflow,
implementing the change, and verifying its implementation through an audit. When the implementation
is complete, the workflow closes the ECNs, associated problem reports (PRs), and engineering change
requests (ECRs).

A fast track ECN provides a quick and controlled change process that can be audited. An analyst usually
performs this when the cost of the change is below a company’s set threshold. Therefore, you should
have a preceding ECR process and object whose purpose is to define the cost and the proposed solution,
and determine the appropriate processing track.

The analyst typically owns the items requiring change (in CMII terms, the analyst is the creator), and can
modify and release them without additional approval (CMII rules for a fast track process).

The change specialist monitors the fast track process and performs the final audit.
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Note:

The fast track ECN process does not include setting a planned effectivity. If you need to set
effectivity, use a standard track process. The actual effectivity is set as-needed at the Set Status
Released task.

The process flow for the Change Manager example workflow process for an ECN fast track is:

• Start the workflow and assign participants

• Develop the implementation plan

• Is planning complete?

• Notify plan approved

• Set Planned Effectivity

• Execute Implementation Plan

• Notify ECN Rejected

• Set Disposition to Investigate

• Perform the change tasks and create supersedure

Process Participants

• Requestor

Initiates the ECN.

• Change Specialist

Administers/coordinates the change. Assigns the analyst.

• Analyst

The technical expert/lead. Performs the change tasks.

Start the workflow and assign participants

Participant assignments are not carried over from the change object to the derived change. Therefore,
the change specialist needs to be assigned for each new change object (either an ECR or an ECN).
Typically, the change specialist derives or creates the ECR or ECN, and therefore, would assign
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themselves as change specialists. They can do this because they have write access as owners of the
object. However, the Business Modeler IDE conditions must also be met (the creator must be in the
Change Management group).

The workflow starts by verifying whether this assignment has been completed using two Or branches as
was done for the PR. In this case, the branches verify and assign the change specialist, and the second
branch verifies and assigns the analyst.

Workflow handlers

• The EPM-check-object-properties action handler checks that the ChangeSpecialist1 is assigned. If it
is not, the workflow is routed to a task requesting its assignment.

• The EPM-auto-assign handler assigns the participants.

Workflow Handlers for check and assign tasks

Task Handler Argument Value

Check whether
the change
specialist is
assigned.

EPM-check-object-properties -include_type

-property

ChangeNoticeRevision

ChangeSpecialist1

Assign the
Change Specialist
1 participant on
the ECN revision.
Complete task
when assignment
is done.

EPM-auto-assign -assignee $REQUESTOR

Check for the
analyst

EPM-check-object-properties -include_type

-property

ChangeNoticeRevision

Analyst

Assign the
analyst

EPM-auto-assign -assignee $CHANGE_SPECIALIST1
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Task Handler Argument Value

Note:

The handler produces
an error if the
property is null.

Assign participants prior to starting workflow process

If the Change Specialist, or the Analyst and Change Implementation Board (CIB) are assigned to the ECN
prior to starting the workflow process, the validate task checks result in true (non-error) outcomes, and
the ECN automatically progresses forward to the Change Implementation Board (CIB): Review Plan
step.

To assign the participants prior to the workflow:

1. Select the ECN revision.

2. Select Tools, and then Assign Participants, and assign the Change Specialist.

3. If you did not assign yourself as the Change Specialist, click OK to exist the assignment. Log in as
the assigned Change Specialist user and assign the Analyst and CIB.

4. If you did assign yourself as the Change Specialist, click Apply.

5. Assign the Analyst and CIB, and click OK.

The BMIDE condition specifies that only the Change Specialist can assign the Analyst, so that
assignment must be completed first. In your organization, you would most likely edit the condition
to enable other users to assign the Analyst and CIB, as appropriate for your organization's business
rules.

Develop implementation plan

The implementation plan can take several forms. Typically, the simplest changes are outlined in the
Description property. More complex changes can be handled by creating a schedule (using Schedule
Manager) and relating it to the ECN using the Plan Items relationship. Ad-hoc schedules can be created
to meet the requirements of each individual ECN, or they can be copied from a schedule template.
Schedule templates provide a pre-defined schedule of tasks established for changes of a specific type.
When you plan the implementation for such a change, start with the corresponding schedule template.
Any number of schedules can be defined and related to the ECN.

The schedule has tasks for each discipline (or user) to create new revisions or items, and make the
changes to implement the proposed solution. Depending on the change work, you may have one task

Engineering change notice fast track workflow example

Change Management ─ Deployment and Rich Client Usage, Teamcenter 2412  16-27
© 2025 Siemens



per assignee covering the changes for any number of items assigned to that user, or you may have one
task per problem item or impacted item, or any other work breakdown style you choose.

each schedule task has a small workflow to manage the execution of the task and to route the task
and related objects to the assignees. Such a workflow may include tasks to approve the changes made
to each item revision, or such validation can be left to a later step. This applies a status such as
pre-released.

Note:

If you use a schedule with the change items, the workflow associated to the schedule tasks must
use the EPM-set-rule-based-protection handler with the Task Single Assignee Write ACL to
enable impacted item revision.

For example, in the following illustration, the schedule for ECN 123 was crated from a standard schedule
template, and then modified to meet the ECN's requirements (copying the update mechanical piece
parts task for Bill and Laura). Each task has the same small workflow template attached, routing the
tasks to the assignee (Bill), routes to a review of the resulting items, and then adds a status to the
resulting items.
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The approach over the span of tasks includes:

• Apply the status PreReleased to the ECN, so planned effectivity can be set.

• Attach the Solution Items as targets of the workflow process.
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• Apply the PreReleased status (already created by the create-status handler and attached to the root
workflow task) to the solution items when approved. The solution items will share the same status
object as the ECN, and have the same effectivity.

• Finally rename the status on the ECN and solution items to Released once the overall ECN has been
audited.

This approach means that all of the solution items share the same status and effectivity, and will be
implemented at the same point. Any subsequent updates to the effectivity on the ECN automatically
apply to all the solution items.

The release status on the solution items is important for structure configuration. The following diagram
illustrates this approach:

Workflow handlers

• Workflow handlers

The EPM-set-status handler removes any status objects from the ECN that were carried into this task
from an earlier loop through this workflow process, or from an earlier workflow process. If this is the
first time through this task, this handler has no affect.

• The EPM-remove-objects handler removes all workflow attachments that were carried into this task
from an earlier loop through this workflow process or from an earlier workflow process, leaving only
the ECN. If this is the first time through this task, this handler has no affect.

• The EPM-auto-assign handler assigns the task to the analyst.

• The EPM-set-rule-based-protection handler is required to enable the analyst to sign off the task,
triggering the attachment of the related items. The related items are actually modified by the
attachment to the workflow. Therefore, write access is required. It also requires an appropriate ACL.

After the change has been executed, the solution items and any other items related to the ECN are
attached to the workflow task to enable easy management of status objects and effectivity.
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• The EPM-attach-related-objects handler attaches related objects to the ECN in the Complete action
portion of the task. For example:

-relation=IMAN_specification
-attachment=target

Or

-relation CMHasSolutionItem

-attachment target

Therefore, when the status is applied in the next task (Audit Change), it is added to the solution
items.

Note:

The same status object is shared with the ECN and all of its resulting items. Any effectivity added
to the status object applies to all of the resulting items equally. In addition, if the status object is
changed or deleted, all of the resulting items are affected equally. Therefore, all the solution items
share the same status and effectivity, and are implemented at the same point. Also, any updates to
the effectivity on the ECN automatically apply to all the solution items.

Therefore, all the solution items share the same status and effectivity, and are implemented at the
same point. Also, any updates to the effectivity on the ECN automatically apply to all the solution
items.

Is planning complete?

This task is assigned to the change specialist, who evaluates whether the ECN is ready to move forward.
The condition task has four possible outcomes/exit paths:

• Plan OK- standard track (if CIB review is necessary)

• Plan OK- fast track (if CIB review is unnecessary)

• Plan Not OK- rework

• Plan Not OK- reject

Notify plan approved

If the plan is approved, a notify handler is used to avoid a required acknowledgment. The Notify Plan
Approved task sets the disposition to approved. This is set on the Start action, so resulting items can be
added to the Solution Itemsfolder.
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Handler Argument Value

EPM-set-property -property

-value

-to_attach

-include_type

-bypass

CMDisposition

Approved

target

ChangeNoticeRevision

Set Planned Effectivity

The Set Planned Effectivity task sets the Maturity to Executing. This is set on the Start action so
resulting items can be added to the Solution Items folder.

Handler Argument Value

EPM-set-property -property

-value

-to_attach

-include_type

-bypass

CMMaturity

Executing

target

ChangeNoticeRevision

Execute Implementation Plan

The analyst is responsible for executing the change, creating solution items, and revising impacted
items. The analyst can in turn make the changes or delegate to other team members. Since this is a fast
track change, it is typically performed by the analyst.

Workflow handlers

• The EPM-set-status handler is used to remove any status objects from the ECN that were carried into
the task from an earlier loop through workflow process execution, or from an earlier workflow process
execution. This handler has no effect if it is the first time through this task.

• EPM-remove-objects is used to remove all workflow attachments that were carried into this task from
an earlier loop through this workflow process execution, or from a previous workflow process. This
handler has no effect if it is the first time through this task.

• EPM-auto-assign assigns the analyst to implement the change.

• EPM-set-rule-based-protection is required to enable the user to sign off the task, triggering the
attachment of the related items. The related items are modified by the attachment to the workflow, so
write access is required.
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Handler Argument Value

EPM-set-status -action delete

EPM-remove-objects -keep_targets ChangeNoticeRevision

EPM-auto-assign -assignee $ANALYST

EPM-set-rule-based-protection -acl Task Single Assignee Write

After the change is executed, the solution items and any other items related to the CN are attached to
the workflow task. This enables easy management of status objects and effectivity.

Note:

This implementation approach takes advantage of sharing the same status object with the CN and
all of the resulting items. Any effectivity added to the status object applies to all of the resulting
items equally. If the status object is changed or deleted, all of the resulting items are affected
equally.

Handler Argument Value

EPM-attach-related-objects -relation

-attachment

CMHasSolutionItem

target

EPM-attach-related-objects -relation

-attachment

IMAN_specification

target

EPM-attach-related-objects -relation

-attachment

TC_Attaches

target

The task is assigned to an analyst who manages the execution. If a schedule was created, the plan is
executed. The schedule automatically executes the tasks once the first task is started by the analyst.

Notify ECN Rejected

This is an automatic task, using the notify handler to inform the analyst and requestor participants that
the ECN is rejected.

• Closure = canceled

• Maturity = complete

• Disposition = disapproved
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Handler Argument Value

EPM-set-property -property

-value

-to_attach

-include_type

-bypass

CMClosure, CMMaturity, CMDisposition

Canceled, Complete, Disapproved

target

ChangeNoticeRevision

Set Disposition to Investigate

This task uses the EPM-set-property handler to set the disposition to investigate. This allows the analyst
developing the plan to change the implementation plan for the change notice, or add a new plan.

Handler Argument Value

EPM-set-property -property

-value

-to_attach

-include_type

-bypass

CMDisposition

Investigate

target

ChangeNoticeRevision

Set Planned Effectivity

The change specialist sets the planned effectivity, using the following rules:

• You must be assigned as the change specialist for the ECN

• The ECN revision must have an attached status object.

• The Disposition state must be set to Approved.

• The ECN Maturity state must be set to Reviewing.

These rules can be adjusted by updating the BMIDE conditions.

On the start action, the EPM-set-status handler attaches the status object to the ECN (already the
process target).

The change specialist sends the ECN to the Change Manager application and opens the Change
Effectivity tab. The planned effectivity can be set on the status object. Once the effectivity is set, the
Maturity state is set to Executing.
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Handler Argument Value

EPM-set-status -action replace

EPM-set-property -property

-value

-to_attach

-include_type

-bypass

CMMaturity

Executing

target

ChangeNoticeRevision

Perform the change tasks and create supersedure

After the change tasks are complete, if a BOM has been changed, each task assignee should create
supersedure records for their parts of the change.

1. Receive the ECN in My Worklist.

2. Send the ECN to Change Manager.

3. Select the impacted item; RMB > Revise Impacted Item. This revises the item to the next revision
and pastes it into the solution items folder.

4. If the replacement item is already in the solution items folder, copy the replacing item revision.

5. Select the new solution item; RMB > Open in Structure Manager with Supersedure Window.

6. In Structure Manager, select the problem item to be replaced.

7. Click Edit > Replace to replace the existing item with the replacing item.

8. Save the BOM changes.

9. Select the problem item in the left window and the replacing item in the right window. Click the
Create Supersedure icon.

• The supersedure is created, where you can expand to see the adds and cancels.

• If a message appears indicate that no problem item exists, click Yes.

• If a message appears indicating you must update the BOM changes outside of Change Manager,
click Yes.

• If you receive an error, close Structure Manager and reopen it from Change Manager (repeat step
5).

Engineering change notice fast track workflow example
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10. Go to Change Manager and select the ECN.

11. Select BOM Changes and expand to see the adds and cancels.

12. Go to My Worklistto sign off your task.

Designing the workflow for loops

Workflow loops must be designed so that they behave correctly after a reject or retry loop, for instance,
when the task is executed for a second time. Care must be taken when attaching the release status
object and related solution items. Workflow handler order is important:

The logic is as follows:
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Before executing the change tasks, all status objects are removed from the workflow targets, including
both the ECN and any of its related items (for example, solution items). Then the related items are
removed from the workflow and are no longer targets. At this time, change tasks can be performed.
Once they are complete and the user has signed off the task, the related items are attached to the
workflow as targets.

The results of the change are reviewed for completeness, and if approved, they are given
PreReleasedstatus, along with the ECN. If they are disapproved, they return to step 1 where the
status object is removed and the targets are reset to the ECN. The EPM-create-status handler for the
PreReleased status is placed on the root task, start action, so that the status object is only created once.

The results of the change are reviewed for formal release and if approved, they are given Released
status, along with the ECN. Any effectivity settings are retained. If disapproved, they return to step 1,
where the status object is removed and the targets are reset to the ECN.

Note:

Attaching and detaching items to the workflow do not affect the relationships to the ECN.
Relationships are manipulated by the users performing their assignments.

PreRelease design changes and audit changes

These tasks are assigned to the change specialist. The specialist checks to ensure that the change
should have been solved through a fast track process. This is in addition to the safety checks against
the inappropriate use of the fast track process provided in the ECR process where the change specialist
validates the criteria before the change review board review, and when the change specialist derives the
fast track ECN from the ECR. The EPM-auto-assign handler is set to the change specialist.

Engineering change notice fast track workflow example
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Set Effectivity and Release ECNs and SIs

In your organization, this task may be performed by the lead designer or a checker. Since this is a fast
track change, the analyst could check her own work, but a designated user is beneficial.

This task renames the ECN and solutions status from PreReleased to Released and retains the
effectivity. The specialist can change the effectivity and implements relations. Upon task completion
the ECN and its Implements ECRs, and their Implements PRs are closed.

Handler Argument Value

EPM-set-status -action

-status

-new_status

rename

PreReleased

Released

EPM-set-property -property

-value

-to_attach

-include_type

-bypass

CMMaturity

Executing

target

ChangeNoticeRevision

The EPM-set-status handler can also set the status object effectivity automatically, using the
set_effectivity argument. By itself, it sets the effectivity as an open-ended date effectivity with the
start date set to the time of execution. If it is used with the retain_release_date argument, the original
release data of the target object is retained and used as the start date for the effectivity.

This task sets Maturity to Complete.

Handler Argument Value

EPM-set-property -property

-value

-to_attach

-include_type

-bypass

CMMaturity

Complete

target

ChangeNoticeRevision

Upon task completion, the ECN, its Implements CRs and their Implements PRs are closed.

The EPM-attach-related-objects handler automatically attaches the related objects with the
Implements relation.
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Handler Argument Value

EPM-attach-related-objects -attachment

-include_related_type

-relation

target

ProblemReportRevision

CMImplements

EPM-set-property -property

-value

-to_attach

-include_type

-bypass

CMClosure

Closed

target

ChangeNoticeRevision,

ChangeRequestRevision,

ProblemReport

Engineering change notice standard track workflow example

The Engineering Change Notice (ECN) process is performed by the analyst who is responsible for
developing an implementation plan, possibly using a schedule to plan all the tasks. The change does not
fit Fast Track criteria, so the change implementation board (CIB) must approve the plan.

Note:

Fast Track criteria are defined by your organization.

The objectives of the ECN process are to:

• plan and implement the change within the budget agreed on the change request.

• set the effectivity for the deployment of the new configuration.

• Release the resulting items from engineering to downstream processes such as manufacturing.

The workflow looks as follows:

Engineering change notice standard track workflow example
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ECN Properties

The following ECN-specific properties are available:

Property Description LOV

CMImplPriority Provides guidance to the analyst regarding
the relative priority of implementing this
change

CM Priority

1, 2, 3, 4

CMSpecialInstruction The CIB can record any special instructions
to the analyst and implementation team

None

CMIsCustApprovalRequired Indicates if one or more customers must
approve the change.

CMSpecialInstruction

None

CMStatusOfCustApproval Indicates whether the customers have
approved or disapproved.

CMDateOfCustApproval

None

CMDateofCustApproval The date the customer approved or
disapproved.

None

Process Participants

• Requestor

Initiates the ECN.

• Change Specialist

Administers/coordinates the change. Assigns the analyst.

• Analyst

The technical expert/lead. Performs the change tasks.
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• Change Implementation Board (CIB)

Operations managers to make the implementation analysis and provide approval.

Process template detailed notes

The standard track contains three specific tasks that differ from the fast track: the specialist makes
assignments to the CIB, the CIB reviews the plan, and the specialist sets the result of the CIB review. The
remaining tasks are outlined in the Fast Track section.

CIB Assignments

The Change Implementation Board (CIB) participant assignments are checked, and if empty, the user is
prompted to assign them.

Handler Argument Value

EPM-check-condition -source_task

-decision

Specialist: Is Planning Complete?

Plan OK- Standard Track

Change Implementation Board Review Plan

The Start action sets Maturity to Reviewing and the CIB reviews the plan.

The CIB is assigned using the select-signoff-team task using the adhoc-signoffs handler. If all members
approve, the approve path continues to the notify plan approved task. If all members do not approve,
the reject path continues to the set change CIB result condition task for a meeting to be held. The ECN
maturity is set to reviewing.

Handler Argument Value

EPM-set-property -property

-value

-to_attach

-include_type

-bypass

CMMaturity

Reviewing

target

ChangeNoticeRevision

Set Change CIB Result

This task has the CIB review the signoff comments, polls the CIB members or convene a meeting. The
EPM-auto-assign handler assigns it to the change specialist. The change specialist then calls a meeting
of the CIB to determine how to proceed. Three paths are available:

Engineering change notice standard track workflow example
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• Approve. Continue to the Notify Plan Approved task.

• Reject. Go to the Notify CN Rejected task.

• Rework. Go to the Set Disposition: Investigate task and back to the Develop Implementation Plan
task.

BMIDE configuration

You may want to update the BMIDE conditions governing Change Manager behaviors to reference the
groups and roles configured in your organization.

States

States apply to a specific change object, not the overall process, and control what can be done with
relations to that objects.

These properties can only be changed using the EPM-set-property handler in workflow.

State Description

Closure Open or closed: Open, Closed, Canceled, On Hold

Maturity Stage of process: Elaborating, Reviewing, Executing, Complete

Disposition Decision: None, Approved, Disapproved, Investigate, Deferred.

Licensing

Any user, whether consumer or author, can create a PR. Only authors can create an ECR or ECN.

Business Rules

Business rules control which users can add information to a change and at what change in the change
process.

BMIDE conditions

Change Manager installs a set of BMIDE conditions defining specific rules to control access to change
objects and their relationships.

Condition to control ECN derivation

To create the Implementsrelation for an ECR to ECN, the conditions state that Maturity must be
Reviewing.

16. Managing the change process through a workflow
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The Implements relationship is defined with the implementing change item (the ECN) as the primary
item and the implemented change item (the ECR) as the secondary item. The secondary item in the
relationship controls when the CN can be derived from the ECR.

The primary controls the LHS: ECN- Implements ECR

The secondary controls the RHS: CR- Implemented By CN

isCMImplementsCreatableForSecondary ( ChangeItemRevision o , UserSession u)
o.CMClosure = "Open" AND o.CMDisposition = "Approved" AND o.CMMaturity = "Reviewing"

Condition to Control CN Implements Relationship

This condition controls who, on the change item, can create the Implements relation to another change
item (for instance, add an ECR to an ECN).

isCMImplementsCreatableForPrimary ( ChangeItemRevision o , UserSession u)
(Condition::isRequestor(o, u)  AND o.CMClosure = "Open" AND o.CMDisposition = "None" AND 
o.CMMaturity = "Elaborating")  
OR (Condition::isChangeSpecialist1(o, u) AND ((o.CMClosure = "Open" AND 
o.CMDisposition = "None" 
AND o.CMMaturity = "Elaborating")  OR (o.CMClosure = "Open" AND 
o.CMDisposition = "Investigate" 
AND o.CMMaturity = "Reviewing")))

You can be the requestor of the ECN, or the change specialist of the ECN. The ECN must have these
values:

• Closure = Open

• Disposition = None

• Maturity = Elaborating

The ECR must have these values:

• Closure = Open

• Disposition = Approved

• Maturity = Reviewing

Condition to control ECN solution items relationship

To add item revisions to the solution items folder (applies to ECN only):

Cm0isCMHasSolutionItemCreatableForPrimary ( ChangeItemRevision o , UserSession u)
(o.is_modifiable = true) AND Condition::isChangeExecutionAllowed(o, u)

BMIDE conditions
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isChangeExecutionAllowed ( ChangeItemRevision o , UserSession u)
( Condition::isAnalyst(o, u) OR o.fnd0IsParticipant("Cm0ChangeContributors") ) 
AND o.CMClosure = "Open" AND o.CMDisposition = "Approved" AND 
o.CMMaturity = "Executing" 
AND u.fnd0ConditionHelper.fnd0isSubTypeOf(o, "ChangeNoticeRevision")

You must be the analyst of the ECN, and the ECN must have these values:

• Closure = Open

• Disposition = Approved

• Maturity = Executing

Rules to control change item property edits

Under most circumstances, the ability to check out and edit the properties of a change item is controlled
by the same BMIDE conditions controlling the creation of the change items. For example:

isChangeNoticeCreatable (UserSession u) Condition::isTrue()

Note:

BMIDE conditions prevent edits to a change item having a disposition of approved, with one
exception. The owning user and owning group have write access, regardless of the values of the
Closure, Maturity and Disposition properties.

Workflow

Workflow tasks generally give access to the target objects to the responsible party of the workflow task.
In these workflow templates, most task assignments are to the dynamic participants of the change item.
Usually this is enough, but in some cases specific access is granted to the change item or related items
by workflow ACLs applied using the EPM-set-rule-based-protection handler.

Managing change management folders through a workflow

Folders under change objects (such as engineering change notices, problem reports, and engineering
change requests) contain items that are related to the objects of that type.

For a listing of the folders and the objects in them, see About relating objects to a change.
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The relation Does the following

CMHasImpactedItem Relates the ChangeItem object (such as ProblemReport, ChangeRequest,
and ChangeNotice) to impacted item revisions.

CMHasProblemItem Relates the ChangeItem object (such as ProblemReport, ChangeRequest,
and ChangeNotice) to problem item revisions.

CMHasSolutionItem Provides for the traceability of the deliverable that results from the
execution of the product plan by relating ChangeNotice objects to a
solution item.

CMHasWorkBreakdown Provides for work breakdown relations.

CMImplements Allows ProblemReport objects to be implemented by ChangeRequest
objects, and ChangeRequest objects to be implemented by ChangeNotice
objects. It is used for navigating change resolutions.

CMReferences Allows problem reports, change requests, and change notices to reference
items and datasets.

Relates the ChangeItem object (such as ProblemReport, ChangeRequest
and ChangeNotice) to impacted item revisions.

Example

During a workflow process, the EPM-attach-related-objects handler is used to add the items and takes
a -relation argument. 

Argument Values

-relation CMHasSolutionItem

-attachment target

Managing change management folders through a workflow
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17. Scheduling implementation activities
About scheduling implementation activities

Schedule Manager is integrated into Change Manager so you can use it to schedule implementation
activities (work breakdowns) associated with a change. The Plan Items folder stores the work
breakdowns. Creating work breakdowns are useful to:

• Analyze the impact of the change to determine the amount and scope of the work required for the
change. It can also identify the parts and documents impacted by the change.

• Plan the implementation of the change to specify the actions, or tasks, that address the change.

Example of a schedule work breakdown

Whether you create a work breakdown and define tasks depends on the complexity of the change and
the conventions at your site. A simple change request, for example, may require relationships only to
affected parts, affected documents, and supporting information, while a more complex change requires

Change Management ─ Deployment and Rich Client Usage, Teamcenter 2412  17-1
© 2025 Siemens



information about subassemblies or other components that only becomes clear after detailed analysis.
In addition, during the change creation, you may not know what other items must be added until the
tasks are built and executed.

Schedules can be created in an ad-hoc manner to meet the requirements of each individual change
object, or they can be created (copied) from a schedule template. A schedule template is a pre-defined
schedule of tasks that is established for changes of a specific type. When you plan the implementation
for such a change, you start with the corresponding schedule template. Any number of schedules can be
defined and related to a change object.

The schedule can have tasks for each discipline or user to create new revisions or items and then make
the changes to implement the proposed solution. Depending on the change work to be done, you could
have one task per assignee that covers the changes for any number of items assigned to that user, or
you could have one task per problem item or impacted item, or any other style of work breakdown you
choose.

Because schedule tasks are not routed to users, it is good practice to have a simple one-step workflow
task associated with each schedule task, as shown in the figure. The workflow routes the schedule task
to the assignee’s inbox and manages the implementation of the task. The resource associated with the
schedule task is automatically assigned as the user to perform the workflow task. If more than one user
is assigned to the schedule task, the single privileged user is assigned to the workflow. The workflow
could include tasks to approve the changes made to each item revision, or this type of validation can be
left to a later step (a later task in the schedule or a later workflow task in the ECN workflow). This would
apply a status (for example, Pre-Released).

Flexibility of schedules

The advantage of a schedule is its flexibility. A schedule can easily be made larger or smaller, depending
on the need. By contrast, workflows are much more rigid as they control the process and decision-
making authority. Workflows should be kept simple, and schedules used when more complexity is
required. Typically schedule templates are used to make defining the schedule for a particular ECR or ECN
much quicker.

An analyst usually creates a work breakdown schedule, but another type of user can create it, and the
analyst can then relate the schedule to the change object through the Plan Items or Work Breakdown
relationship.

Example of a schedule work breakdown

The following is a simple example of a work breakdown for an engineering change notice (ECN 123).
The work breakdown was created based on a standard schedule template (shown in the figure with
dashed lines). The schedule was then modified to meet the ECN’s requirements, creating copies of the
Update Mechanical Piece Parts task for the two designers involved (Bill and Laura). Each of those tasks
has the same small workflow template attached, which routes the task to the assignee (for example,
Bill), then routes it for review of the changed and new items, and finally adds a status to them.

17. Scheduling implementation activities
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Work Breakdown Schedule Manager view

You use the Work Breakdown Schedule Manager view to display the structure of the schedule and task
breakdown or modify or create a new one. Schedule Manager must be installed to see this view.

Work Breakdown Schedule Manager view
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1 Schedule Manager view Lists all the work breakdown tasks created in the schedule.

2 Open Task view Displays the change folders associated with the task:

• ImpactedItems

• ProblemItems

• ReferenceItems

• SolutionItems (ECN only)

You can add items to the change folders and quickly
propagate the folders.

After a task is complete, you can roll the change items in
the task folders to the change object folders.

3 Roll Up view Provides viewing of the entire work breakdown structure at
a glance, letting users see the contributions from the tasks.

You can then roll these tasks up to the change object,
saving you from having to relate them manually. For
example, you can roll up the item revisions in your task
folders to the change object folders. Once the change is
complete, you can make the rolled-up objects permanent
by committing them.
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Create a work breakdown using Schedule Manager

Note:

You can copy an existing schedule, but it can only be associated with one change object.

1. Select the Plan Items folder of the engineering change request (ECR) or engineering change notice
(ECN) for which you want to create a work breakdown.

For an ECR or ECN, you can add objects to the Plan Items folder if you are an assigned participant
and the change object property settings are as follows.

Assigned
participant Closure Disposition Maturity

Analyst Open

or

None Elaborating

Open Investigate Reviewing

2. Choose File→New→Schedule.

This starts the New Schedule wizard in Schedule Manager where you create your work
breakdowns.

Complete the steps in the New Schedule wizard to create the new schedule.

You can create several schedules to help you analyze the change.

Note:

You must be an Author user to create schedules.

3. In the Open Change view, select the schedule in the Plan Items folder and click Open Schedule
.

The Schedule Manager view appears.

4. Add tasks to your schedules.

5. Assign resources to tasks, including selecting responsible people using the Membership button .

6. In the Schedule Manager view, click View Task folders .

Change Manager displays the Open Task view.

Create a work breakdown using Schedule Manager
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7. Add change items to be associated with the tasks, as necessary.

8. (Optional) Roll up the item revisions in your task folders to the change object folders.

Roll up objects associated with a change object

The Roll Up view displays all objects in the folders of the selected change and its associated work
breakdown tasks at one level, eliminating the need to look through multiple levels of the work
breakdown structure. This view is static and the related objects are not moved. You can also roll up
the objects to the change object and commit the changes.

1. Double-click the change object in the Change Home view and select the change object in the tab
that just opened.

2. Click the Rollup  button.

The Roll Up view displays the objects, its folders, and tasks.

3. In the Roll Up view, click the list button of the Commit Rollup  button and select the relations to
commit.
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A message appears asking you if you want to commit the changes.

4. Click OK.

5. To commit the rollup, click the Commit Rollup  button in the view.

The objects committed appear with a check next to their names and the objects appear in the
change folders.

Display a schedule work breakdown

• In the Open Change view, select the schedule in the Plan Items folder you want to display, and click
the Open Schedule button .

Display a schedule work breakdown
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The schedule appears in the Schedule Manager view.

Managing change items associated with a schedule task

Use schedule task to manage changes

A complex change can have dozens or hundreds of problem, impacted, and solution items to manage.
You can efficiently manage these as change items under a single change object by using a schedule task
in one or more schedules (change plan items).

17. Scheduling implementation activities
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When you create a schedule task as
a change object, you can add the
change items—problem, impacted,
and solution items—to the task,
so users can quickly access them.
The change items associated with a
schedule task appear in the Open
Task view where you can do the
following:

• Add and remove items from the
change object

• Work on multiple items at once

• Propagate change items to a
schedule task

Remote workflows that contain
remote schedule tasks with change
items function as follows:

• Solution items, problem items,
and impacted items on the
schedule task are replicated

• The change object and its
reference items are replicated and
attached to the workflow as a
reference

• When the user selects a task
from My Worklist, Summary
view displays the Problem Items,
Solution Items, Impacted Items,
and Reference Items

Display the change items associated with a schedule

• In the Schedule Manager view in Change Manager, click the View Task folders  button.

The Open Task view appears.

Display the change items associated with a schedule
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Manage the change items associated with a schedule using the Open Task
view

You can manually add change items to the folders of a schedule.

Note:

• You can also propagate change items to the folders of a schedule task.

• If you create a new revision of a change item, any schedules associated with the original
revision are not automatically associated with the new revision (a schedule cannot have two
parents). Therefore, you need to cut the schedules in the Plan Items folder of the original
change item revision and paste them in the Plan Items folder of the new revision.

17. Scheduling implementation activities
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1. In the Schedule Manager view, click the View Task folders  button to display the Open Task
view

2. Select a task folder, such as the Solution Items folder, as shown above.

3. Paste the item revision (for example, New Lens) into the folder. You also see the item revision
appear in the Roll Up view.

Manage the change items associated with a schedule using the Change
Details view

You can use the Change Details view to add and remove change items associated with a schedule task.
In addition, you can add multiple items at once.

Manage the change items associated with a schedule using the Change Details view
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Note:

• You can also propagate change items to a schedule task.

• If you create a new revision of a change item, any schedules associated with the original
revision are not automatically associated with the new revision (a schedule cannot have two
parents). Therefore, you need to cut the schedules in the Plan Items folder of the original
change item revision and paste them in the Plan Items folder of the new revision.

1. In the Schedule Manager view in Change Manager, right-click a schedule task and choose Change
Details.

The Change Details view displays the change associated with the task (the Parent Change). It also
displays each folder (problem, impacted, reference, and, if applicable, solution items) associated
with the tasks and its contents.
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2. Use the Cut, Copy, and Paste tools, as appropriate, to add or remove items from the folders of the
schedule task.

Propagating change items to schedules

About propagating change items to schedules

You can selectively propagate the items related to a change object (problem, impacted, solution, and
reference items) to related plan items (schedule tasks) associated with the change object, as shown. This
allows you to quickly associate the change items to be worked on during a task with the task so a user
can easily access them. For example, you can propagate the assembly with the problem bumper to the
scheduled task so the user can replace the bumper with a new one.

You can choose to associate all the items in a folder or just individual items. You can initiate the
propagation from a change object (change notice, change request, and deviation request) or from a
schedule. Your workflow administrator can also set up a workflow to propagate change items to a
schedule through a workflow process.

About propagating change items to schedules
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Example of propagating change items to a schedule

Company ABC has a problem with the bearing in a compressor assembly. In addition, the vibration
sensor needs to be changed. It is a large change, and Company ABC will use a schedule to plan and
implement all the tasks.

Engineering change notice (ECN)

Company ABC creates an engineering change notice to manage the change.

17. Scheduling implementation activities
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Schedules

The change analyst creates two separate schedules, one for the mechanical designer and one for the
electrical. These schedules require different items for each user. For example, the mechanical designer
requires the mechanical items (bearing, housing, shaft, and the compressor assembly), while the
electrical designer requires the electrical items (bearing vibration sensor and the compressor monitoring
system). The change specialist propagates the items as appropriate to the different schedules.

Participants

• Change specialist: Manages change items, including the propagation of the items to the schedules.

• Change analyst: Creates and manages the high-level plan.

• Team leader: Creates and manages the detailed plan.

• Team members: Execute the work. Change Manager automatically updates their work status.

Example of propagating change items to a schedule
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Propagation

Using the Change Manager propagate capability, a change specialist relates the objects attached to the
ECN (problem and impacted items) to the two schedule tasks in the plan.

Completion

After creating new revisions of the impacted items in the Solutions items folder of the schedule, the
designer who created them, pastes them in the Solution items folder of the ECN.

17. Scheduling implementation activities
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Configuring who can propagate change items to schedules

By default, a change specialist or the user assigned to a task can propagate change items in change
folders to schedule folders. In earlier versions of Teamcenter, this was hard-coded in the conditions.
Now, you can use Business Modeler IDE conditions that begin with Cm0 to control how the propagation
is handled and they must be met for the propagation to be successful. These conditions call the
Teamcenter conditions that had hard-coded the propagation. Therefore, if you have used those
conditions, you still receive the configurations defined in them.

The condition Calls

Cm0isCMHasImpactedItem
CreatableForTask

isCMHasImpactedItemCreatable
ForTask

Cm0isCMHasProblemItem
CreatableForTask

isCMHasProblemItemCreatable
ForTask.

Cm0isCMHasSolutionItem
CreatableForTask

isCMHasSolutionItemCreatable
ForTask

Cm0isCMReferencesCreatable
ForTask

isCMReferencesCreatable
ForTask

The following shows the expression for Cm0isCMHasImpactedItemsCreatableforTask calling in
isCMHasImpactedItemCreatableForTask:

(o.CMClosure = "Open" AND o.CMDisposition
        = "None" AND o.CMMaturity = "Elaborating") OR (o.CMClosure = 
"Open" AND
        o.CMDisposition = "Investigate" AND o.CMMaturity = "Reviewing") 
OR
        Condition::isChangeExecutionAllowed(o, u))
  

Note:

Change object modification is permitted only when CMClosure is set to Open.

Propagate change items to schedules

You can propagate the items related to a change object in its Solution, Problem, Impacted, or
References folders to selected schedules.

The change items are propagated to the lowest tasks in the selected schedules (those with no children,
referred to as leaf-level tasks). For example, when you select to propagate the change items to the
ECN–Sched1 schedule, the items are propagated to the highlighted leaf-level tasks:
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1. In the Change Home, My Open Changes, or the Open Change view, display the change object.

2. Do one of the following:

• To select all the schedules associated with the change object, select the Plan Items folder.

• To select one or more schedules, expand the Plan Items folder and select one or more
schedules, as shown for selecting ECN-Sched1 in the Open Change view.

3. From Change Manager, choose Tools→Propagate Folder Contents.

Change Manager validates that the propagation can be performed, and if it can, it displays the
Propagate Folder Contents box.
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• The schedules you selected appear in the Propagate To list. The change items are propagated to
them.

• The items associated with the change object appear in the Select Items to Propagate list.

4. (Optional) Click the link next to the change object to view its properties.

5. In the Select Items to Propagate tree, do one of the following:

• To include all the items in a folder, select the check box next to the folder.

• To select one or more items in a folder, expand the folder and select the individual items.

6. Click Finish.

If you do not have access to create any of the relationships, access to one or more selected objects,
or the conditions are not met, Change Manager processes all the actions that are allowed. It
displays a message indicating what relationships were not created. It does not report on successes.
It also ignores that an item might have already been propagated.

Propagate change items to schedules
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Note:

You may need to refresh Teamcenter to view the propagated change items.

Propagate change items to selected schedule tasks

You can propagate the items related to a change object in its Solution, Problem, Impacted, or
References folders to the related schedule tasks.

The following explains how to initiate the propagation from a schedule. When you initiate the
propagation from the schedule, you can select the individual tasks to which you want the items to
be propagated.

1. In the Schedule Manager view in Change Manager, select the schedule or schedule tasks to which
you want to propagate the change items.

• If you select a schedule, the change items are propagated to the lowest tasks in the schedule
(those with no children, referred to as leaf-level tasks). For example, if you select to propagate
the change items to ECN-Sched1, the items are propagated to the following tasks:

17. Scheduling implementation activities
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• If you select a schedule summary task, Change Manager propagates the change items to all
leaf-level tasks change folders but not to the schedule summary task.

• If you select a summary task (task with sub-tasks), Change Manager propagates the change
items to all leaf-level tasks change folders under the selected summary task but not to the
summary task itself.

• If you select a leaf-level task (task with no sub-tasks), Change Manager propagates the change
items to the selected leaf-level tasks change folders.

Note:

• The selected schedules must have the same parent change object.

• A proxy task does not have change folders, so it is grayed and you cannot select it.

• A milestone task does have change folders, and you can propagate change items to it.

2. From Change Manager, choose Tools→Propagate Folder Contents.

Change Manager validates that the propagation can be performed, and if it can, it displays the
Propagate Folder Contents box. The following shows the Propagate Folder Contents box when
one schedule task is selected.

Propagate change items to selected schedule tasks
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• The schedule or tasks you selected appear in the Propagate To list. The change items are
propagated to them.

• The items associated with the change object appear in the Select Items to Propagate list.

3. (Optional) Click the link next to the associated change object to view its properties.

4. In the Select Items to Propagate tree, do one of the following:

• To include all the items in a folder, select the check box next to the folder.

• To select one or more items in a folder, expand the folder and select the individual items.

5. Click Finish.

If you do not have access to create any of the relationships, access to one or more selected objects,
or the conditions are not met, Change Manager processes all the actions that are allowed. It
displays a message indicating what relationships were not created. It does not report on successes.
It also ignores that an item might have already been propagated.
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Propagate change items to schedules through a workflow

A workflow designer can include the workflow handler CSI-propagate-folder-contents as part of a
workflow template to propagate change items to all the change folders or the related schedule tasks.
The designer can use the arguments to CSI-propagate-folder-contents to define:

• Which folders to propagate (problem, impacted, reference and, if applicable, solution).

You need to create a CSI-propagate-folder-contents handler for each relation you want propagated.
For example, if you want to propagate the change items to all folders, you would create four handlers.
The CSI-propagate-folder-contents arguments shown are for problem items.

Propagate change items to schedules through a workflow
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• Types of objects to include or exclude.

• Status of objects to allow or not allow.

• Whether condition checking should be bypassed.

17. Scheduling implementation activities
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